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FOREWORD 
Thank you for purchasing our robot products. 
This manual contains the information necessary for the correct use of the Manipulator. 
Please carefully read this manual and other related manuals before installing the robot 
system. 
Keep this manual handy for easy access at all times. 

 
WARRANTY 

The robot and its optional parts are shipped to our customers only after being subjected to 
the strictest quality controls, tests, and inspections to certify its compliance with our high 
performance standards. 
 
Product malfunctions resulting from normal handling or operation will be repaired free of 
charge during the normal warranty period. (Please ask your Regional Sales Office for 
warranty period information.)  
 
However, customers will be charged for repairs in the following cases (even if they occur 
during the warranty period): 
 
1. Damage or malfunction caused by improper use which is not described in the manual, 

or careless use. 
2. Malfunctions caused by customers’ unauthorized disassembly. 
3. Damage due to improper adjustments or unauthorized repair attempts. 
4. Damage caused by natural disasters such as earthquake, flood, etc. 

 
Warnings, Cautions, Usage: 

 
1. If the robot or associated equipment is used outside of the usage conditions and product 

specifications described in the manuals, this warranty is void. 
2. If you do not follow the WARNINGS and CAUTIONS in this manual, we cannot be 

responsible for any malfunction or accident, even if the result is injury or death. 
3. We cannot foresee all possible dangers and consequences.  Therefore, this manual 

cannot warn the user of all possible hazards. 
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TRADEMARKS 
Microsoft, Windows, and Windows logo are either registered trademarks or trademarks of 
Microsoft Corporation in the United States and/or other countries.  Other brand and 
product names are trademarks or registered trademarks of the respective holders. 
 

TRADEMARK NOTATION IN THIS MANUAL 
Microsoft® Windows® XP Operating system 
Microsoft® Windows® Vista Operating system 
Microsoft® Windows® 7 Operating system 
Microsoft® Windows® 8 Operating system 
Throughout this manual, Windows XP, Windows Vista, Windows 7, and Windows 8 refer 
to above respective operating systems.  In some cases, Windows refers generically to 
Windows XP, Windows Vista, Windows 7, and Windows 8. 
 

NOTICE 
No part of this manual may be copied or reproduced without authorization. 
The contents of this manual are subject to change without notice. 
Please notify us if you should find any errors in this manual or if you have any comments 
regarding its contents. 

  
MANUFACTURER 
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4. We will now teach the local origin point.  Click the <Teach> button to open the [Local 
Wizard Teach Point] dialog. 

  
5. Jog the robot until the end effector is aligned with the origin point.  Then click the 

<Teach> button.  The next step will be displayed. 

  
6. We will now teach a point on the local X axis.  Click the <Teach> button and jog the 

robot until the end effector is aligned with a point anywhere along the X axis of the 
new coordinate system.  Click the <Teach> button on the [Teach Point] dialog to 
continue. 
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7. We will now teach a point on the local Y axis.  Click the <Teach> button and jog the 
robot until the end effector is aligned with a point anywhere along the Y axis of the 
new coordinate system.  Click the <Teach> button on the [Teach Point] dialog to 
continue. 

8. The new local definition is displayed as shown below.  Click <Finish> to accept the 
new definition. 
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[Tools]-[Robot Manager]-[Tools] Page 

This page allows you to define tool settings for a robot.  When the tab is selected, the 
current values are displayed. 

A grid is used to display all the values for all 15 tools you can define. 

When the RC180 Controller firmware is Ver.1.4.*.* or before, the row from 4 to 15 will 
not be displayed. 

When a tool is undefined, then all fields for that tool will be blank.  When you enter a 
value in any of the fields for an undefined tool, then the remaining fields will be set to zero 
and the tool will be defined when you click the <Apply> button. 

For more information on tools, see the SPEL+ Language Reference: TLSet Statement. 

 
Navigating the grid 

Use the TAB key to move to the next field.  Use the arrow keys or the mouse to move to 
any field. 

Item Description 

Tool Wizard This button starts the Tool Wizard.  Follow the instructions for each step of 
the wizard to define a tool.  See details in the next section. 

X The X coordinate of the tool. 
Y The Y coordinate of the tool. 
Z Z offset of tool. 
U Rotation angle of the tool about the Z axis (roll). 
V Rotation angle of the tool about the Y axis (pitch).   
W Rotation angle of the tool about the X axis (yaw).   
Apply Set the current values. 
Restore Revert back to the previous values 
Clear Clear all values for the selected tool. 

 

 

NOTE 
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Using the Tool Wizard 

1. Open the [Robot Manager] and click on [Tools] to show the [Tools] page. 

2. Click the <Tool Wizard> button.  You will see the dialog shown below. 

  
3. Select the tool you want to define and click <Next>. 

  
4. Click the <Teach> button to open the [Tool Wizard: Teach Point] dialog. 
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5. Jog the robot until the tool is aligned with the reference point.  For 6-axis robots, 
ensure that U = 0, V = 0, and W = 180 at the reference point.  Then click the <Teach> 
button.  The next step will be displayed in the wizard. 

  
6. Click the <Teach> button.  Jog the robot so that the tool is aligned with the reference 

point, but from another U angle.  To do this, jog the U axis several degrees, then jog X 
& Y until the tool is aligned with the reference point.  After you have finished jogging 
to the reference point, click <Teach>. 

7. For 6-axis robots only: Jog the robot back to the reference point with U = 0, V = 0, and 
W = 180.  Jog the W axis several degrees, then jog X and Y until the tool is aligned 
with the reference point.  Ensure that U and V remain at 0 degrees. 

  
8. The new tool definition is displayed as shown below.  Click <Finish> to accept the new 

definition. 
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[Tools]-[Robot Manager]-[Arms] Page 

This page allows you to define Arm settings for a robot.  When the tab is selected, the 
current Arm values are displayed.  The tab is disabled if the current robot does not support 
the Arm command. 

A grid is used to display all the values for all 15 arm configurations you can define. 

When the RC180 Controller firmware is Ver.1.4.*.* or before, the row from 4 to 15 will 
not be displayed. 

When an arm is undefined, then all fields for that arm will be blank.  When you enter a 
value in any of the fields for an undefined arm, then the remaining fields will be set to zero 
and the tool will be defined when you click the <Apply> button. 

For more information on arm parameters, see the SPEL+ Language Reference: ArmSet 
Statement. 

 
Navigating the grid 

Use the TAB key to move to the next field.  Use the arrow keys or the mouse to move to 
any field. 

Item Description 

L2 Dist Distance between the center of joint 2 and the center of the orientation joint 
in millimeters. 

J2 Offset Angle of the line from the center of joint 2 to the center of the orientation 
joint in degrees. 

Z Offset The Z offset between the new orientation axis and the standard orientation 
axis. 

L1 Dist Distance between the center of the shoulder joint and the center of the 
elbow joint in millimeters. 

U Offset The angle offset between the standard orientation zero position and the new 
orientation axis zero position in degrees. 

Apply Sets current values. 

Restore Reverts to the previous values. 

Clear Clears all values for the selected arm 
 
 
  

 

NOTE 
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[Tools]-[Robot Manager]-[ECP] Page 

This page allows you to define ECP (external control point) settings for a robot.  When the 
page is selected, the current values are displayed. 

If the ECP option is not enabled in the controller, this page will not be visible. 

For detailed information on using external control points in your application, refer to 
6.14.5 ECP Coordinate Systems (Option).   

A grid is used to display all of the values for all ECPs you can define. 

When an ECP is undefined, then all fields for that ECP will be blank.  When you enter a 
value in any of the fields for an undefined ECP, then the remaining fields will be set to 
zero and the ECP will be defined when you press the <Apply> button. 

 
Navigating the grid 

Use the TAB key to move to the next field.  Use the arrow keys or the mouse to move to 
any field. 

Item Description 

X The X coordinate of the ECP. 

Y The Y coordinate of the ECP. 

Z The Z coordinate of the ECP. 

U Rotation angle of the ECP about the Z axis (roll). 

V Rotation angle of the ECP about the Y axis (pitch). 

W Rotation angle of the ECP about the X axis (yaw). 

Apply Sets current values. 

Restore   Reverts back to the previous values. 

Clear Clears all values for the selected ECP. 
 
  

 

NOTE 
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[Tools]-[Robot Manager]-[Box] Page 

When the RC180 Controller firmware is Ver.1.4.*.* or before, this page will not be 
displayed. 

This page allows you to define Box (approach check area) settings for a robot.  When the 
page is selected, the current values are displayed.  When a Box is undefined, then all fields 
for that Box will be blank.  When you enter a value in any of the fields for an undefined 
Box, then the remaining fields will be set to zero and the Box will be defined when you 
press the <Apply> button.  

For more information on Box, see the SPEL+ Language Reference: Box Statement. 

 
Navigating the grid 

Use the TAB key to move to the next field.  Use the arrow keys or the mouse to move to 
any field. 

Item Description 

Min X Type in the minimum X limit value in millimeters.  

Max X Type in the maximum X limit value in millimeters. 

Min Y Type in the minimum Y limit value in millimeters.  

Max Y Type in the maximum Y limit value in millimeters. 

Min Z Type in the minimum Z limit value in millimeters.  

Max Z Type in the maximum Z limit value in millimeters. 

Apply Sets current values. 

Restore   Reverts back to the previous values. 

Clear Clears all values. 

 
Setting both values to zero disables the limits. 

  

 

NOTE 
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[Tools]-[Robot Manager]-[Plane] Page 

When the RC180 Controller firmware is Ver.1.4.*.* or before, this page will not be 
displayed. 

This page allows you to define Plane (approach check plane) settings for a robot.  When 
the page is selected, the current values are displayed.  When a Plane is undefined, then all 
fields for that Plane will be blank.  When you enter a value in any of the fields for an 
undefined Plane, then the remaining fields will be set to zero and the Plane will be defined 
when you press the <Apply> button. 

For more information on Plane, see the SPEL+ Language Reference: Plane Statement. 

 
Navigating the grid 

Use the TAB key to move to the next field.  Use the arrow keys or the mouse to move to 
any field. 

Item Description 

X Sets the X origin of the coordinate for approach check plane. 

Y Sets the Y origin of the coordinate for approach check plane. 

Z Sets the Z origin of the coordinate for approach check plane. 

U Sets the U origin of the coordinate for approach check plane. 

V Sets the V origin of the coordinate for approach check plane. 

W Sets the W origin of the coordinate for approach check plane. 

Apply Sets current values. 

Restore   Reverts back to the previous values. 

Clear Clears all values. 

 
 
  

 

NOTE 
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[Tools]-[Robot Manager]-[Weight] Page 

This page is for changing the Weight parameters for the robot.  

For details on the Weight parameters, see the SPEL+ Language Reference: Wight 
Statement. 

 
Item Description 

Weight Type in the new total weight of the payload on the robot. 
Kg/Lb Choose which unit the weight is represented in: kilograms or pounds. 
Length Type in the new length. 
Apply Sets the current values. 
Restore Reverts back to the previous values. 
Defaults Click the defaults button to display factory default settings. 
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[Tools]-[Robot Manager]-[Inertia] Page 

This page is for changing the Inertia parameters.   

For details on the Inertia parameters, see the SPEL+ Language Reference: Inertia 
Statement. 

 
Item Description 

Load inertia Type in the new load inertia of the payload on the robot in kg⋅m2.  This 
includes the inertia of end effector plus the part to be carried. 

Eccentricity Type in the new eccentricity value in millimeters.  This is the distance from 
rotational center of joint 4 to the center of gravity of end effector and part. 

Apply Sets the current values. 

Restore Reverts back to the previous values. 

Defaults Click the defaults button to display factory default settings. 
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[Tools]-[Robot Manager]-[XYZ Limits] Page 

This page allows you to configure limits for X, Y and Z motion in the robot envelope. 

For details on the XYZ limits, see the SPEL+ Language Reference: XYLim Statement. 

 
Item Description 

X, Y, Z Type in the minimum and maximum X, Y, and Z limit values.  Setting 
both values to zero disables the limits. 

Read Current Click this button to read the value from the current robot position.  The 
button text shows the axis and minimum or maximum depending on 
which text field has the current focus. 

Apply Sets the current values. 
Restore Reverts back to previous values. 
Defaults  Sets default values. 
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[Tools]-[Robot Manager]-[Range] Page 

This page allows you to configure the robot joint software limits. 

For details on configuring the motion range, see the SPEL+ Language Reference: Range 
Statement. 

 
Item Description 

J1 - J6 Type in the minimum and maximum encoder pulse values for each joint. 

Read Current Click this button to read the current joint value of the robot into the 
currently field.  The button text will change depending on which text 
field has focus. 

Apply Save the current changes. 

Restore Reverts back to the previous values. 

Defaults Sets the default values. 
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[Tools]-[Robot Manager]-[Home Config] Page 

[Home Config] allows you to configure the optional user home position and home order 
used by the Home command. 

For details on configuring the home position, see the SPEL+ Language Reference: 
HomeSet Statement. 

 
Changing home position 

When you select the [Home Config] tab, the current home position is read from the robot 
controller and displayed in the text boxes.  If the home position has never been defined, 
then the text boxes will be blank. 

To define the home position, you can enter an encoder position value for each of the four 
robot joints in the text boxes, or you can select the [Jog & Teach] page to jog the robot to 
the desired home position, then select the [Home Config] page and click the <Read 
Current Position> button to read the current encoder position values. 

Changing home order 

The home command executes in steps.  The number of steps equals the number of joints 
on the robot.  Select the home step number for each joint using the dropdown list for each 
joint.  More than one joint can be homed in the same step. 

Testing home 

After making changes to the home position and home order, you can click the [Robot 
Manager]-[Control Panel] tab and click the <Home> button. 

Item Description 

Read Current Click this button to read the current position encoder pulse value into the 
currently selected text field.  The button text will change according 
which text field is selected. 

Defaults Set the value of the [Home order] group box to the default value. 

Apply Save the current changes. 

Restore Revert back to the previous values. 
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5.11.2  [Task Manager] Command (Tools Menu) 
The [Task Manager] window allows you to Halt (suspend), Resume, and Quit (abort) tasks. 

To open the Task Manager 

Select Task Manager from the Tools Menu. 
 Or 
Type Ctrl + T. 
 Or 
Click on the  button on the toolbar. 

Operation 

The [Task Manager] is used for suspending, resuming, stepping, and stopping tasks. 

When [Task Manager] is started, you will see a grid containing status information for 16 
tasks standard tasks and 4 trap tasks.  There are several items shown for each task.  To 
view all of the columns, use the scroll bar or resize the window. 

Task Number of task from 1 to 16 and four trap tasks. 

Name Name of the function that was started as a task. 

Status Current task status: Run, Waiting, Halt, Pause, Quit, Step. 

Type Task types 
Normal This task is a normal task 
NoPause This task does not pause with Pause statement or when 

Pause input or Safety Door open occur. 
NoEmgAbort This task continuously processes during the Emergency 

Stop or error occurrence. 

Line Current task line number. 

Function Current task function name. 

Program Current task program name. 

Start The date and time that the task was started. 
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Item Description 

Halt  Suspends the selected task.  This temporarily stops the task so that it 
can be started again with the <Resume> button.  <Halt> can only be 
executed when a task is running (status is Run).  When <Halt> is 
executed, the <Resume> button will be enabled.  If a motion command 
is executing with Halt occurs, the motion will be completed before the 
task reaches the Halt state. 
The task also temporarily stops when the task is NoPause type or 
NoEmgAbort type. 

Resume  After one or more tasks have been suspended with the <Halt> button, 
clicking on <Resume> will make the halted tasks continue where they 
left off.  First, a confirmation dialog is displayed. 

Quit  This button stops the selected task permanently.  You cannot resume a 
task once you have executed Quit.  To restart the task, you must start it 
from within a program or from the [Run] window.  The task also stops 
when the task is NoPause type or NoEmgAbort type. 

Pause  This button pauses tasks that can be paused.  After pause, you must use 
either <Continue> or <Stop>. 
The task does not pause when the task is NoPause type or 
NoEmgAbort type. 

Continue  This button continues all tasks that were paused with the <Pause> 
button. 

Stop  This button stops all tasks. 

To Halt, Step, Walk, and Resume a task 

Use the mouse to click on the desired task in the task list.  You can click on any field to 
select a task.  The current task status must be Run before it can be halted.  The Halt button 
will become active after you have selected the task. 

After a task has been halted, the source code will be displayed and the next step will be 
indicated.  You can either click on the <Resume> button to resume execution, or executed 
[Step Into], [Step Over], or [Walk] from the [Run] Menu. 

To Pause and Continue tasks 

Pause allows you to “suspend” all tasks that can be suspended. 

Click on the <Pause> button to pause available tasks.  The robot will decelerate to a stop 
immediately. 

After executing Pause, click on <Continue> to resume all suspended tasks. 

To view source code at the current execution line 

Select a task row.  Then right click and select [Go To Line].  The program editor will be 
opened at the current execution line 
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5.11.3  [I/O Label Editor] Command (Tools Menu) 
The [I/O label] editor lets you define meaningful names for inputs, outputs, and memory 
I/O for each project.  The labels can be used in your programs, from the [Command 
window, or in macros.  They are also displayed in the [I/O Monitor] window. 

To open the I/O Label Editor 

Select [I/O Label Editor] from the [Tools] menu. 

 Or 

Type Ctrl + L. 

 Or 

Click on the  button on the toolbar. 

 
The I/O Label Spreadsheet 

When you select [I/O Label Editor] from the [Tools] menu, a window opens that contains 
a tree and a spreadsheet editor. 

The tree on the left side of the window shows the various types of I/O for the controller.  
For each type of I/O you can view and edit labels for bits, bytes (8 bits), and words (16 
bits).   

The first column of the spreadsheet shows the bit, byte, or word number, depending on 
which type of I/O you are viewing. 

The second column contains the label for each bit, byte, or word in column 1.  You can 
type in up to 16 characters for a label.  Label characters can be alphanumeric or 
underscore. 

The third column contains the description associated with the label.   

If you add a description to an I/O point, then the description will be displayed as a tool tip 
on the I/O Monitor. 

All I/O types are shown in the I/O Label Editor, but some may not be available on your 
controller.  For example, you can edit Fieldbus I/O labels, but you may not have a 
Fieldbus board installed in the controller.  This allows you to edit labels when you are 
disconnected from a controller.  Verify that the controller to be used with the project has 
the hardware installed for the I/O you are using. 

 

NOTE 
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To add or edit a label 

Select the type of I/O you want to label in the tree.  After you select the I/O type, the 
spreadsheet will be refreshed to display the labels for that type.  The number of rows in the 
spreadsheet equals the number of bits, bytes, or words available for the type you have 
selected.   

Use the mouse to scroll through the spreadsheet and put the cursor in the [Label] field next 
to the bit, bytes, or words number that you want to add a label to.  Type in the label, which 
can be up to 16 alphanumeric characters without any spaces.  Optionally, you can type a 
description for the label in the [Description] field. 

After adding or editing labels, save the changes by executing [Save] from the [File] menu 
or by clicking on the <Save Project>  toolbar button.  If any duplicate labels are 
detected, an error message will be displayed and the save operation will be aborted.  You 
must correct the duplication before you can save the labels successfully. 

To cut and paste labels and descriptions 

You can cut and paste labels and descriptions by selecting with the mouse, then executing 
[Copy], [Cut], and [Paste] from the [Edit] menu.  

You can also cut and paste entire rows using the following steps: 

1. Select one or more rows by using the row selectors on the left and execute either the 
[Cut] or [Copy] command from the [Edit] Menu.  When selecting multiple rows, hold 
down the shift or control key while selecting rows with the mouse. 

2. Select the destination I/O type, if required.   

3. Select the row where you want to start the paste by clicking the row selector on the left 
of the row. 

4. Execute the [Paste] command from the [Edit] menu.   
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5.11.4  [I/O Monitor] Command (Tools Menu) 
The [I/O Monitor] window lets you monitor all controller hardware inputs and outputs and 
also memory I/O.  There are up to four views available: one standard view and three 
custom views.   

On the standard view, there are two grids.  For each grid you can specify which type and 
size of I/O to monitor.   

For each custom view, you can specify a list of any combination of input, output, or 
memory.  By default, there is one custom view available.  To use the other two custom 
views, right click on a tab and check the views you want to be visible.  See the section 
Custom I/O Views later in this chapter. 

Labels that have been defined using the [I/O Label Editor] are displayed next to each bit, 
byte, or word. 

After the [I/O Monitor] window has been opened, the input and output status for the 
current view is constantly updated. 

The I/O monitor will always be displayed on top of other child windows, such as program 
windows and point windows. 

If a description has been entered for an I/O port (bit, byte, or word) in the I/O Label Editor, 
then a tool tip will be displayed when the mouse pointer is over the row containing the 
port. 

You can turn outputs on and off by double clicking on the output LED images in the 
Status column. 

 
To open the I/O Monitor 

Select [I/O Monitor] from the [Tools] menu. 
 Or 

Click on the  tool bar button. 
 Or 

Type Ctrl + I. 

Using the I/O Monitor 

Select the tab for the type of I/O you want to monitor. 

Scroll through the grids to locate the desired inputs or outputs to monitor. 

You can split each grid into two scroll regions by selecting the split bar in the upper right 
corner of the grid and dragging it down.  Each scroll region can be individually scrolled. 

To turn an output off or on, double click on the LED image for the desired output. 

When Virtual I/O is active, you can turn input bits on and off by double clicking on the 
input LED images in the Status column. 

To view bytes and words in hexadecimal format, check the [Hexadecimal Values] 
checkbox. 
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You can resize the I/O monitor in the vertical direction to show more data.  Move your 
mouse pointer to the lower right corner of the window to activate a size handle, then click 
down and drag the window down or up to the desired size. 

Custom I/O Views 

You can configure up to three custom I/O views.  In each view, you can add any 
combination of I/O.  You can also change the name of each view and hide each view. 

 
To change a view 

1. Click on a custom view tab.  If none are currently shown, right click on the [Standard 
View] tab and select one of the three custom views to show it. 

 
2. Click the <Add> button to add a new row to the list. 

3. Select the <Type> by clicking in the [Type] column, then click the arrow to view a list 
of I/O types and select one. 

4. In the [Port] column, select the port (bit, byte, or word, depending on I/O type). 

5. Add more rows as needed by repeating steps 2 - 4. 

<Apply>: Save the changes 

<Delete>: Delete a row 

<Restore>: Cancel changes. 

To rename a view 

1. Click on a custom view tab.  If none are currently shown, right click on the [Standard 
View] tab and select one of the three custom views to show it. 

2. Right click on the view tab and select [Rename]. 

3. Enter the new name for the view. 
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5.11.5  [Command Window] Command (Tools Menu) 
The command window emulates an ASCII terminal that communicates directly with the 
robot controller.  You can execute SPEL+ immediate commands from this window and 
view the results. 

To open the Command window 

Select Command Window from the Tools Menu 

 Or 

Click on the  button on the toolbar. 

 Or 

Type Ctrl+M 

 
To execute SPEL+ commands from the Command window 

1. Type in the desired command after the prompt (>).   
Commands can be entered in upper or lower case. 

2. Press the <Enter> key to execute the command.   
The cursor can be anywhere on the line when you press <Enter>. 

3. Wait for the prompt to return before typing in a new command. 

When an error occurs, an error number will be displayed along with an error message. 

You can use the arrow keys or the mouse to move the cursor to any line in the window that 
starts with a prompt (>) character and execute it by pressing Enter. 
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Command Window Keys 

Key Action 

Ctrl+A Select entire window. 

Ctrl+C Stop the program and initialize robot controller.  If a robot motion 
command is in progress, the prompt will return when the command has 
been completed. 

Ctrl+V Execute Paste command.  Paste from Clipboard to current selection. 

Ctrl+W Re-display last command line after the prompt. 

Ctrl+X Execute Cut command.  Cut current selection and put in Clipboard. 

Ctrl+Z Undo last change. 

Ctrl+Home Go to the top of the window. 

Ctrl+End Go to last prompt at end of the window. 

? Translates to “PRINT “ when used as the first character of a command.  
This can be used to display variables or any statement that requires a 
PRINT command. 

 
5.11.6  [Macros] Command (Tools Menu) 

You can create SPEL+ command macros using the Macro Editor.  Macros consist of one 
or more SPEL+ statements that can be executed from the command window.  A macro 
statement may use global variables, I/O labels, and point labels.  You can assign a macro 
to each of the Alt function keys except for Alt+F4, which is a Windows shortcut to close 
the application. 

1. Select [Tools]-[Macros] to open the [Command Macros] dialog. 

 
2. Type the macro statements in the [Macro] text box. 

3. Click the <Apply> button to save changes. 

4. Click <Execute> to run the macro. 

5. Click <Close> to close the dialog.  You will be prompted to save the macros you have 
created or changed. 

To open a macro and execute it, type <Alt> + function key.  Then click <Execute> to run 
it.  Macros never execute by pressing the function key.  The separate execute step is 
provided for safety, since macros can move the robot and control I/O. 

Macros can be executed while tasks are running.  If one or more commands in a macro are 
not valid while tasks are running, an error will occur.  
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5.11.7 [Controller] Command (Tools Menu) 
Select Controller from the [Tools] Menu to open the [Controller Tools] dialog. 

From the [Controller Tools] dialog, you can save and restore the complete controller 
configuration and the project using the [Backup Controller] and [Restore Controller] 
commands.  You can also save and view controller status, and reset the controller. 

Before servicing the system, you should execute [Backup Controller] and store the system 
configuration on an external media such as a USB memory key. 

If required, you can use [Restore Controller] to restore previously stored data. 

 
Backup Controller 

Use Backup Controller to save controller configuration data on your PC.   
You cannot backup the controller data while tasks are running.  If you attempt to do so, an 
error message will be displayed. 

1. Select [Tools]-[Controller]. 

2. Click on the <Backup Controller> button to open the [Browse For Folder] dialog. 

 
3. Select the disk drive and parent folder where you want to save the information.  You 

can create a new parent folder by clicking the <Make New Folder> button. 

4. Click <OK>.  A new folder containing the backup files will be created in the selected 
folder named "B_" plus the controller serial number followed by the current date / time. 

When the version of the connected RC180 controller firmware is Ver.1.0.*.*, Backup 
Controller does not backup the project data. 
Be sure to backup the project data individually by selecting [Copy] from the [Project] 
menu. 

 

NOTE 
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Restore Controller 

Use <Restore Controller> to load controller settings from previously saved backup data.  
You cannot restore the controller data while tasks are running.  If you attempt to do so, an 
error message will be displayed. 

To restore controller configuration: 

1. Select [Tools]-[Controller]. 

2. Click on the <Restore Controller> button to open the [Browse For Folder] dialog. 

 
3. Select the drive and folder where the information is stored.  Controller backup 

information is stored in a folder that is named “B” plus the controller serial number 
followed by the date / time. 

You can also select a folder containing export controller status information. 
Export controller status is stored in a folder that is named “S” plus the controller serial 
number followed by the date / time. 

4. Click <OK> to display the dialog to select the restore data.  

 
Robot name, serial #, calibration checkbox 
This checkbox allows you to restore the robot name, robot serial number, Hofs data, 
and CalPls data.  Make sure that the correct Hofs data is restored.  If the wrong Hofs 
data is restored, the robot may move to wrong positions. 
The default setting is unchecked. 

Robot maintenance configuration checkbox 

This checkbox allows you to restore the parts consumption data. 
For details, refer to the following manual. 
   Robot controller RC180  Appendix. Alarm. 
The parts consumption management is available for the following Manipulator types: 

- G series   (G1, G3, G6, G10, G20) 
- RS series (RS3, RS4) 

The default setting is unchecked. 
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Project checkbox 
This checkbox allows you to restore the files related to projects. 
The default setting is unchecked. 
When the project is restored, all the values of Global Preserve variables are restored. 
For details about Global Preserve variable backup, refer to 5.10.10 [Display Variables] 
Command (Run Menu). 

When the version of the connected RC180 controller firmware is Ver.1.0.*.*, this 
dialog does not appear.  Robot name, serial number, and calibration data is always 
restored.   
The project is not restored. 

5. Click the <OK> button to restore the system information. 

Restore the system configuration saved using [Backup Controller] only for the same 
system. 
When different system information is restored, the following warning message appears. 

 
Click the <No> button cancel restoration of data except for special situations such as 
controller replacement.   

Export Controller Status 

You can export the current status of the controller using this button.  Tasks can be running 
when this command is executed.  The current status is saved in a folder containing several 
files.  The controller configuration settings, task status, I/O status, robot status, etc. are 
saved in these files.  This is useful for an end user to send a snapshot of the controller 
status to a system vendor or to Epson technical support, should the need arise.  

<Export Controller Status> is equivalent to connecting a USB memory key to the 
controller and pressing the TRIG button on the controller to save controller status. 

You can configure the controller whether to save the project files in the status folder or not.  
See [Setup]-[Controller]-[Preferences]. 

You can view the exported status using the <View Controller Status> button (see next 
section). 

To export controller status 
1. Select [Tools]-[Controller]. 

2. Click on the <Export Controller Status> button to open the [Browse For Folder] dialog. 

 
3. Select the drive and parent folder where the information is to be saved. 
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4. Click <OK> to save the current controller status.  A new folder will be created inside 
the parent folder using the controller serial number and the current date / time. 

View Controller Status 

Click the <View Controller Status> button to view the status data stored from a previous 
status export (see the Export Controller Status section above). 

To view controller status: 

1. Select [Tools]-[Controller]. 

2. Click on the <View Controller Status> button to open the [Browse For Folder] dialog. 

 
3. Select the drive and folder where the information is stored.  Controller status 

information is stored in a folder that is named "S_" plus the controller serial number 
followed by the date / time. 

4. Click <OK> to view the selected controller status. 

5. The [Controller Status Viewer] dialog will be displayed. 

 
6. Select items to view from the tree on the left side of the dialog.   

7. To view another controller status, click the ellipses button next to the Status Folder 
name and select a new status folder.   
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Maintenance 

It shows the parts consumption data for the Controller or Manipulator parts. 
For details, refer to Appendix. Alarm in the RC180 Controller Manual. 

The parts consumption management is available for the following Manipulator types: 
- G series   (G1, G3, G6, G10, G20) 
- RS series (RS3, RS4) 

Reset Controller 

Use <Reset Controller> to reset the current controller from within EPSON RC+ 5.0.  This 
is equivalent to powering the controller off and on.  It is useful for when you want to reset 
the controller state remotely because you do not have easy access to the controller power 
switch.  For example, a development team could be using a controller for development by 
connecting to it using Ethernet.  By executing this command, a team member can reset the 
controller from his development system. 
 

5.11.8  [User Error Editor] Command (Tools Menu) 
The [User Error Editor] allows you to define user errors for the current project.  If a user 
error is caught in an error handler, then the ErrMsg$ function will return the error message 
defined in the editor.  The label associated with an error can be used in any integer 
expression.  

 
User error numbers can be from 8000 to 8999. 
Labels can be up to 16 characters in length. 
It is recommended that you use the ER_ prefix for each error label and use all caps for the 
label.  This makes it easy to see error labels in your code. 

Some user error examples: 

Error # Label Message 

8000  ER_VACUUM Vacuum error has occurred. 

8001  ER_INDEXOT Indexer overtime has occurred. 

In your program code, use the Error statement to generate a user error.  For example: 
On Vacuum 

Wait Sw(VacOn), 1 

If Tw = 1 Then 

Error ER_VACUUM 

EndIf 
The user error information is stored in the current project folder in a file called 
UserErrors.dat. 
You can use the [Import] command from the [File] menu to import user errors from other 
projects. 
After adding new error definitions, save the changes by executing [Save] from the [File] 
menu or by clicking on the <Save all files>  toolbar button.  If any duplicate labels are 
detected, an error message will be displayed and the save operation will be aborted.  You 
must correct the duplication before you can save the labels successfully.  



5.  The EPSON RC+ 5.0 GUI 
 

120  EPSON RC+ 5.0 (Ver.5.4) User's Guide Rev.7 

5.11.9  [Simulator] Command (Tools Menu) 
Shortcuts 

Toolbar:  

This command opens the Simulator window.  For instructions on using the Simulator, 
refer to 8. Simulator.  
 

5.11.10  [Vision] Command (Tools Menu) 
Shortcuts 

Toolbar:  

This command opens the Vision Guide window.  For instructions on using Vision Guide, 
refer to the EPSON RC+ 5.0 Option Vision Guide 5.0 Manual.  
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5.12  [Setup] Menu 
The [Setup] menu contains the following commands: 

 PC to Controller Communications -
 Controller -
 Vision -
 Preferences -

For details on the Vision command, refer to EPSON RC+ 5.0 Option Vision Guide 5.0. 

5.12.1  [PC to Controller Communications] Command (Setup Menu) 
Toolbar:  

The [PC to Controller Communications command] opens a dialog box that is used for 
configuring communications between your PC and the Controller. 

 
Item Description 

Connect Connect to the currently selected connection. 

Disconnect Disconnect from the current connection. 

Add Adds a new Ethernet or virtual controller connection.  When you 
click this button, another dialog will open that allows you to specify 
the connection type.  

 
Delete Deletes the currently selected connection.   

You cannot delete connection #1, USB. 

Apply Saves the current changes. 

Restore Reverts back to the previous settings. 

Work Offline When Work Offline is checked, EPSON RC+ 5.0 does not attempt to 
connect to a controller during operations such as building a project.  
Some windows such as Robot Manager will not be available while 
working offline. 

Auto Connect When Auto Connect is selected, EPSON RC+ 5.0 will automatically 
connect if the current connection is available. 

Close Closes the dialog. 
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5.12.2  [Controller] Command (Setup Menu) 
The [Controller] command opens the [Setup Controller] dialog.  This dialog has several 
pages that can be accessed by selecting them from the tree on the left side of the dialog. 

[Setup]-[Controller]-[General] Page 

This page allows the user to view general information about the controller. 

 
Item Description 

Serial # Displays the serial number of the current controller. 

MAC Address Displays the MAC Address of the controller. 

Firmware Version Displays the firmware version used in the current controller. 

Date / Time Displays the current date and time in the controller. 

Project Name Displays the name of the project in the controller. 

Close Closes the Setup Controller dialog. 

 

 
  



5.  The EPSON RC+ 5.0 GUI 
 

EPSON RC+ 5.0 (Ver.5.4) User's Guide Rev.7   123 

[Setup]-[Controller]-[Configuration] Page 

This page allows the user to view and change the controller configuration settings. 

 
Item Description 

Name Use this text box to change the controller name.   
You may use any name up to 16 characters long using 
alphanumeric characters and underscore. 

IP Address Use this text box to set current IP address of the 
controller.   
The IP Address must be on the same subnet as the PC. 

IP Mask Use this text box to set the IP mask of the controller.  
Note that the IP Mask must match the IP mask used for 
your network. 

IP Gateway Use this text box to set the IP gateway of the controller.  
This is only required if you will be accessing the 
controller from outside of the local network. 

USB Speed Select the speed of the USB connection. 

Control Device Allows you to select the Control Device. 

TP Program Mode Password Allows you to change the TP Program Mode password. 

Close Closes the Setup Controller dialog. 

Apply Saves the current changes.  If necessary, the controller 
will be reset to use the new settings. 

Restore Reverts back to previous settings. 
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[Setup]-[Controller]-[Preferences] Page 

This page contains controller preference settings. 

  
RESET command turns off outputs 

When this preference is turned on, all outputs other than remote control outputs will be 
turned off when a Reset instruction is executed.  The default setting is off. 

The outputs of the standard I/O, expansion I/O, and Fieldbus I/O are included in the 
“outputs” mentioned in the above preferences [RESET command turns off outputs] and 
[Outputs off during Emergency Stop].  Memory I/O is not affected by these preferences.  
Therefore, memory I/O bits are not turned off by the RESET command execution or 
during Emergency Stop. 

Outputs off during Emergency Stop 

When this preference is turned on, all outputs other than remote control outputs will be 
turned off when emergency stop occurs.  Also, no outputs can be turned on until the 
emergency stop condition is cleared.    The default setting is on. 

You should design your system to always remove all power to output devices when 
emergency stop occurs.  Even if the controller turns off outputs, the I/O hardware could 
malfunction. 

Allow motion with one or more joints free 

When this preference is turned on, motion commands can be executed after SFree has 
been used to free one or more joints.  The default setting is off. 

Walk stops for output commands 

When checked, the Walk command from the Run Menu will execute lines until after the 
next motion or output statement (whichever comes first).  When unchecked, the Walk 
command will execute lines until after the next motion statement and will not stop for 
output statements.  The default setting is on. 

Dry run 

This preference allows you to run programs without a robot connected to the controller.  
All program statements will work.  Motion statements will execute approximately the 
same amount of time as when connected to a robot.  

Virtual I/O 

This preference allows you to run programs using virtual I/O.  When Virtual I/O is enabled, 
I/O commands do not affect the hardware I/O.  There are also several commands available 
for turning on inputs from within a program.  The default setting is off. 

Remote function is also available when virtual I/O is enabled.
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Include project files in when status exported 
This preference allows you to configure whether project files are included or not when the 
controller status is exported.  Refer to 5.11.7 [Controller] Command (Tools Menu).   
The default setting is on. 

The project using Vision Guide cannot perfectly be stored by the Status storage.  This is 
because some files are not transferred to the Controller. 
If you are using Vision Guide, please back up the project files with RC+. 

Safeguard open stops all tasks 

Check this option to cause all tasks to stop when the safeguard is open.    
This option can be used in applications where pause / continue are not required. 
The default setting is off. 

When the version of the connected RC180 controller firmware is Ver.1.0.*.*, this 
checkbox cannot be checked. 

Enable CP – PTP connection when CP is on 

This preference allows you to overlap the trajectories of CP motion and PTP motion 
during CP ON.   

Over-speed error or Over-acceleration-speed error may occur according to the motion 
acceleration / deceleration speed setting.  If the error occurs, adjust the acceleration / 
deceleration speed setting or uncheck this checkbox. 

Auto LJM (Least Joint Motion) 

This preference allows you to enable Auto LJM at the controller start up.  To disable Auto 
LJM temporarily, use AutoLJM Off command. 

If Auto LJM is enabled at all times, this function automatically adjusts the posture of the 
manipulator to reduce the motion distance, even when you intended to move the joint 
widely.  Therefore, it is recommended to disable Auto LJM at the controller start up and 
operate the manipulator as you desired using AutoLJM On command or LJM function. 

Disable LJM in Teach Mode 

This preference allows you to invalidate LJM in the TEACH mode.  The LJM function 
becomes invalid regardless of the command of AutoLJM.  The default setting is 
unchecked. 

Disable Point flag check 

This preference allows you to continue operation even when point flags, one was specified 
as a target point and the other one after the motion completion, do not match in a CP 
motion. 

However, if the flags do not match at the transferring point while CP On is used, the 
manipulator will stop at the point and the motion will not become a path motion. 

Motor off when Enable switch off in Teach Mode 

This preference is read-only.  It shows whether motors will be turned off when the Enable 
switch is off during Teach Mode. 

Enable robot maintenance data 

This preference allows you to enable the parts consumption management for the Controller and 
robot parts.  
The parts consumption management is available for the following Manipulator types: 

- G series   (G1, G3, G6, G10, G20) 
- RS series (RS3, RS4) 

The default setting is unchecked.  
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Motor power low when ForcePowerLow signal OFF 

This preference allows you to specify whether or not to invert the logic of the ForcePowerLow 
signal input value. 
When this checkbox is selected, the ForcePowerLow signal will work as the forced low power 
function which operates the robot in the low power mode when remote I/O input signal is Low. 
When this checkbox is unchecked, the ForcePowerLow signal will work as the forced low 
power function which operates the robot in the low power mode when the remote I/O input 
signal is High.  The default setting is unchecked. 
For details of the ForcePowerLow signal, refer to 11.7 Remote Inputs. 

ForcePowerLow signal change pauses all tasks 

This preference allows you to specify whether to stop or temporarily stop the tasks when the 
input of the ForcePowerLow (forced low power) signal is changed.  
When this checkbox is selected, all tasks and commands will be temporarily stopped when the 
remote I/O input signal is changed.  The program execution can be continued.  
When this checkbox is unchecked, all tasks and commands will be stopped when the remote 
I/O input signal is changed.  The program needs to be restarted.  
The default setting is unchecked. 
For details of the ForcePowerLow signal, refer to 11.8 Remote Inputs. 
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[Setup]-[Controller]-[Options] 

This page is used to configure options in the controller.   
For instructions, refer to 15. Installing Controller Options. 

 

[Setup]-[Controller]-[Simulator] 

This page is used to configure the Simulator.  For virtual controllers, the Enable Simulator 
checkbox is grayed out and checked.  For real controllers, if the firmware supports 
simulation, then you can check the Enable Simulator checkbox. 

 
 
For more details, refer to 8.3.4 Virtual Controller Configuration. 
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[Setup]-[Controller]-[Robot] 

[Setup]-[Controller]-[Robot]-[Model] Page 

 
Item Description 

Model Allows the user to select the robot model.   
You can only select a model that the current amplifier power ratings will 
allow.   
If Dry Run is active, or the controller is a virtual controller, then all robot 
models will be displayed.   
If you select "None", then the current robot will be removed from the 
controller when <Apply> is clicked. 

Type Displays the robot type. 

Length Displays the robot length (J1 + J2 for SCARA robots) or reach for 6-axis 
robots. 

Apply Saves the current changes. 

Restore Reverts back to previous settings. 

Close Closes the Setup Controller dialog. 
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[Setup]-[Controller]-[Robot]-[Configuration] Page 

 
Item Description 

Name Enter a Name for the robot. 

Serial # Enter the Serial number of the robot. 

Joints These checkboxes determine if the respective joint is enabled or disabled. 

Close Closes the [Setup Controller] dialog. 

Apply Saves the current changes. 

Restore Reverts back to previous settings. 
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[Setup]-[Controller]-[Robot]-[Calibration] Page 

You can calibrate each joint of the robot from this page. 

 
You can calibrate each joint of the robot from this page.   
It is not displayed if the controller is virtual. 

Item Description 

Joint to Calibrate Select the joint that you want to Calibrate. 

Calibrate… This button starts the [Calibration Wizard] dialog that walks you 
through the calibration process. 

Calpls These are the Calpls settings for each joint.   
Normally, the calibration wizard will calculate these values. 

Hofs These are the Hofs settings for each joint.   
Normally, the calibration wizard will calculate these values. 

Load Cal This button is used to load data from a previously save calibration 
file.  After the data is loaded, the grid will be refreshed to show 
the values. 

Save Cal This button is used to save the calibration data to a calibration file. 

Apply Saves the current changes. 

Restore Reverts back to previous settings. 

Close Closes the Setup Controller dialog. 
 
  



5.  The EPSON RC+ 5.0 GUI 
 

EPSON RC+ 5.0 (Ver.5.4) User's Guide Rev.7   131 

[Setup]-[Controller]-[Robot]-[Amplifiers] Page 

This page shows the power values for the motor amplifiers installed in the controller.   
It is not displayed if the controller is virtual. 

 
Item Description 

Robot Amplifiers This shows the power for each robot amplifier currently in 
the controller. 

Close Closes the Setup Controller dialog. 
 

The motor amplifiers and the motor powers may not be the same. 
 

[Setup]-[Controller]-[Inputs / Outputs] Page 

This page shows the I/O hardware installed in the controller. 
There are no settings to configure. 

 
 

[Setup]-[Controller]-[EtherNet/IP] Page 

If an EtherNet/IP board is installed in the controller, a configuration page is shown under 
[Inputs / Outputs].  For details on EtherNet/IP configuration, refer to the controller manual. 
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[Setup]-[Controller]-[Remote Control] 

For details of Remote function, refer to 10. Remote Control. 

[Setup]-[Controller]-[Remote Control]-[Inputs] Page 

Use this page to configure the controller remote control inputs. 

 
Item Description 

Input # Select an input bit to use for the corresponding input signal.   
Select "Not used" to disable the remote input. 
For example, if “Start” is assigned to I/O input bit 0, select “Not used” to 
use this as a normal I/O input. 

 
Close Closes the Setup Controller dialog. 

Apply Saves the current changes. 

Restore Reverts back to previous settings. 

Defaults Click this button to set the default remote inputs.   
First, a dialog box will be displayed asking you which type of inputs to use 
for defaults: Standard I/O or Fieldbus.   
You can also select <Clear All> to set all remote inputs to Not used. 

Load Reads the assigned remote inputs and outputs from a file on the PC and 
save it in the controller. 

Save Saves the assigned remote inputs and outputs shown in the dialog to a file 
on the PC. 

Both the remote inputs and outputs are loaded or saved together when using <Load> or 
<Save>. 
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[Setup]-[Controller]-[Remote Control]-[Outputs] Page 
Use this page to configure the controller remote control outputs. 

 
Item Description 

Output # Select an output bit to use for the corresponding output signal.   
Select "Not used" to disable the remote output. 
For example, if “Ready” is assigned to I/O output bit 0, select “Not used” 
to use this as a normal I/O output. 

Close Closes the Setup Controller dialog. 

Apply Saves the current changes. 

Restore Reverts back to previous settings. 

Defaults Click this button to set the default remote outputs.  First, a dialog box will 
be displayed asking you which type of outputs to use for defaults: Standard 
I/O or Fieldbus.  You can also select Clear All to set all remote outputs to 
Not used. 

Load Reads the assigned remote inputs and outputs from a file on the PC and 
save it in the controller. 

Save Saves the assigned remote inputs and outputs shown in the dialog to a file 
on the PC. 

Both the remote inputs and outputs are loaded or saved together when using <Load> or 
<Save>. 
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[Setup]-[Controller]-[Remote]-[Ethernet] 

Use this page to configure the Remote Ethernet. 
These settings are necessary when the control device is “Remote Ethernet”, or when the 
operator acquires the value using the Remote Ethernet while the control device is not 
“Remote Ethernet”.  

 
Item Description 

TCP/IP port  Input the port number used by the Remote Ethernet client.  
Select a port that is not used for other TCP/IP communications.  

Terminator Select the code that indicates the line terminator (end-of-data) for 
the Remote Ethernet client.  

Timeout Specify the longest interval time for a remote command during 
Remote Ethernet communications (in units of seconds). 
If there is no remote command from the client during the time set in 
[Timeout], task execution stops with a communication error.  

Password Specify a password for client authentication to connect.  
Authentication is accomplished with the Login command.  

Use only for 
monitoring 

Specify to acquire the value using Remote Ethernet, if the control 
device is not “Remote Ethernet”. 

Close Close the dialog. 

Apply Save the current changes.  

Restore Revert back to the previous settings. 

Defaults Click this button to set the Remote Ethernet default settings.  

Default setting 
TCP/IP port No. : 5000 
Terminator : CRLF 
Timeout : 60 seconds 
Password : No setting 
Use only for monitoring : Not checked 

 

 
CAUTION 

■ If you set “0” in the [Timeout] textbox, then the time out duration is infinite.  In this 
case, the task(s) continue to execute even without the communication from 
client.  This means the robot may keep moving and cause unexpected damage.  
Ensure that tasks will be stopped appropriately in your system. 
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[Setup]-[Controller]-[Remote]-[RS232] 

Use this page to configure the Remote RS232. 
When the Remote RS-232C port is not installed to the Controller, RS232 is not shown in 
the tree. 
These settings are necessary when the control device is “Remote Ethernet”, or when the 
operator acquires the value using the Remote Ethernet while the control device is not 
“Remote Ethernet”. 

 
Item Description 

Port Specify a port No. used for remote RS232 communication. 

For example, RS-232C port of the Controller is allotted to the 
Remote RS232 connection in the above dialog. 

Specify the port No. that is not used for other RS-232C 
communication. 

RS-232C port setting is the value specified at [Controller]-[RS-
232C]-[Specified port No]. 

Password Specify a password for client authentication to connect.  
Authentication is accomplished with the Login command.  

Use only for 
monitoring 

Select to acquire the value using Remote Ethernet, if Control device 
is not Remote Ethernet. 

Close Closes the dialog. 

Apply Saves the current changes.  

Restore Reverts back to the previous settings. 

Defaults Click this button to set the Remote RS232 default settings.  

Default setting 
RS-232C port No. : 1 
Password : No setting 
Use for monitoring : No 

 

 
CAUTION 

■ If you set “0” in the [Timeout] textbox of the specified RC-232C port, then the 
time out duration is infinite.  In this case, the task(s) continue to execute even 
without the communication from client.  This means the robot may keep moving 
and cause unexpected damage.  Ensure that tasks will be stopped appropriately 
in your system. 
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[Setup]-[Controller]-[RS232] Pages 

There is one page for each RS232 port installed in the controller.  If there are no RS232 
ports installed in the controller, then no RS232 selections are visible in the tree. 

 
To configure an RS-232 port 

1. Select [Controller] from the [Setup] menu and select the page for the RS232 port you 
want to configure. 

2.  Change the settings as desired.  You can also click the <Defaults> button to use default 
settings. 

3.  Click <Apply> to save the new settings and click <Close>. 
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[Setup]-[Controller]-[TCP/IP] Pages 

You can configure TCP/IP settings for the robot controller in a SPEL+ program using the 
SetNet command.  You can also configure settings from the [TCP/IP] tab on the [Setup]-
[Controller] dialog. 

 
To configure a TCP/IP port 

1. Select [Controller] from the [Setup] menu and select the page for the TCP/IP port you 
want to configure. 

2.  Enter the host name or IP address for the controller or PC that you want this controller 
to communicate with. 

The controller does not support DNS, so you must specify an IP address for the host 
you are communicating with.  You cannot specify a name for the host. 

3. Enter the TCP/IP port number.  This must be the same port number that is used on the 
host device.  It must be different from any of the other TCP/IP port numbers used for 
the other TCP/IP ports. 

4.  Change the other settings as desired. 

5.  Click <Apply> to save the new settings and click <Close>. 
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5.12.3  [Preferences] Command (Setup Menu) 
The [Preferences] command opens a dialog that contains several pages that are used to 
configure user preferences for the EPSON RC+ 5.0 environment. 

To open the [Preferences] dialog, select [Setup]-[Preferences] . 

[Setup]-[Preferences]-[Startup] 

[Setup]-[Preferences]-[Startup]-[Start Mode] Page 

From the [Start Mode] page, you can choose whether EPSON RC+ 5.0 starts in Auto 
mode or Program mode.   

 
Item Description 

Auto Select Auto to start EPSON RC+ 5.0 in Auto mode.   
For details, refer to 4. Operation. 

Program Select Program to start EPSON RC+ 5.0 in Program mode.   
For details, refer to 4. Operation. 

Password Click this button to change the password required to enter Program mode 
from Auto mode when EPSON RC+ 5.0 starts. 

Apply Saves the current changes. 

Restore Reverts back to previous settings. 

Defaults Click this button to set the default startup mode. 

Close Closes the Preferences dialog. 
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[Setup]-[Preferences]-[Startup]-[Auto Start] Page 

 
Item Description 

Start EPSON RC+ after 
Windows start 

Check this box if you want EPSON RC+ 5.0 to automatically 
start after Windows starts. 

Command line options Enter the command line options used when EPSON RC+ 5.0 
is automatically started.  This has no effect if the Start 
EPSON RC+ 5.0 with Windows start checkbox is not 
checked. 

Apply Saves the current changes. 

Restore Reverts back to previous settings. 

Close Closes the Preferences dialog. 
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[Setup]-[Preferences]-[Startup]-[Windows Login] Page 

The Windows Login page allows you to configure your PC to automatically login a user 
when Windows starts.  This is useful when the PC is used to run EPSON RC+ 5.0 in Auto 
mode and display an operator window.  The operator does not have to login to Windows. 

 
Item Description 

Enable windows auto 
login 

Check this box if you want to automatically login to Windows 
when it starts.  You must supply a valid user name, password, 
and domain.   

User Name Enter the name of a valid Windows user on the system. 

Password Enter the login password for the user. 

Domain Optional.  If the PC is the member of a domain, enter the name 
here. 

Apply Saves the current changes. 

Restore Reverts back to previous settings. 

Close Closes the Preferences dialog. 
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[Setup]-[Preferences]-[Workspace] Page 

From this page, you can configure your workspace preferences. 

 
Item Description 

Auto file save Checking this box will cause EPSON RC+ 5.0 to automatically 
save any open files before executing a command that requires 
the file to be saved.  For example, if a file needs to be saved 
before executing a project build, the file will automatically be 
saved before running the build.  Default is On. 

Stop compile after  
first error 

Stops compile after first error occurs.  This makes it easier to see 
the first error in the status pane and allows you to fix one error at 
a time.  Default is On. 

Do not open last project If this radio button is selected, the last project will not be opened 
when EPSON RC+ 5.0 is started. 

Open last project and 
program windows 

If this radio button is selected, the last project will be opened 
and any program windows that were previously opened will be 
opened. 

Open last project and 
all windows 

If this radio button is selected, the last project will be opened 
and all windows will be restored to their previous locations.   
This is the default setting. 

Show Tip of the Day If this checkbox is on, the Tip of the Day dialog will be 
displayed when EPSON RC+ 5.0 is started. 

Apply Saves the current changes. 

Restore Reverts back to previous settings. 

Close Closes the Preferences dialog. 
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[Setup]-[Preferences]-[Editor] Page 

This page is used to configure your preferences for the program editor windows. 

 
Item Description 

Auto Indent Check this box if you want new lines to follow the indentation 
for the previous line.  Also, lines will automatically be indented 
after Do, If, Else, For, Select, and Case statements.  Default is 
on. 

Auto End Construct Check this box if you want EPSON RC+ 5.0 to add the end 
construct statement for a loop construct.  For example, if you 
enter a For statement, then a Next statement will be added 
automatically.  Default is on. 

Margin Indicators Check this box to display a margin on the left side.  This margin 
is used to indicate lines with breakpoints, current step line, and 
current execution line.  Default is on. 

Function Separators Check this box to display a line after each Fend statement.  
Default is on. 

Syntax Help Check this box to enable the Syntax Help window.  The Syntax 
Help window displays syntax for a keyword after it has been 
typed.  Default is on. 

Tab Stops Type in the number of columns to move for the TAB key.  
Default is 4. 

Font Click on the Font button to open the fonts dialog.  Choose the 
font you desire for the editor.  The monitor window also uses the 
editor font.  The current font name and size is displayed next to 
the Font button. 

Apply Applies the current settings. 

Restore Reverts back to the previous settings. 

Defaults Sets default values. 

Close Closes the Preferences dialog. 
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[Setup]-[Preferences]-[Robot Manager]-[General] Page 

This page lets you configure your preferences for the Robot Manager. 

 
Item Description 

Display Choose if you want the Robot Manager to be displayed as an MDI 
Window or as a Dialog. 

Close Closes the Preferences dialog 

Apply Applies the current settings. 

Restore Reverts back to the previous settings. 

Defaults Sets default values. 

Close Closes the Preferences dialog. 

The Robot Manager can be displayed as an MDI child window (default) or as a dialog.  
When displayed as an MDI child, the Robot Manager is displayed in the MDI document 
area and can remain open while you work with other windows and dialogs.  When 
displayed as a dialog, you can only work with the Robot Manager controls until you close 
the dialog.  When using screen resolutions less than 1024 x 768, the Robot Manager MDI 
window will not fit in the MDI document area.  In this case, only the Dialog mode is 
allowed. 
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[Setup]-[Preferences]-[Robot Manager]-[Jogging] Page 

This page lets you configure the [Robot Manager]-[Jog & Teach] page. 

 
Setting Jog Button Orientation 

The jog button orientations are useful for “aligning” your PC monitor with the robot’s 
Cartesian coordinate system.  Align the buttons so that the robot moves in the direction of 
the arrows. 

You can change the orientation of the jogging buttons and arrow keys for the X and Y 
axes by selecting the desired top button from the [Top Button] dropdown list. 

You can also click on one of the buttons to change it to the top button position. 

Program Mode Options 

These options affect the [Robot Manager]-[Jog & Teach] page when used from program 
mode.   

These settings do not affect the Robot Manager when used for operators in auto mode, 
such as for the Operator Window or from VB Guide.  To configure the Robot Manager for 
operators, refer to [Project]-[Properties]-[Operator Settings]-[Robot Manager]. 

Item Description 

Confirm teach Check this box if you want a confirmation prompt each 
time you press the <Teach> button on the Robot Manager 
Jog & Teach page. 

Enable motion commands Check this box if you want to execute motion commands 
(Go, Jump, etc.) from the [Robot Manager]-[Jog & Teach] 
page. 

Prompt for new point 
information 

Check this box if you want to be prompted for point label 
and description when a new point is taught using the 
<Teach> button. 

Apply Applies the current settings. 

Restore Reverts back to the previous settings. 

Defaults Sets default values. 

Close Closes the [Preferences] dialog. 
 
  

 

NOTE 



5.  The EPSON RC+ 5.0 GUI 
 

EPSON RC+ 5.0 (Ver.5.4) User's Guide Rev.7   145 

[Setup]-[Preferences]-[Run Window] Page 

This page allows you to change preferences for the Run Window. 

 
Item Description 

Confirm Start This checkbox allows you to select if you want to see a 
confirmation message box before a program is started. 

Clear text window on start Checking this will cause the Run Window text pane to be 
cleared each time the <Start> button is clicked. 

Allow multiple tasks to be 
started 

Checking this allows you to start a task from the [Run] 
window while other tasks are running.  The <Start> button 
will not be disabled after starting a task. 

Font Click on the <Font> button to open the fonts dialog.  
Choose the font you desire for the [Run] window.  The 
current font name and size is displayed next to the <Font> 
button. 

Apply Applies the current settings. 

Restore Reverts back to the previous settings. 

Defaults Sets default values. 

Close Closes the [Preferences] dialog. 
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[Setup]-[Preferences]-[Command Window] Page 

This page allows you to change preferences for the Command Window. 

 
Item Description 

Preserve contents Checking this option will cause the command window to 
preserve its contents between sessions. 

Font Click on the <Font> button to change the font for the 
Command window. 

Apply Saves the current changes. 

Restore Reverts back to the previous values. 

Defaults Sets default values. 

Close Closes the [Preferences] dialog. 
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[Setup]-[Preferences]-[Language] 

This page allows you to change the EPSON RC+ 5.0 GUI language. 

  
When EPSON RC+ 5.0 is installed on a Windows system using a Western language, then 
the English, German, and French selections are available.   

When it is installed on a Windows system using Japanese, then Japanese and English 
selections are available. 

When it is installed on a Windows system using Chinese, then English, Chinese 
(Simplified), and Chinese (Traditional) are available.   

After selecting the desired language, you must re-start EPSON RC+ 5.0. 

If you change the language to a language that does not match the Windows language, then 
some system dialogs will be in the Windows language.  For example, if you select German 
for EPSON RC+ 5.0, but you are using English Windows, then messages boxes and some 
file navigation dialogs will be in English. 

Item Description 

Language This set of option buttons allows you to choose which language to use 
for the EPSON RC+ 5.0 GUI. 

Apply Saves the current changes. 

Restore Reverts back to the previous values. 

Defaults Sets the default language. 

Close Closes the [Preferences] dialog. 

 
  



5.  The EPSON RC+ 5.0 GUI 
 

148  EPSON RC+ 5.0 (Ver.5.4) User's Guide Rev.7 

5.13  [Window] Menu 
The [Window] menu contains selections for managing the currently open EPSON RC+ 5.0 
child windows. 
 

5.13.1  [Cascade] Command (Window Menu) 
Use [Cascade] to show all of the currently open files in windows of the same size, stacked 
one on top of another. 

 
 

5.13.2  [Tile Horizontal] Command (Window Menu) 
Use [Tile Horizontal] to evenly display all open windows horizontally. 
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5.13.3  [Tile Vertical] Command (Window Menu) 
Use [Tile Vertical] to evenly display all open windows vertically. 

 
 

5.13.4  [Arrange Icons] Command (Window Menu) 
Arrange the icons for all child windows that have been minimized. 

 
 

5.13.5  [Close All] Command (Window Menu) 
This command closes all EPSON RC+ 5.0 child windows. 
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5.13.6  1, 2, 3 Command (Window Menu) 
A list of currently open document windows is displayed at the bottom of the [Window] 
menu.  

When you choose an open window from the listing, you make that document active.  A 
check mark appears in front of the document name of the currently active window. 

 
 

5.13.7  [Windows] Command (Window Menu) 
This command displays a dialog that contains a list of all currently open EPSON RC+ 5.0 
windows. 

 
Item Description 

Activate Brings the selected window into focus. 

Save Saves the contents of the selected windows. 

Close Closes the selected windows. 

OK Closes the dialog. 
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5.14  [Help] Menu 
The [Help] menu contains selections for accessing the help system and manuals along with 
version information. 
 

5.14.1  [How Do I] Command (Help Menu) 
Shortcuts 

Keys: Ctrl +F1 

Select [How Do I] to view topics that contain information for performing common tasks in 
EPSON RC+ 5.0. 
 

5.14.2  [Contents] Command (Help Menu) 
This command opens the Contents view for the EPSON RC+ 5.0 on-line help system. 

From the Contents view, you can navigate through all of the topics in the help system.  
Double-click on a book icon to open or close the subtopic list contained within the book 
folder. 
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5.14.3  [Index] Command (Help Menu) 
This command opens the Index view for the EPSON RC+ 5.0 on-line help system. 

From the [Index] view, as you begin typing in a keyword, the alphabetical topic list will 
show the keywords starting with the letters you have typed. 

 
 

5.14.4  [Search] Command (Help Menu) 
This command opens the Search view for the EPSON RC+ 5.0 on-line help system. 

From the Search view, you can type in one or more keywords and click List Topics to 
show a list of all topics containing one or more of the keywords.  The keywords are 
highlighted in the topics as shown below. 
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5.14.5  [Manuals] Submenu (Help Menu) 
The [Manuals] submenu contains selections for each of the manuals installed on the PC in 
Adobe PDF format.  These include manuals for EPSON RC+ 5.0, SPEL+ Language 
Reference, VB Guide 5.0, Controller, and various robot models. 
 

5.14.6  [About EPSON RC+ 5.0] Command (Help Menu) 
The [About EPSON RC+ 5.0] command displays a dialog box showing the current version 
of the EPSON RC+ 5.0 software, along with copyright and license information.  When 
calling technical support about EPSON RC+ 5.0, you should report the version you are 
using from this dialog. 
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6.  The SPEL+ Language 
This chapter contains information about the SPEL+ Language. 

Contents 

 Overview -

 Program structure -

 Commands and statements -

 Function and variable names -

 Date types -

 Operators -

 Working with variables -

 Working with strings -

 Multi-statements -

 Labels -

 Comments -

 Error handling -

 Multi-tasking -

 Robot coordinate systems -

 Robot arm orientations -

 Robot motion commands -

 Working with robot points -

 Input and output control -

 Using Traps -  
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6.1  Overview 
SPEL+ is a BASIC-like programming language that runs in the controller.  It supports 
multitasking, motion control, I/O control. 

Programs are written in ASCII text and then compiled into executable object files. 
Several language instructions can also be executed in immediate mode from the Command 
window. 
  

6.2  Program structure 
 

6.2.1  What is a SPEL+ program? 
A SPEL+ program is a collection of functions, variables, and macros.  Each line in a 
program is a statement.  The program statements are stored in one or more program text 
files.  Every program file has a .PRG extension and resides in the project folder on the PC 
and optionally in the controller. 

Each project must contain at least one program and there must be one function called 
"main".  This is the default function.  A compile error will occur if function main is not 
found. 

In addition, seven more programs can be defined in the same project.  Each program has 
its own start function: main1, main2…main7.  Each of the eight programs can be started 
from the Operator window, from the remote console, or from VB Guide. 

A function definition begins with the Function statement and ends with the Fend statement.  
All source statements to be executed by a function must be included within the body of the 
function. 

The following program file contains two function definitions.  Function Main calls 
function Func1. 

MAIN.PRG 

Function Main 

Call Func1 

... 

Fend 

Function Func1 

Jump pickpnt 

... 

Fend 
 

6.2.2  Calling functions 
You can execute a user function by using the Call statement.  The function can reside in 
any program file in the current project.  To get a return value, you must use the function as 
an argument in a statement.  You can also omit the Call statement if you don't need the 
return value.  When Call is omitted, then parentheses for the arguments must not be 
supplied 

Here are some examples: 
Call MyFunc(1, 2) 

MyFunc 1, 2 

Print MyFunc(1, 2)   
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6.3  Commands and statements 
Commands and statements consist of a SPEL+ instruction followed by the parameters for 
that instruction.   

A command is executed immediately.  You can execute commands from the Command 
window or from the Macros dialog box. 

Statements can be used only in programs. 

Statements can include more than one SPEL+ instruction.  When you put several 
statements in a line of a program (Multi-Statement), use a semi-colon (;) to separate 
instructions. 

The maximum length for a statement is 200 characters.  This includes the line number. 
 

6.4  Function and variable names (Naming restriction) 
Function and variable names can include up to 32 alphanumeric characters and the 
underscore character.  Characters can be upper case or lower case. 

The following names are valid: 
Function main 

Real real_var 

Integer IntVar 

Function and variable names cannot begin with a numeric digit or underscore. 

The strings that are already used as keywords cannot be use. (Example: Go / On) 

String variables must have an additional dollar sign ('$') suffix, as shown in the example 
below: 

Function Test 

String modname$ 

Print "Enter model name:" 

Line Input modname$ 

Print "model is ", modname$ 

Fend 
 

Restriction for naming in SPEL+ language 

- Characters can be alphanumeric characters or underscore character.  

- Use alphabets for the first letter.  

- Characters can be upper case or lower case. 

- No keywords can be used. 

- Maximum limits of names are as follows. 

Name Max. limit 
Point label 16 
I/O label 16 

User error label 16 
Function name 32 
Variable name 32 

Line label 32 
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6.5  Data types 
You can declare different types of data in your program.  All variables must be declared. 

The following table shows the different data types for the SPEL+ language. 

Data Type Size Range 

Boolean 2 byte True or False 

Byte 2 byte −128 to +127 

Double 8 bytes −1.79E+308 to 1.79E+308  Number of significant figure is 14 

Integer 2 bytes −32768 to +32767 

Long 4 bytes −2147483648 to +2147483647 

Real 4 bytes −3.40E+38 to 3.40E+38  Number of significant figure is 6 

String 256 bytes All ASCII characters  Up to 255 characters 
 

6.6  Operators 
The following table shows the different operators for the SPEL+ language. 

Keyword or Symbol Description 

+ Addition 

− Subtraction 

* Multiplication 

/ Division 

** Exponentiation 

= Equal 

> Greater than 

< Less than 

>= Greater or equal 

<= Less or equal 

<> Not equal 

And Performs logical and bitwise AND operation. 

Mod Returns the remainder obtained by dividing a numeric 
expression by another numeric expression. 

Not Performs logical or bitwise negation of the operand. 

Or Performs the bitwise Or operation on the values of the operands. 
Xor Performs the bitwise Xor operation on the values of the 

operands. 
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6.7  Working with variables 
 

6.7.1  Variable scopes 
There are three different scopes for variables in SPEL+: 

 Local -

 Module -

 Global -
 

6.7.2  Local variables 
Local variables are available to all statements in the same function.  Functions using local 
variable names cannot refer to the same local variables in other functions.  This is why 
they are called locals, because they are local to the function they are being used in. 

To declare local variables in a function, use one of the variable declaration instructions at 
the beginning of the function after the Function statement: 

Boolean, Byte, Integer, Long, Real, Double, String 

For example, the following function declares several local variables: 
Function test 

Integer intVar1, intVar2 

Real realVar 

String dataStr$ 

Integer array(10) 

..... 

Fend 
 

6.7.3  Module variables 
Module variables are available to all functions in the same program file. 

To declare module variables in a program, use one of the variable declaration instructions 
at the beginning of the program before any Function statements: 

Boolean, Byte, Integer, Long, Real, Double, String 

In order to indicate that a variable is module level, precede the name with "m_", as shown 
in the example below.  With this, you can improve the program readability. 

For example, the following function declares several module level variables: 
' Module level vars, used by all functions in this file 
Integer m_IntVar1, m_IntVar2 
Real m_RealVar 
String m_DataStr$ 
Integer m_Array(10) 
 
Function main 

m_IntVar1 = 25 
Call test 

Fend 
 
Function test 

Print m_IntVar1 

Fend   

 

TIP 
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6.7.4  Global variables 
Global variables can be shared between all functions in a project.  The Global instruction 
is used to declare a global variable. 

To declare global variables in a program, use the Global instruction with the desired 
variable type (Boolean, Byte, Integer, Long, Real, Double, String) at the beginning of the 
program before any Function statements: 

In order to indicate that a variable is module level, precede the name with "m_", as shown 
in the example below.  With this, you can improve the program readability. 

Program: MAIN.PRG 
Global Integer g_TotalCycles 

Function main 

Call LoadPart 
... ... 

Fend 

Program: LOADPART.PRG 
Function LoadPart 

Jump pick 

On gripper 

Wait .1 

Jump place 

Off gripper 

Wait .1 

g_TotalCycles = g_TotalCycles + 1 

Fend 

For more information, see Data Types. 
 

6.7.5  Global Preserve variables 
You can preserve global variable values by using the optional Preserve parameter when 
you declare global variables.   

Preserved variables are stored in the controller’s SRAM.   

If the data type of a preserved variable is changed, or the number of dimensions is changed, 
then the variable values will be cleared. 
   

 

TIP 
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6.7.6  Arrays 
You can declare local, module, and global variables with up to three dimensions for all 
data types. 

To declare an array, use this syntax: 

dataType name ( ubound1 [ , ubound2 [ , ubound3] ] ) 

SPEL+ arrays are zero based.  The first element is referenced with a value of zero. 

The total available number of array elements for local and global preserve variables is 100 
for strings and 1000 for all other types. 

The total available number of array elements for global and module variables is 1000 for 
strings and 10000 for all other types. 

To calculate the total elements used in an array, use the following formula.  (If a 
dimension is not used, substitute 0 for the ubound value.) 
total elements = (ubound1 + 1) * (ubound2 + 1) * (ubound3 + 1) 

Array declaration examples: 
' Global string array 
Global String gData$(10) 

Function main 

' Arrays local to this function 
Integer intArray(10) 

Real coords(20, 10) 

Use Redim to change the bounds of an array at run time.  
Integer a(10) 

Redim a(20) 

To preserve values when using Redim, add the Preserve optional argument.  
 Integer a(10) 

 Redim Preserve a(20) 

Use UBound to get the upper bound of an array dimension. 
Integer i, a(10) 

For i = 1 to UBound(a) 

a(i) = i 

Next i 
 

6.7.7  Initial values 
All variables are initialized when first used except for Global Preserve variables.  Strings 
are set to empty, and all other variables are set to zero. 
 

6.7.8  Clearing arrays 
Execute Redim (without Preserve) to clear all of the elements of an array at run time.   
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6.8  Working with strings 
A string in SPEL+ is a set of ASCII characters with a maximum length of 255. 

You must declare strings in your programs with the String instruction. 

All string variable names must end with a dollar sign ($) suffix. 

You can declare string arrays with up to three dimensions. 

The following table shows the string commands available in SPEL+. 

Keyword Description 

Asc Returns the decimal ASCII value of the first character in a string. 

Chr$ Converts an ASCII value into a one character string. 

FmtStr Formats a numerical or date/time expression. 

Hex$ Returns a string containing the hexadecimal value of a number. 

InStr Returns the position of a substring within a string. 

LCase$ Returns the specified string in lower case characters. 

Left$ Returns a substring beginning with the first character of a string. 

Len Returns the length (number of characters) of a string. 

LTrim$ Returns the specified string with left spaces removed. 

Mid$ Returns a substring of a string. 

ParseStr Parses a string into an array of tokens. 

Right$ Returns a substring from the end of a string. 

RTrim$ Returns the specified string with right spaces removed. 

Space$ Returns a string containing a specified number of space (ASCII 32) 
characters. 

Str$ Converts a number to a string. 

String Declare a string variable in a program. 

Trim$ Returns the specified string with left and right spaces removed. 

UCase$ Returns the specified string in upper case characters. 

Val Converts a string to a number. 
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6.9  Multi-statements 
A program statement can contain several statements separated by semi-colons.  The total 
length of a multi-statement program line cannot exceed 200 characters.  

For example: 
Function Test 

Pass P1; Pass P2; Go P3    ' Multi-statement 

Fend 

Even though multi-statements are supported (mainly for compatibility), it is strongly 
recommended that they not be used.  Multi-statements can make your code more difficult 
to read and debug. 

 
6.10  Labels 

A program label is an alphanumeric name followed by a colon (":") that marks a location 
in a program for a GoTo or GoSub statement.  The name may be up to 32 characters long 
and can include alphanumeric characters and the underscore ("_") character if it is not the 
first character.  You cannot use any SPEL+ keywords as labels. 

For example: 
Function Main 

Do 

Jump P1 

Jump P2 

If Sw(1) Then GoTo MainAbort 

Loop 

MainAbort:   ' Program label 

  Print "Program aborted" 

Fend 
  

6.11  Comments 
Use comments to add notes to your programs.  An apostrophe character (') starts a 
comment. 

Examples of comments 
Function Main 

' ****** Main Demo Program ****** 

Xqt conveyor     ' Start up the task for conveyor 

Do 

    Print "Press ENTER to run demo cycle" 

    Print "Press CTRL+C to quit" 

    Input dumy 

    Call demo   ' Execute the demo function 

Loop            ' Return to start of main loop 
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6.12  Error handling 

When an error occurs in a SPEL+ function, you can cause execution to be transferred to an 
error handling routine for processing the error.  The routine must be inside a function 
definition. 

The table on the next page shows the program instructions that are used for error handling. 

Item Purpose 

OnErr Use the OnErr statement to define the location of the error handling routine. 

Err Use Err to retrieve the number for the current error status.  Use this in the 
error handling routine to determine which error has occurred. 

Error Generate a user defined error which can be caught by an error handler. 

Era Use Era to retrieve the axis number for which the error occurred.  This is 
normally used in the error handling routine. 

Erl Use Erl to retrieve the line number in which the error occurred.  This is 
normally used in the error handling routine. 

Ert Use Ert to retrieve the task number in which the error occurred.  This is 
normally used in the error handling routine. 

ErrMsg$ Use ErrMsg$ to retrieve the error message associated with a specified error 
number. 

 

User Errors 
You can define your own error messages by using the User Error Editor which is available 
from the Tools Menu.  For details, refer to 5.11.8 [User Error Editor] Command (Tools 
Menu). 
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Example 

The following example shows a simple error handling routine.  When an error occurs, 
program execution goes to the ErrHandler label, where the error handler starts.  The error 
number is displayed and the operator is asked to continue or not.  If the operator enters 
"N" then the program executes the Quit All statement to end the program. 

Function Main 

String cont$ 

Integer i 

OnErr Goto Errhandler 

For i = 1 To 10 

Jump P(i) 

Next i 

Exit Function 

' *** Error handler *** 

Errhandler: 

enum = Err 

Print "Error #", enum, " occurred" 

Print "Continue (Y or N)?" 

Line Input cont$ 

Select cont$ 

Case "y", "Y" 

EResume Next 

Default 

Quit All 

Send 

Fend   



6.  The SPEL+ Language 
 

EPSON RC+ 5.0 (Ver.5.4) User's Guide Rev.7 165 

6.13  Multi-tasking 
For some applications, you may want to control other equipment besides the robot, such as 
conveyors, pick and place units, etc.  By using multi-tasking, you can control this other 
equipment with their own tasks. 

SPEL+ supports up to 16 tasks running simultaneously.  A task is a function that has been 
started by the system or by the Xqt statement.   

Use the Xqt statement to start another task from within a function.  You can optionally 
specify a task number from 1 to 16 in the Xqt statement.   

The table below shows the program instructions that are used for multitasking. 

Statement Purpose 

Xqt Starts a function as a task. 

Halt Temporarily suspends execution of a task. 

Resume Resumes a task that has been halted. 

Quit Stops a task. 

Signal Sends a signal to one or more tasks that are waiting for the signal using 
WaitSig. 

SyncLock Locks a resource for use by the current task and blocks other tasks from 
using the resource until SyncUnlock is executed. 

WaitSig Waits for a signal from another task. 

Pause Pause all tasks. 

One example for starting another task is to run a conveyor system for the robot work cell. 

 

Program: MAINTASK.PRG 
Function Main 

Xqt Conveyor  ' Start the conveyor task 

Do 

... 

... 

Loop 

Fend 

Program: CONVTASK.PRG 
Function Conveyor 

Do 

Select True 

Case Sw(10) = On 

Off convCtrl 

Case Sw(11) = On 

On convCtrl 

Send 

Loop 

Fend   
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6.14  Robot coordinate systems 
 

6.14.1  Overview 
In this section we discuss the coordinate systems for different types of robots supported in 
SPEL+. 

The following coordinate systems are used in SPEL+: 

Robot Coordinate System This is the native coordinate system of the robot.   
This is also known as the default base coordinate system. 

Local Coordinate System This is a user defined coordinate system located 
somewhere within the working envelop. 

Tool Coordinate System This is the coordinate system of the tool mounted on the 
robot end-effector. 

6.14.2  Robot Coordinate System 

Robot Coordinate System of SCARA Robot 

 
Center of third axis 

Origin 

 

Z axis in Robot Coordinate System U axis in Robot Coordinate System 

 

-Z 

Z=0 

 

 

+ X 

+ U 

- U 

+ Y 

± 360° 

 

 

Robot Coordinate Systems for 6-Axis Robot 
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Floor Mounting Ceiling Mounting 

  
 

Side (Wall) Mounting 
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Robot Coordinate Systems for RS series 
 

Origin 

Y+ 

X+ 

View from this 
direction 

 

Robot coordinate system Z axis  Robot coordinate system U axis  

 

-Z 

Z＝0 

Joint #3 in the center  

 

- X 

+ Y 

+ U - U 

± 360° View from this 
direction 
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6.14.3  Local Coordinate Systems 
With SPEL+, a maximum of 15 local coordinate systems can be defined.  SPEL+ 
correlates robot coordinate systems and local coordinate systems by defining in advance 
the relative positional relationship of the local coordinate system from the robot coordinate 
system, assigning local numbers (1 to 15), and then assigning the local numbers to 
coordinate system attributes (local). 

To define a local coordinate system, use the Local statement. 
 

6.14.4  Tool Coordinate Systems 
Point data is defined by the position and orientation of the tool coordinate system with 
respect to some reference rectangular coordinate system.  The position is specified by the 
position data (X, Y, Z) and the orientation is specified by the orientation data (U, V, W) 
that correspond with roll, pitch, and yaw.  

You can also define and use your own tool coordinate systems.  To define the tool 
coordinate systems, use Tlset. 

The default TOOL 0 coordinate systems are defined as follows according to the robot type. 

SCARA Tool 0 coordinate system 

The origin of tool 0 for SCARA robots is the center of the forth joint (rotation joint).  
When the fourth joint is adjusted to the position of 0 degrees, the tool 0 coordinate system 
axes are parallel to the robot coordinate system axes (see the figure below.) 

The tool 0 coordinate system rotates as the fourth joint rotates.  

 

b 

X 

Y 

xt0 

xt1 

yt1 

a 

c 

yt0 

Tool 1 coordinate system 

Tool 0 coordinate system 

Robot coordinate system 
 

 

6-Axis Tool 0 coordinate system 

For table mounting, the origin of TOOL 0 is the flange side center of the sixth joint.  In 
TOOL 0, the tool Z axis is perpendicular to the sixth joint flange.  (See the figure in the 
previous section Robot Coordinate Systems).  The TOOL 0 coordinate system moves as 
the 6-Axis robot changes its orientation. 

For ceiling mounting and wall mounting robots, the TOOL 0 coordinate systems are 
defined as shown in the figures in the section Robot Coordinate Systems. 
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6.14.5  ECP Coordinate Systems (Option) 
Specify a coordinate system whose origin point is on the tip of the outside fixed tool 
(hereafter referred to as the external control point or ECP) to move the robot arm holding a 
part in the trajectory made on the external control point along with the part’s edges. 

 

 

External Control Point 
(ECP) 

 
Outside Fixed Tool 

Part 

 
 

Use the ECPSet statement for defining an ECP coordinate system.  A maximum of 15 ECP 
coordinate systems can be defined. 

The following commands are available for optional ECP:  
 Move command -
 Arc3 command -
 Curve and CVMove commands -
 ECP jog motion -

For details, refer to 14. ECP Motion.    
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6.15  Robot arm orientations 
When developing a robot a program, it is necessary to specify the point data taught for a 
particular arm orientation.  If you fail to do so, the position can deviate slightly depending 
on the arm orientation, which in turn can cause the arm to follow an unexpected path, 
resulting in interference with peripheral equipment.  This can be dangerous!  To prevent 
this from happening, the orientation that the arm will be in when moved to the given point 
should be specified ahead of time in the point data.  Such information can also be changed 
from the program. 

 
6.15.1  SCARA robot arm orientations 

With two types of arm orientation, a SCARA robot can move to nearly any position and 
orientation within a given work envelope.  Examples are shown in the figures on the next 
page. 

 

Lefty arm orientation Righty arm orientation  

Examples of moving to the same point using Lefty and Righty arm orientations   
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6.15.2  6-Axis robot arm orientations 
The 6-Axis robot can be operated in various arm orientations within a given work 
envelope as shown below: 

Righty hand orientation Lefty hand orientation 

 
Above elbow orientation Below elbow orientation 

 
NoFlip wrist orientation Flip wrist orientation 

 



6.  The SPEL+ Language 
 

EPSON RC+ 5.0 (Ver.5.4) User's Guide Rev.7 173 

To specify orientation for the 6-Axis robot, add a forward slash (/) followed by L (for 
Lefty hand orientation) or R (Righty hand orientation), A (Above elbow orientation) or B 
(Below elbow orientation), and NF (NoFlip wrist orientation) or F (Flip wrist orientation). 

There are eight available orientations as shown below, however, the 6-Axis robot cannot 
be operated in all of the orientations depending on point. 

Available Orientation 

1 /R /A /NF 5 /R /A /F 

2 /L /A /NF 6 /L /A /F 

3 /R /B /NF 7 /R /B /F 

4 /L /B /NF 8 /L /B /F 

At some points in the work envelope, the 6-Axis robot can have the same position and 
orientation even if the fourth joint or the sixth joint are rotated 360 degrees.  To 
distinguish these points, the J4Flag and J6Flag point attributes are provided.  

To specify the J4Flag, add a forward slash (/) followed by J4F0 (-180 < the forth joint 
angle <= 180) or J4F1 (the forth joint angle <= -180 or 180 < the forth joint angle). 

To specify the J6Flag, add a forward slash (/) followed by J6F0 (-180 < the sixth joint 
angle <= 180), J6F1 (-360 < the sixth joint angle <= -180 or 180 <the sixth joint angle <= 
360), or J6Fn (-180*(n+1) < the sixth joint angle <= 180*n or 180*n <the sixth joint angle 
<= 180*(n+1)). 
 

Singularity 
The orientation in the boundary where the arm orientation switches to the other  

Hand singularity : The boundary where Righty hand orientation and Lefty hand 
orientation switch 

Elbow singularity : The boundary where Above elbow orientation and Below elbow 
orientation switch 

Wrist singularity : The boundary where NoFlip wrist orientation and Flip wrist 
orientation switch 

 

 

 

 

 

 

 
Hand singularity Elbow singularity Wrist singularity 

For the 6-axis robot, Hand / Wrist singularities exist also inside the motion range.  When 
jogging near the singularity, follow the directions below.    
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PTP motion near the singularity  

When jogging a robot from a point near the singularity to a point calculated by point 
operations such as P1+X(10), the robot may move to unintended direction because the arm 
orientation is not properly specified. 

For example, when jogging from a point where the wrist is NoFlip to another point 
calculated by point operations, if the wrist keeps the NoFlip orientation while jogging, 
Joints #4 and #6 may rotate widely (by approx. 180 degrees). 

In this case, switch to the Flip wrist orientation to jog smoothly through the wrist 
singularity.  This phenomenon occurs not only with the point operations but also when 
creating points automatically with Pallet command or the result values that run from vision 
sequence. 

 

 
Proper motion 

 

 
Unintended motion (Joints #4, #6 rotate 180 degrees) 

However in the cases like this, it is difficult for users to specify the proper arm orientations 
by a program.  For this LJM function is a useful command.  LJM function switches the 
arm orientations to enable the least motion of the joints.  For the details of LJM function, 
refer to SPEL+ Language Reference manual.  

Also, AutoLJM command can automatically apply LJM function to the motion commands 
which are included in a particular section of the program without using LJM function.   
For details of AutoLJM command, refer to the SPEL+ Language Reference. 

In addition, you can set AutoLJM function to be enabled at the controller start up by 
setting preferences of the controller.  However, if Auto LJM is enabled in preferences, this 
function automatically adjusts the posture of the manipulator to reduce the motion distance, 
even when you intend to move the joint widely.  Therefore, it is recommended to build a 
program using AutoLJM command or LJM function to operate the manipulator as you 
desired. 

If you specify all points by teaching, the arm orientations are also recorded.  Therefore, the 
manipulator moves to the taught position without using LJM function or AutoLJM.  
Instead, the manipulator may move differently from the taught position by the use of LJM 
and AutoLJM. 
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LJM function for CP motion command 

LJM function and AutoLJM command described above are also available for CP motion 
commands.  However, since CP motion commands give priority to operate based on 
specified trajectories, the manipulator sometimes reach to the point with a different 
posture from the specified one.  At this time, if CP motion command is used with CP On, 
an error from 4274 to 4278 will occur according to the mismatched point flag.  To avoid 
the error, operate the manipulator with CP Off, or match the point flag of a target point 
and the one after motion completion.  If operated with CP Off, the error does not occur 
and the manipulator can continue operation from the point where the mismatch happened. 

Also, you can set the controller’s preference so that the mismatches of flags are not 
considered as an error at the controller startup.  However, path motions which use CP On 
will be disabled. 

 
CP motion near the singularity (singularity avoiding function in CP motion) 

When executing Move or CP motion near the singularity, joint speed may increase rapidly.  
The over speed error will occur and the joints will move widely and interfere with 
peripherals.  Particularly the position of Joint #1 changes greatly near the hand singularity 
and the position of Joints #2 - #6 near the wrist singularity. 

EPSON RC+5.0 has a singularity avoiding function to prevent acceleration errors during 
the execution of CP motion commands that pass the wrist singularity described above.  
With this function, the manipulator takes a detour to avoid an acceleration error by passing 
a different trajectory and returns to the original trajectory after passing the singularity.  For 
details of the singularity avoiding function, refer to AvoidSingularity in the SPEL+ 
Language Reference. 

Singularity avoiding function is enabled as default.  If you want to avoid the error by 
reducing the motion speed in order to maintain the trajectory accuracy, you can disable the 
function temporarily by setting “0” to AvoidSingularity. 

If you cannot avoid errors even if you use the singularity avoiding function, use PTP 
motion to enable the least motion of the joints or arrange the manipulator installation 
position and hand offset volume to prevent the CP motion near the singularity. 
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6.15.3  RS series arm orientations  
The RS series can be operated in various arm orientations within a given work envelope as 
shown below: 

  
Lefty arm orientation Righty arm orientation 

 

 

 

 

J1 F0 arm orientation  J1 F1 arm orientation  

  
J2 F0 arm orientation J2 F1 arm orientation 
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To specify the arm orientation of the RS series, add a forward slash (/) followed by: 

- L (for Lefty hand orientation) or R (Righty hand orientation) 

- J1F0 or J1F1 

- J2F0 or J2F1. 
 
For the RS series robots, some points in the work envelope can have the same position and 
orientation even if J1 or J2 is rotated 360 degrees. 

To distinguish these points, the J1Flag and J2Flag point attributes are provided. 

To specify the J1Flag, add a forward slash (/) followed by: 

- J1F0 (−90 < the first joint angle <= 270), or 

- J1F1 (−270 < the first joint angle <= −90 or 270 < the first joint angle <= 450) 

 

To specify the J2Flag, add a forward slash (/) followed by 

- J2F0 (−180 < the second joint angle <= 180), or 

- J2F1 (−360 < the second joint angle <= −180 or 180 < the second joint angle <= 360) 

There are eight available orientations as shown below.   

Note that some combinations are not available depending on the point. 

 

Available Orientation 
1 /R /J1F0 /J2F0 5 /R /J1F0 / J2F1 

2 /L /J1F0 /J2F0 6 /L /J1F0 / J2F1 

3 /R /J1F1 /J2F0 7 /R /J1F1 / J2F1 

4 /L /J1F1 /J2F0 8 /L /J1F1 / J2F1 
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6.16  Robot motion commands 
SPEL+ includes several commands for controlling the robot from your programs. 
 

6.16.1  Homing the robot 
The Home command moves the robot to a user defined "park" or "idle" position.  This 
command works for all robots.  It is mainly used for absolute encoder robots that normally 
do not need to be mechanically homed.  Use the HomeSet command to set the home 
position and the Hordr command to set the home order. 
 

6.16.2  Point to point motion 
Point to point (PTP) commands move the tool center point of the robot from its current 
position to a specified point.  Motion of the tool center point may not be in a straight line. 

To set the speed for point to point commands, use the Speed command.  To set 
acceleration and deceleration, use the Accel command. 

Command Description 

Go Move directly to a point using point to point motion. 

Jump Jump to a point.  First move up to the current LimZ setting, the move 
over the destination point, then move to the point.  The Arch table 
settings determine the Jump profile. 

Jump3 Jump to a point in 3 dimensions.  Move in a straight line with the same 
orientation until the recede point.  The motion between the recede points 
is PTP motion. 

Pass Move near one or more points. 

TGo Move directly to a point in a tool coordinate system. 

BGo Move in a PTP motion to the relative specified point in Base / Local 
coordinate system. 

 
6.16.3  Linear motion 

Linear motion commands move the tool center point of the robot from its current position 
to a specified point in a straight line.  Liner motion is a CP (Continuous Path) motion. 

To set velocity (speed) for straight motion, use the SpeedS command.  To set acceleration 
and deceleration, use the AccelS command. 

Command Description 

Move Move in a straight line to the specified point. 

TMove Move in a straight line to the specified point in a tool coordinate system. 

Jump3CP Jump to a point in 3 dimensions using CP motion.   

BMove Move in a straight line to the relative specified point in Base / Local 
coordinate system. 
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6.16.4  Curves 
Curves commands move the robot in a circular arc.  Curves is a CP (Continuous Path) 
motion. 

To set velocity (speed) for Curves, use the SpeedS command.  To set acceleration and 
deceleration, use the AccelS command. 

Command Description 

Arc Move the robot through one point to another point using circular 
interpolation. 

Arc3 Move the robot in 3D using circular interpolation. 

Curve Creates a file containing a path specification. 

CVMove Executes a path specified by Curve. 
 

6.16.5  Joint motion 
Command Description 

JTran The JTran command can be used to move one joint of the robot to a 
position specified in degrees or millimeters, depending on the joint type.  
The speed and acceleration are the same as for point to point motion 
commands -- i.e., specified with Speed or Accel commands. 

PTran The PTran command can be used to move one joint of the robot to an 
encoder pulse position.  The speed and acceleration are the same as for 
point to point motion commands -- i.e., specified with Speed or Accel 
commands. 

Pulse The Pulse command can be used to move all joints of the robot to encoder 
pulse positions.  The speed and acceleration are the same as for point to 
point motion commands -- i.e., specified with Speed or Accel commands. 

 
6.16.6  Controlling position accuracy 

Use the Fine command to adjust position accuracy for the end of a motion command.  Fine 
specifies, for each joint, the allowable positioning error for detecting completion of any 
given move.  The lower the Fine settings, the more accurate the final position of the joint, 
which can cause slower performance.  Conversely, large Fine settings can speed up motion 
commands, but position accuracy will decrease.  For many applications, the default 
settings can be used. 
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6.16.7  CP Motion Speed / Acceleration and Tool Orientation 
When you attempt to change only the tool orientation while keeping the tool tip of the 
robot arm at the specified coordinate point or when the tool orientation variation is larger 
than the travel distance of the tool tip, moving the arm by normal CP motion commands 
will cause an increase in the variation of speed, acceleration and deceleration of tool 
orientation.  In some cases, an error will occur. 

To prevent these situations, add the ROT parameter to the CP motion commands.  The arm 
will be moved based on the specified angular velocity and acceleration/deceleration of the 
main axis regarding the orientation variation. 

The angular velocity and acceleration/deceleration of the main axis regarding the 
orientation variation should be specified with the SpeedR and AccelR commands in 
advance.  

For example: 
SpeedR 50 ' degree/sec 

AccelR 200, 200 ' degree/sec2 

Move P1 ROT 

The tool orientation variation is normally comprised of orientation variations of more than 
one rotation axis.  

The SpeedR and AccelR parameters specify the angular velocity and acceleration/ 
deceleration of the main axis regarding the orientation variation.  Therefore, actual angular 
velocity and acceleration/deceleration of the orientation variation are different from the 
parameters except for the case where the rotation axis of the orientation is only one.   
While the motion command with the ROT parameter is executed, the specified SpeedS and 
AccelS parameters are invalid. 

The ROT parameter can be used with the following motion commands:  
Move BMove  
Arc TMove  
Arc3 Jump3CP  

 
6.16.8  PTP Speed / Acceleration for Small Distances 

You can change the speed and acceleration for small distances using PTPBoost and 
PTPBoostOK.  Normally, PTPBoost is not required.  In certain cases, you may want to 
shorten the cycle time even if vibration becomes larger, or conversely you may want to 
reduce vibration even if cycle time becomes longer.  PTPBoost is a robot parameter with 
values from 0 – 100 that affects the speed and acceleration for small distances.  Normally, 
for small distance motion, the desired speed cannot be attained using the current 
acceleration.  By increasing PTPBoost, acceralation, deceleration, and speed are increased 
for small distance motion.  To check if a motion command will be affected by PTPBoost, 
use the PTPBoostOK function.  See PTPBoost and PTPBoostOK in the SPEL+ Language 
Reference manual for more details.  

  

 

NOTE 
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6.16.9  Torque Restriction Function 

For reduction of damage on the arms and the end effectors due to the collision with peripherals, 
the EPSON RC+ is equipped with the torque restriction function. 
The torque restriction function restricts torque at the collision and also stops the robot 
immediately. 

This is a function to reduce damage on the robot at the collision, but cannot avoid damage 
completely.  Also, the functions cannot be used for the purpose of human safety. 

The force applied to the robot at the collision can be 
roughly divided into two types as shown on the right: 
the impact of speed right before the collision, and the 
pressing force by the motor torque after the collision.  
The torque restriction function reduces damage 
caused by the pressing force right after the collision.  
The function does not have any effect on damage 
caused by the impact of speed. 

 Impact of speed 

Pressing force by torque 

Fo
rc

e 

Time  

The torque restriction function adds the margin to the upper limit torque value used in the 
program in order to avoid malfunction, and uses the value as the torque restriction value.   
By using the torque restriction function, the pressing force can be reduced. 

For example, if the torque is restricted at 30%, the pressing force can also be reduced to 30%.  
Also, the robot immediately stops when the torque reaches the upper limit value.  By stopping 
the robot immediately, a further 20-30% reduction effect can be obtained. 
When the torque is restricted at 30% and the robot is stopped immediately, the total of less than 
25% or equivalent reduction effect can be obtained.  
For SCARA robots, the end of the extended shaft may get caught and bent.  To reduce 
occurrence of the bent shaft, it is recommended to use this function to reduce the pressing force 
to the maximum degree. 
 
If malfunction occurs, take any of the following measures for the axis of malfunction. 

- Set LimitTorqueStop or LimitTorqueStopLp off 
- Increase the threshold value of LimitTorque or LimitTorqueLp 

To use the torque restriction function for jogging motion, follow the steps below. 
(1) Execute PTCLR and start torque measurement. 
(2) Execute the jogging motion. 
(3) Measure the maximum torque value by PTRQ, and then add the margin to it. 
(4) Set LimitTorqeLP and LimitTorqeLPStop. 

If the robot is temporarily stopped in the low power motion, the value larger than the normal 
program operation or jogging motion may be obtained.  In such case, execute the temporary 
stop while measuring PTRQ and include it into measurement. 
 
For details of the command and function, refer to the following manual. 

EPSON RC+ 7.0 SPEL+ Language Reference 
LimitTorque Statement, LimitTorque Function,  
LimitTorqueLP Statement, LimitTorqueLP Function,  
LimitTorqueStop Statement, LimitTorqueStop Function,  
LimitTorqueStopLP Statement, LimitTorqueStopLP Function 
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The following is a sample program which automatically configures the torque restriction 
function. 
The program repeats the motion called “all_ax_move”. 
The program measures the maximum torque in the first five moves, adds the margin to the 
measured value (1.2 times if HighPower, 1.4 times if LowPower), and sets the upper limit 
torque value to stop the robot at the upper limit torque.  
This is the example of automatic setting which repeats motion after the sixth time with the 
above settings. 
When the upper limit torque value is changed, the changed value will be considered as “1.0” 
for the subsequent PTRQ measurement.  If the margin of 1.2 times is set, PTRQ will be slightly 
larger than 0.8, and if the margin of 1.4 rimes is set, PTRQ will be slightly smaller than 0.7. 
 
Setting example) 
 
Function main 
 Integer icnt 
 Real rtrq(6) 
  
 Motor On 
 Power High 
‘ Power Low 
 Weight 8 
 Speed 50 
 Accel 80, 80 
  
 icnt = 1 
 PTCLR 
 LimitTorque 100  'init HighPower limit torque 
 LimitTorqueLP 100  'init LowPower  limit torque 
 Do 
  Call all_ax_move 
  Print PTRQ(1), PTRQ(2), PTRQ(3), PTRQ(4), PTRQ(5), PTRQ(6) 
  icnt = icnt + 1 
  If icnt = 5 Then 
   If Power = 1 Then 'High power case 
    Print "LimitTorque set" 
    rtrq(1) = PTRQ(1) * 1.2 * LimitTorque(1) + 1.0 
    rtrq(2) = PTRQ(2) * 1.2 * LimitTorque(2) + 1.0 
    rtrq(3) = PTRQ(3) * 1.2 * LimitTorque(3) + 1.0 
    rtrq(4) = PTRQ(4) * 1.2 * LimitTorque(4) + 1.0 
    rtrq(5) = PTRQ(5) * 1.2 * LimitTorque(5) + 1.0 
    rtrq(6) = PTRQ(6) * 1.2 * LimitTorque(6) + 1.0 
    Print LimitTorque(1), LimitTorque(2), LimitTorque(3), LimitTorque(4), 
LimitTorque(5), LimitTorque(6) 
    LimitTorque rtrq(1), rtrq(2), rtrq(3), rtrq(4), rtrq(5), rtrq(6) 
    Print LimitTorque(1), LimitTorque(2), LimitTorque(3), LimitTorque(4), 
LimitTorque(5), LimitTorque(6) 
    LimitTorqueStop On 
   Else    'Low poser case 
    Print "LimitTorqueLP set" 
    rtrq(1) = PTRQ(1) * 1.4 * LimitTorqueLP(1) + 1.0 
    rtrq(2) = PTRQ(2) * 1.4 * LimitTorqueLP(2) + 1.0 
    rtrq(3) = PTRQ(3) * 1.4 * LimitTorqueLP(3) + 1.0 
    rtrq(4) = PTRQ(4) * 1.4 * LimitTorqueLP(4) + 1.0 
    rtrq(5) = PTRQ(5) * 1.4 * LimitTorqueLP(5) + 1.0 
    rtrq(6) = PTRQ(6) * 1.4 * LimitTorqueLP(6) + 1.0 
    Print LimitTorqueLP(1), LimitTorqueLP(2), LimitTorqueLP(3), 
LimitTorqueLP(4), LimitTorqueLP(5), LimitTorqueLP(6) 
    LimitTorqueLP rtrq(1), rtrq(2), rtrq(3), rtrq(4), rtrq(5), rtrq(6) 
    Print LimitTorqueLP(1), LimitTorqueLP(2), LimitTorqueLP(3), 
LimitTorqueLP(4), LimitTorqueLP(5), LimitTorqueLP(6) 
    LimitTorqueStopLP On 
  EndIf 
  If icnt > 5 Then  
   icnt = 6 
  Endif 
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 Loop While icnt > 0 
 
Fend 
 
Function all_ax_move 
 Integer icount 
  Go JA(10, 10, 10, 10, 10, 10) 
  Go JA(-10, -10, -10, -10, -10, -10) 
Fend 
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6.17  Working with robot points 
A robot point is a set of coordinates that define a position in the robot work envelope.  For 
SCARA and Cartesian robots, a point is defined by the position data (X, Y, Z) within the 
reference rectangular coordinate space and the orientation data (U) which is the rotation 
about the Z axis of the rectangular coordinate. 

For 6-Axis robots, a point is defined by the position and orientation of the tool coordinate 
system with respect to a reference rectangular coordinate system.  The point is specified 
by the position data (X, Y, Z) and the orientation is specified by the orientation data (U, V, 
W) which correspond with roll (rotation about the Z axis), pitch (rotation about the Y axis), 
and yaw (rotation about the X axis). 

The X, Y, and Z coordinates of a point are specified in millimeters.  The U, V, and W 
coordinates are specified in degrees. 

Points are referenced using the letter P followed by an integer number or integer 
expression or by a label defined in the point file editor or Robot Manager Jog & Teach 
page. 

 

6.17.1  Defining points 
You can define points in a program statement, points editor window, [Robot Manager]-
[Jog&Teach] page, or at the [Command] window. 

In a program statement or at the [Command] window, you can assign coordinates to a 
point, or define a point that is the current robot arm position. 

P1 = XY(200, 100, -25, 0) 'Assign coordinates to point P1 

Pick = XY(300, 200, -45, 0) 'Assign coordinates to point pick 

P10 = P* 'Assign a point to current position 
 

6.17.2  Referencing points by name 
You can assign names to point numbers so you can refer to points by name in a program.  
Assign names from the point editor (see Editing Points) or the [Robot Manager]-
[Jog&Teach] page.  Names must be unique for each point number when used in the same 
point file. 
Point labels can include up to 32 alphanumeric characters and the underscore character. 
Characters can be upper case or lower case.  Only alphabets can be used for the first letter. 

For i = 0 To 10 

Go pick 

Jump place 

Next i 
 

6.17.3  Referencing points with variables 
Use the letter P followed by a variable name within parentheses that represents the point 
number you are referencing. 

For i = 0 To 10 

Go P(i) 

Next i 

Although you can define points at the Command window for test purposes, it is 
recommended that all points be defined in a program, point editor, or with the [Robot 
Manager]-[Jog&Teach] page.  Points defined at the [Command] window will be cleared 
from memory when you build a project or run a program unless you execute SavePoints. 
 

 

NOTE 
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6.17.4  Using points in a program 
When starting programs, the default point file for the robot is loaded.  You can also load 
other points in the program using the LoadPoints statement. 

Function main 

Integer i 

 

LoadPoints "model1.pts" 

For i = 0 To 10 

Jump pick 

Jump place 

Next i 

Fend 
 

6.17.5  Saving and loading points 
Use LoadPoints to load a point file in the current project.  You can optionally specify the 
Merge parameter to combine points in a file with points that have already been loaded.   

Use SavePoints to save the points in a point file.  If the point file is in the current project, it 
will be updated on the PC when it is connected and the same project is open. 

If the point file is not the current project, it will not be automatically updated on the PC.  
Use Project Synchronize to copy the file to the PC if desired. 

There are limits to the number of point files and number of total point.  You can register 
up to 100 files and 10,000 points in one project.  If each number is over the limit, an error 
occurs.  

 

6.17.6  Point attributes 
Each point definition can optionally specify a local number and various arm orientations, 
depending on the robot type.  You can specify point attributes in point assignment 
statements or use individual statements and functions to change the attributes of a 
previously defined point. 

Local point attribute 
To specify a local coordinate system number for a point in an assignment statement, add a 
forward slash (/) followed by the local number after the coordinates of the point. 

P1 = XY(300, -125.54, -42.3, 0) /1  ' P1 is in local 1 

The local number can also be an expression enclosed in parentheses. 
P2 = P3 /(mylocal) 

Use the PLocal function and statement to read and set the local attribute of a point. 

Hand point attribute 
To specify orientation for the SCARA or 6-Axis robot, add a forward slash (/) followed by 
L (for Lefty hand orientation) or R (for Righty hand orientation). 

P2 = XY(200, 100, -20, -45) /L ' Hand orientation is Lefty 

P3 = XY(50, 0, 0, 0) /2 /R ' Righty in Local 2 

You can read and set point hand orientation using the Hand statement and function. 
Hand P1, Righty 

 

NOTE 
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Elbow point attribute 
To specify elbow orientation for the 6-Axis robot in a point assignment statement, add a 
forward slash (/) followed by A (Above elbow orientation) or B (Below elbow orientation), 

Elbow orientation is Below. 
P1 = XY(0, 600, 400, 90, 0, 180) /B 

You can read and set point elbow orientation using the Elbow statement and function. 

Wrist point attribute 
To specify wrist orientation for the 6-Axis robot in a point assignment statement, add a 
forward slash (/) followed by NF (NoFlip wrist orientation) or F (Flip wrist orientation). 

Wrist orientation is Flip. 
P2 = XY(0, 600, 400, 90, 0, 180) /F  

You can read and set point wrist orientation using the Wrist statement and function. 

J4Flag and J6Flag point attributes 
At some points in the work envelope, the 6-Axis robot can have the same position and 
orientation even if the fourth joint or the sixth joint is rotated 360 degrees.  To distinguish 
these points, the J4Flag and J6Flag point attributes are provided.   These flags allow you to 
specify a position range for joint 4 and joint 6 for a given point. 

To specify the J4Flag in a point assignment statement, add a forward slash (/) followed by 
J4F0 (-180 < the forth joint angle <= 180) or J4F1 (the forth joint angle <= -180 or 180 < 
the forth joint angle). 

P2 = XY(0, 600, 400, 90, 0, 180) /J4F1  

To specify the J6Flag in a point assignment statement, add a forward slash (/) followed by 
J6F0 (-180 < the sixth joint angle <= 180), J6F1 (-360 < the sixth joint angle <= -180 or 
180 <the sixth joint angle <= 360), or J6Fn (-180*(n+1) < the sixth joint angle <= 180*n 
or 180*n <the sixth joint angle <= 180*(n+1)). 

P2 = XY(50, 400, 400, 90, 0, 180) /J6F2  

J1Flag and J2Flag point attributes 
At some points in the work envelope, the RS series can have the same position and 
orientation even if the first joint or the second joint is rotated 360 degrees.  To distinguish 
these points, the J1Flag and J2Flag point attributes are provided.   These flags allow you to 
specify a position range for joint 1 and joint 2 for a given point. 

To specify the J1Flag in a point assignment statement, add a forward slash (/) followed by 
J1F0 (-90 < the first joint angle <= 270) or J1F1 (-270 <= the first joint angle <= -90 or 
270 < the first joint angle <= 450). 

P2 = XY(-175, -175, 0, 90) /J1F1  

To specify the J2Flag in a point assignment statement, add a forward slash (/) followed by 
J2F0 (-180 < the second joint angle <= 180), J2F1 (-360 < the second joint angle <= -180 
or 180 < the second joint angle <= 360). 

P2 = XY(300, 175, 40, 90) /J2F1   
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6.17.7  Extracting and setting point coordinates 
Use the CX, CY, CZ, CU, CV, and CW commands to get a coordinate of a point or set it. 

xcoord = CX(P1) 

P2 = XY(xcoord, 200, -20, 0) 

ycoord = CY(P*) ' Gets current Y position coordinate 
 

CX(pick) = 25.5 

CY(pick) = CY(pick) + 2.3 
 
 

6.17.8  Alteration of points 
There are several ways of modifying a point without re-teaching it.  You can change one 
or more coordinate values with relative offsets or absolute values. 

To set an absolute value for a coordinate, use a colon followed by the axis letter and the 
value. 

To add a relative offset to a coordinate, use an axis letter followed by the offset value or 
expression in parentheses.  If the offset is negative, then precede the axis letter with the 
minus sign.  If parentheses are omitted, they will be automatically added. 
 
Go P1 -Z(20) Move to P1 with a z offset of -20mm 
Go P1 :Z(-25) Move to P1 with a z absolute position of -25mm 
Go P1 -X(20) +Y(50) :Z(-25) Move to P1 with offsets for X and Y relative 

offsets and an absolute position for Z 
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6.18  Input and output control 
 

6.18.1  Hardware I/O 
There are 24 DC inputs and 16 DC outputs on a standard controller.  8 inputs and 8 
outputs are assigned to remote function.  However, these inputs and outputs can be reset 
and be used as standard I/O.  By purchasing I/O boards, you can add additional 128 inputs 
and 128 outputs.  You can also add Fieldbus I/O option that allows the controller to 
function as a Fieldbus slave.  Refer to 10. I/O Systems for details. 
 

6.18.2  Memory I/O 
There are 32 bytes (256 bits) of memory I/O.  Memory I/O is especially useful for 
synchronizing multi-tasking.  Each memory bit can be treated as both an input and an 
output.   

Use the commands with the "Mem" prefix for memory I/O.  
 

6.18.3  I/O Commands 
Command Description 

In Reads one byte (eight bits) of input data.   

InW Reads one word (sixteen bits) of input data.   

MemIn Reads one byte (eight bits) of Memory I/O. 

MemInW Reads one word (sixteen bits) of Memory I/O. 

MemOff Turns off one Memory I/O bit. 

MemOn Turns on one Memory I/O bit. 

MemSw Read status of one bit of memory I/O. 

Off Turns off one output bit. 

On Turns on one output bit.   

Out Sets/reads one byte (eight bits) of output data.  

OutW Sets/reads one word (sixteen bits) of output data.  

Oport Reads the status of one output bit.   

InBCD Reads one byte of input data in BCD (binary coded decimal) format. 

OpBCD Outputs one byte of output data in BCD format. 

Sw Read status of one bit of hardware inputs or memory inputs. 
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6.19  Using Traps 
Traps are used to cause program execution to jump to a label or enable a function to be 
called or executed as a task when a certain event occurs.  Four traps are user defined and 
are triggered by an input condition.   

Note that Traps must be re-armed before they will fire again.  To re-arm a trap, execute a 
Trap statement at the end of the trap function. 

You should keep trap functions short and avoid continuous loops.  You cannot execute 
motion commands in trap functions. 

For details on Trap statement, see the SPEL+ Language Reference manual. 

Here is a simple example for a trap.  In this example, when input 1 turns on, the Sw1 Trap 
function executes as a task. 

Function main 

  ' Arm the trap 
  Trap 1 Sw(1) = On Xqt Sw1Trap 

  Do 

    RunCycle 

  Loop 

Fend 

Function Sw1Trap 

  ' Turn on output 1 for 2 seconds 
On 1, 2 

  ' Wait for trap condition to clear 
  Wait Sw(1) = Off 

  ' Re-arm the trap 
  Trap 1 Sw(1) = On Xqt Sw1Trap 

Fend 
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6.20  Special Tasks  
Each task of SPEL+ pauses by Pause input or Safety Door open and stops by Emergency 
Stop or Error.  Therefore you cannot create a system that monitors the whole system. 

The Robot Controllers are designed to use upper level PLC or PC to monitor the whole 
system.  

However, you may require a system that continues at Pause input or Safety Door open and 
need to handle the Emergency Stop or error with the controller. 

You can execute a task that continues at Pause input or Safety Door open by specifying 
NoPause or NoEmgAbort task type when executing a task using Xqt. 

These special tasks are useful tasks but may reduce the safety of the system by using them 
improperly.  

Be sure to understand the followings when using these tasks.  

 
6.20.1  Precautions to Use the Special Tasks 

 
CAUTION 

■ Forced Flag 

Specify Forced flag in the I/O output commands such as On/Off command to 
enable On/ Off of the I/O outputs during Emergency Stop, Safety Door open, and 
error. 

Do not connect external equipment that operates mechanically such as actuator 
to the I/O output that specifies Forced flag.  Connecting external equipment may 
cause serious safety problems and operate the external equipment during 
Emergency Stop, Safety Door Open, or error occurrence. 

Forced flag is designed to be specified for I/O outputs connected to external 
equipment without mechanical motion such as status display LEDs. 

NoEmgAbort Task 

When Emergency Stop or error occurs, finish the task promptly after completing the error 
handling.  

If you do not complete the NoEmgAbort task, the controller does not change to Ready 
status and you cannot cancel the Emergency Stop or the error.  You cannot execute Reset 
command from the NoEmgAbort task to cancel the Emergency Stop or the error 
automatically. 

NoEmgAbort task is designed for I/O process without motion and communication with 
external device using the Ethernet.  Therefore there are commands such as robot motion 
commands that cannot be executed in the NoEmgAbort task.  An error occurs if you use 
these commands.  The list of these commands is in the next section. 

For details, refer to EPSON RC+ 5.0 Online Help or Xqt in SPEL+ Language Reference. 
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Outputs off during Emergency Stop  

Uncheck [Outputs off during Emergency Stop] in the [Preferences] page of [Setup 
Controller] to execute I/O On/Off using the NoEmgAbort task after Emergency Stop.  If 
this check box is checked, the execution order of turn Off by the controller and turn On 
using the task are not guaranteed. 

 

NoPause Task 

NoPause task continues the operation during the Pause or Safety Door open condition.  
However, when a robot is operating NoPause task, the task pauses as the robot pauses.  

 

Setting of Safeguard open stops all tasks 

When [Outputs off during Emergency Stop] is checked in the [Preferences] page of [Setup 
Controller], NoPause task stops by Safety Door open.  NoEmgAbort task continues the 
task. 

 
6.20.2  NoPause/NoEmgAbort task Specification 

Status by Event and Task 

Event 
Task Type 

Normal NoPause NoEmgAbort 
Pause Statement 
Pause Input 
Pause Button 

Pause Continue *1 Continue  

Safety Door Open Pause *2 Continue *1 *2 Continue  

Error during Auto Mode Stop Stop Continue  

Error during Program Mode Pause Pause Continue  

Emergency Stop Stop Stop Continue  

Stop Button 
Stop Input  

Stop Stop Stop 

Halt Statement 
Halt Button 

Pause Pause Pause 

Brake Point Pause Pause Pause 

Switching to Teach Mode Stop Stop Stop 

*1 When the robot is operating, the task pauses as the robot pauses. 

*2 When [Outputs off during Emergency Stop] is checked in the [Preferences] page of 
[Setup Controller], normal tasks and NoPause tasks stop by Safety Door open.  
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Task Execution 

Normal Omit the task type in Xqt statement, or specify Normal for the task 
type. 

Xqt NormalTask 
Xqt NormalTask, Normal 

NoPause Specify NoPause in Xqt statement. 
Xqt NoPauseTask, NoPause 

NoEmgAbort Specify NoEmgAbort in Xqt statement. 
Xqt NoEmgAbortTask, NoEmgAbort 

You cannot change the task type after executing a task. 

main to main7 that are executed at the beginning of the program are executed as normal 
tasks. 

Tasks executed in Trap Xqt are normal tasks. 

 

Restricted Commands by Task Types 

Normal No restriction  
NoPause No restriction 
NoEmgAbort Cannot execute the following commands. 

Command for robot motion 
Commands for vision 
Reset, Xqt, Trap, etc.  

For details, refer to EPSON RC+ 5.0 Online Help or Xqt in SPEL+ 
Language Reference. 

 

6.20.3  NoPause/NoEmgAbort Example  
The following example shows a program that monitors the error of the controller and 
switches the I/O On/Off when error occurs according to the error number.  

The program example of ErrOn, EStopOn, SafetyOn are indicated in the EPSON RC+ 5.0 
SPEL+ Language Reference. 
Function main 

Xqt ErrorMonitor, NoEmgAbort 
: 
: 

Fend 
 
Function ErrorMonitor 
 Wait ErrorOn 
 If 4000 < SysErr Then 
  Print "Mortion Error = ", SysErr 
  Off 10, Forced 
  On 12, Forced 
 Else 
  Print "Other Error = ", SysErr 
  Off 11, Forced 
  On 13, Forced 
 EndIf 
Fend 
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7.  Building SPEL+ Applications 

 
7.1  Designing Applications 

 
7.1.1  Creating the simplest application 

The simplest SPEL+ application has one program and one point file.  This is what is 
automatically defined for you when you create a new project.  A blank program named 
“Main.prg” (“Program.prg” for simple mode) and a blank point file named “Points.pts” are 
created. 

To write and run a simple application 

1. Select [New Project] from the [Project] menu to create a new project. 

2. Write your program source code in the file that was created for you called “Main.prg”. 

3. Teach the robot points using the [Robot Manager]-[Jog&Teach] page. 

4. Run the program by selecting [Run] window from the [Run] menu or by pressing F5 
(the shortcut key for the Start command). 

 
7.1.2  Application Layout 

Before writing your application, you need to decide what your application will accomplish 
and how the project will be structured.  Here are some general guide lines. 

Programs 
Each project can contain up to eight programs that can be started from the Operator 
Window, Remote Control, or VB Guide.  Each program has a start function, as shown in 
the table below. 

Program # Program Name Start Function 
0 main main 
1 main1 main1 
2 main2 main2 
3 main3 main3 
4 main4 main4 
5 main5 main5 
6 main6 main6 
7 main7 main7 

Your project must always define function main so that the main program can be started.  
The other programs are optional.   If you use the Operator Window for your operator 
interface, you can define meaningful names for each of the programs used in your project 
in [Project]-[Properties]-[Operator Window]. 

Operator interface 
Operator Window 
Use the operator window provided with EPSON RC+ 5.0.  You can configure EPSON 
RC+ 5.0 so that after Windows starts, EPSON RC+ 5.0 will start in Auto mode, which will 
automatically open the Operator Window. 

Operators can select from 1 to 8 programs that you specify.  They can also optionally use 
the I/O Monitor, Robot Manager, and System History viewer. 

To use the Operator Window, a PC must be connected to the controller.  The RC90/RC180 
Control Device must be set to PC. 

For details on configuring EPSON RC+ 5.0 for auto start, see section Start Mode in the 
Operation chapter. 

Remote Control 
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Use remote control to turn motors on/off, home the robot, start programs, etc.  A simple 
push button box can be used, or a PLC can be connected.   

When using Remote Control, a PC does not need to be connected to the controller.  The 
RC90/RC180 Control Device must be set to Remote. 

Operator Panel 
Use the OP1 Operator Panel.  With the OP1, operators can run  
programs and monitor I/O and task status.  See the OP1 Manual for more information. 

When using the Operator Panel, a PC does not need to be connected to the controller.  The 
RC90/RC180 Control Device must be set to OP. 

Windows Application using VB Guide 
Use the VB Guide Option along with a Windows development tool such as Visual Basic, 
Visual C#, or Visual C++.  See the VB Guide Manual for more information. 

Safety interface 
Use guard doors, safety mats, light curtains, etc. to protect the operator from injury.  

Robot Points, Pallets, Tools, Locals 
Decide on which points you need for the work cell.  In many cases you will only need one 
point file per robot. 

Take advantage of Pallets, Tools, and Locals.  Time spent on using these can save hours 
later on the production line.  For example, if your cell has many points that take a lot of 
time to train, consider using Locals so that if the end effecter is damaged or replaced, you 
only need to redefine the Locals, not retrain all of the points. 

Try to design in automatic or semi-automatic procedures for calibrating tools and locals.  
Even if you define them manually, write instructions on how to define them so the process 
can be repeated easily. 

Inputs and outputs 
Layout your I/O early in the design stages.  Use I/O labels in your programs.  You must 
purchase additional I/O boards if you need more than 24 inputs or 16 outputs.  You can 
also use the Fieldbus option so the controller can be a Fieldbus slave. 

Peripherals 
RS-232C is not standard for RC90/RC180 Controller.  You can also add more ports by 
installing an optional RS232 expansion board.  See the chapter RS-232 Communications. 

The RC90 controllers have one RS-232C port as standard.  In addition, you can add more 
four ports by mounting the optional RS-232C expansion boards.   

For details, refer to 12. RS-232C Communications. 

You can use TCP/IP to connect peripheral equipment. 
For details, refer to 13. TCP/IP Communications. 
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7.2  Managing Projects 
 

7.2.1  Overview 

What is an EPSON RC+ 5.0 Project? 
An EPSON RC+ 5.0 project is a collection of SPEL+ program files, robot point files, and 
setup parameters used to run a SPEL+ application. 

Why do you need projects? 
Projects are a safe and convenient way to manage your SPEL+ applications.  All the 
information for each application is kept in one project.  By keeping all of your application 
code and point definitions in one project, it's easy to open a project and begin running or 
editing.  Also, it's easy to create new versions of an application and run older versions.   

Projects make it easier to maintain your application code with less chance of a program 
being lost. 

There are also functions for copying and renaming projects, making it easy to create new 
projects from previous versions and for backing up projects to an external media such as a 
USB memory key. 

What's in an EPSON RC+ 5.0 project? 
Each project has its own folder on disk.  This keeps all of the files for each project 
separate from each other.  The project folders are under the “\EpsonRC50\Projects” folder 
on any drive.  Sub folders may also be created. 

The following paragraphs describe the components of a project. 

Project file 
This file contains all of the information that describes the project.  This file is 
automatically created by EPSON RC+ 5.0.  You should never edit this file.  Doing so may 
cause errors when you open the project.  The file extension is “.sprj”. 

Program source files 
A program source file is an ASCII text file that contains one or more SPEL+ functions.  
Each function in SPEL+ can be run as a separate task (thread) in the controller or called 
from other functions. 

Include files can also be used.  These contain macro definitions and must be included in a 
program file using the #include statement.  The file extension is “.prg”. 

Point files 
A point file contains a list of robot points.  The file extension is “.pts”.  Each point 
describes a Cartesian coordinate in the robot work envelope.  

Default Project 
When you create a new project, one program (Main.prg) and one point file (Points.pts) are 
created for you.  For some users, this is all they need to get started.  They don't have to 
configure the project.  They can just type in a program, teach points using the Robot 
Manager Jog and Teach Tool, and run the program. 
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7.2.2  Creating a new project 

Projects can be created on any drive on your system.   
Projects always reside in the “\EpsonRC50\Projects” folder or sub-folder.  

 

To create a new project 

1. Select [New Project] from the [Project] menu.  The [New Project] dialog box will 
appear. 

2. Select the disk drive where you want the project to be stored on. 

3. Select the project folder or create a new folder by clicking the <New Folder> button 
after selecting the parent folder. 

4. Type in the name for the new project. 

5. Optionally, select a template to base the project on. 

6. Choose <OK> to create the project. 
 

7.2.3  Configuring a project 
Each application project you create must be configured properly before you can run the 
application. 

There are two commands in the Project Menu that allow you to configure a project: Edit 
and Properties. 

Editing a project 
Select Edit from the Project Menu to open the Edit Project dialog.  From this dialog, you 
configure which programs, include files, and point files are used in the current project. 

 
For details on Project | Edit, see the Edit Command (Project Menu) in the chapter EPSON 
RC+ 5.0 GUI.   
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7.2.4  Building a project 
Before you can run any of the code in your application, you must build the project. 

To build your application project 

Select [Build] from the [Project] menu or click on the <Build> button  on the toolbar. 

 Or 

Select [Rebuild] from the [Project] menu.  This will rebuild the entire project. 

 Or 

Select [Run Window] from the [Run] menu or click the <Run> button  on the toolbar.  
The project will be built before the [Run] window appears. 

 Or 

Select [Operator Window] from the [Run] menu.  The project will be built before the 
Operator Window appears. 

After the files have been compiled and linked, the project files are sent to the controller. 
 

Status Pane 
This window shows progress messages and error messages during project build.   

 

Double click this 
line to go to the 
source code. 

 
When errors occur during the build process, a message is displayed that includes the error 
number, program file name, and line number.  Double click on the line with the error to go 
directly to the source code that caused the error. 
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7.2.5  Making copies of projects 

Use the [Copy Project] command in the [Project] menu to copy all of the files in the 
current project to another disk drive or directory.  You can also save the project under a 
different name.   

This command is useful for making backups or for transferring a project to an external 
media such as a USB memory key so that it can be loaded on another machine. 

Use the [Save As] command in the [Project] menu to save the current project under a 
different name or drive and re-open it using the new name and location.  This command is 
useful for making a test version of a project without making changes to the original project. 
 

7.2.6  Backing up a project 
To make a backup copy of the current project, use the [Copy Project] command in the 
[Project] menu to copy the project to another disk drive.  Typically you will want to copy 
the project to a USB memory key. 

To restore a project from the external media such as a USB memory key (or different hard 
drive), open the target project, then use the [Copy Project] command to copy the project to 
the original disk 
 

7.2.7  Converting a simple mode project 
A project created in Simple mode can be converted to Normal mode by opening it while 
operating in Normal mode.  However, once the project is transferred to Normal mode, it 
cannot be used in Simple mode. 
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7.3  Editing Programs 
Before you can edit a program, it must be in the current project and opened in a program 
editor window.  When you first create a new project, this is done for you automatically.  
You can open several program editors during one session. 

To open a program for editing 
1. Select Open from the File Menu. 

2. Select the file(s) you want to open. 

3. Choose <OK> to open the file. 
 

7.3.1  Program rules 
A program contain one or more SPEL+ function definitions. 

Lines can be blank.  You can insert any number of blank lines to separate subroutines and 
functions, if desired. 

The maximum length for each line is 200 characters, including the line number, if used. 

The maximum line number is 32767.  You will get an error if you try to run a program 
with a line number that is too large.   
 

7.3.2  Typing in program code 
Each line can optionally start with a line number.   

You can enter program statements in upper or lower case.  Whenever you leave a line that 
has been changed, the line will be formatted.  SPEL+ keywords are case formatted and 
spaces are inserted around operators and after semi-colons and commas. 

Consider using mixed case or lower case for variables and function names instead of all 
CAPs.  This will make your code easier to read. 

Use indentation for statements within loops.  The [Auto Indent] feature automatically 
moves the cursor under the start of the previous line.  It also indents lines after If, Else, For, 
Select, Case, and Do statements. 

 
For i = 1 To 10 

    Jump P(i) 

    Jump P0 

Next i 

Use the [Auto End Construct] feature to automatically add the end construct statement.  
For example, when you enter a For statement and press Enter, a Next statement is 
automatically created with an indented blank line above it. 
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7.3.3  Syntax Help 

When you type in a SPEL+ keyword or user function, the syntax help window will appear 
to show the syntax of the statement or function.   After the statement is entered, the syntax 
helper will automatically close, or you can press the Esc key to close it.  You can enable 
and disable Syntax Help from the [Setup]-[Preferences]-[Editor] tab. 

A list box will be displayed for some parameters as you type.  To select a value in the list, 
use the up and down arrow keys, or type the first few characters, to highlight the desired 
item, then press <Tab> to select the item.  You can also type in a value not shown in the 
list, such as a variable or literal constant.  Press <Esc> to hide the list box.  In addition to 
<Tab>, you can use a comma or period to select an item.  In the example shown below, the 
first parameter of the On statement can be an output label, so a list of output labels in the 
current project is displayed. 
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7.3.4  Syntax Errors 

When a syntax error is detected, the line with the error will be displayed in red.  If the 
caret is placed on the line with the error, then a brief message will be displayed on the 
status bar.  For example, in the program shown below, the message "Expression expected" 
is displayed on the status bar. 

 

Red indicates 
syntax error 

Error message 
in status bar 
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7.4  Editing Points 

EPSON RC+ 5.0 provides a spreadsheet editor for robot points.  You can define new 
points or cut, copy, and paste points from one point file to another, including between 
projects. 

Robot teach point definitions are kept in files on your PC and in the robot controller.  
EPSON RC+ 5.0 always keeps project point files in the robot controller up to date with the 
files on the PC. 

To open a point file for editing 
1. Select [Open] from the [File] menu to show the [Open] dialog box. 

2. Choose the <Points> radio button. 
You will see a list of point file names in the files list box. 

3. Select the point file you want to edit by clicking on the name. 

4. Press the <Open> button to open the file. 
You will see a spread sheet window for the point file you selected. 

The robot points spread sheet window 

 

Row select 

 

 
The spreadsheet window contains one row for each point in the file.  The spreadsheet 
always contains rows for all points, even if they are not defined.  The cells for an 
undefined point are blank. 

Row select column This is the first column on the left.  Click on this column to select 
a row. 

Number column Point number.  Range is from 0 to 999. 

Name column Name of the point. 

Coordinate columns Coordinates in millimeters for X, Y, Z and degrees for U, V, and 
W. 

Local number column Local number drop down list.  Range is from 0 to 15. 

Hand column Drop down list with two values for robot hand orientation:  
Lefty and Righty.   

Elbow column Drop down list with two values for robot elbow orientation: Above 
and Below.  This column is shown only for 6-axis robots.   
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Wrist column Drop down list with two values for robot wrist orientation: Flip 
and NoFlip.  This column is shown only for 6-axis robots. 

J4Flag column Drop down list with two values for robot J4Flag: 0 and 1.  This 
column is shown only for 6-axis robots. 

J6Flag column Drop down list with values for robot J6Flag: 0 - 127.  This column 
is shown only for 6-axis robots. 

J1Flag column Drop down list with values for robot J1Flag: 0 and 1.  This column 
is shown only for RS series. 

J2Flag column Drop down list with values for robot J2Flag: 0 and 1.  This column 
is shown only for RS series. 

To select one or more rows 
Click on the row select column (first column on the left) to select a row.  To select more 
than one row, point to the row select column of the first row you want to select.  Hold 
down the left mouse button and drag the mouse down or up to select more rows. 

To select all rows 
Execute [Select All] from the [Edit]] menu, or type <Ctrl>+<A>. 

To define a new point 
Using the mouse put the spreadsheet cursor anywhere on the row of the point you want to 
define and start entering information for the point.  This automatically defines the point, 
which means it will be sent to the robot controller at the next project build or Jog and 
Teach command. 

For example, put the cursor in the Name column and type in a name for the point. 

Press the TAB key to move to the X coordinate column.  Type a coordinate value, then 
press Enter.  You will see zeros automatically entered for all of the other coordinates of 
the point.  This indicates that the point as been defined. 

To delete a point 
Select the row containing the point and cut it by selecting [Cut] from the [Edit] menu or by 
typing <Ctrl>+<X>. 

To cut and paste points 
1. Select one or more rows and execute either the [Cut] or [Copy] command from the 

[Edit] menu. 

2. Select the row where you want to start the paste. 

3. Execute the [Paste] command from the [Edit] menu. 
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7.5  Running and Debugging Programs 

You can run programs from the [Run] window or from the Operator Window.  The [Run] 
window is used primarily for testing and debugging.  The Operator Window is used as an 
operator interface for simple applications or demos. 

To run a program 
Select [Run] window from the [Run] menu.  This command will build the project (if 
required) and open the [Run] window.  The [Run] window allows you to choose which 
function to execute.  Select a function, then click <Start>. 
 

7.5.1  The Run Window 
The [Run] window includes controls for running the programs in the current project. 

To open the Run window 
Select [Run Window] from the [Run] menu, or click on the <Run> button  on the 
toolbar.  If necessary, all changed open files will be saved and the project will be built.  If 
the build is successful, the Run window will appear. 

 

To close the Run window 
Choose [Close] from the [File] menu or double click on the  button in the upper right 
hand corner of the window. 

 



7.  Building SPEL+ Applications 
 

EPSON RC+ 5.0 (Ver.5.4) User's Guide Rev.7 205 

Item Description 

Text area This is the area that takes up most of the run window.  Output 
from your programs is displayed here.  When your program uses 
an Input statement, you can type in the requested input from this 
text box.  You can use the scroll bars to view the entire text 
buffer. 
If an error occurs while running a program, the error number, 
line number and function name will be displayed in this text area.  
You can double click on the line where the error is displayed to 
directly go to the source line that caused the problem.  You can 
also get help on the error that occurred by putting the cursor 
anywhere on the line and pressing F1. 

Function Select a function to start.  Functions are sorted alphabetically. 
Function main is selected by default. 

Low Power When this box is checked, SPEL+ ignores the Power High 
command.  This allows you to run your program in low power 
mode to verify operation without having to change the program. 

Speed Factor Specifies the robot motion speed factor.  The speed factor is a 
percentage of maximum point to point speed and linear 
interpolated speed.  For example, if you program executes Speed 
80 and the speed factor is 50%, the robot will move at speed 40. 

Start Starts the function shown in the function drop down list. 

Stop Stops all tasks.  If the robot is executing a motion command 
when this button is pressed, the robot will decelerate to a stop.   

Pause Pauses all tasks with pause enabled.  Activates the <Continue> 
button.  If the robot is executing a motion command when this 
button is pressed, the robot will decelerate to a stop. 

Continue Continues paused tasks.   

CTRL+C Same as <Stop> button.   
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7.5.2  Debugging 
EPSON RC+ 5.0 supports source level debugging.  You can set breakpoints and step 
through your source code.  You can also pause / continue a program or halt a task using 
the Task Manager. 

Setting and clearing breakpoints 
Open the program where you want to set a breakpoint, then click on the line where you 
want to stop.  Use one of the following methods to set a breakpoint: 

 If Margin Indicators are enabled, then click in the margin next to the line on the left.   -
You will see a breakpoint symbol next to the line. 

Or 

 Type F9. -

Or 

 Select Toggle Breakpoint from the [Run] menu. -

Execute one of the methods above to clear a breakpoint, or select [Clear All Breakpoints] 
from the [Run] menu. 

You cannot set a breakpoint on non-executing statements, such as #define, #include, or 
blank lines. 

After setting a breakpoint, the task will halt when the execution line is reached the 
breakpoint.  You can set or remove a breakpoint while a task is running. 

When reached a breakpoint, the program window containing the program source line at the 
breakpoint is opened and the line is highlighted in yellow.  The task number is shown in 
the title of the editor window. 

If more than one task reaches a breakpoint, then a program window will be opened for 
each task.  This allows you to step through each task that reached the breakpoint. 
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Stepping through a program 
There are three commands on the [Run] menu that are used for stepping through code.   

[Step Into] steps through each line and also steps into functions when a step is executed on 
a Call statement. 

[Step Over] steps through each line but when a Call statement is encountered, the function 
in the statement is executed completely. 

Walk executes lines until after the next motion command and then halts the task.  It will 
halt after the next output command if the [Setup]-[Controller]-[Preferences]-[Walk stops 
for outputs] checkbox is checked. 

To step through code, you must set a breakpoint and run until the breakpoint is reached, or 
suspend a task from the Task Manager using the <Halt> button. 

Viewing the Call Stack 
Sometimes you may want to examine the call stack for the current task after you halt the 
task from the task manager, or reach a break point.   

To view the call stack, select [Call Stack] from the [Run] menu.  The [Call Stack] list will 
be displayed, as shown below. 
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After you select a function in the [Call Stack] list, the function will be displayed in a 
program window and an arrow in the left margin will point to the line where the next 
function in the call stack is being called.  In the example below, the arrow in the 
SingleCycle function is pointing to the Gripper On statement to indicate that Gripper was 
called from SingleCycle. 

 

Displaying variables 
To view variable values, you can do one of the following: 

1. When a task is halted by halt or breakpoint, you can view the value for a variable by 
moving the mouse cursor over the variable name.  The value will be displayed in a tool 
tip type window beneath the variable name. 
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2. Select [Display Variables] from the [Run] menu to display the variable display dialog.  
This dialog has three tabs for viewing Global, Module, and Local variables. 

 
You can change the value of a variable by checking the [Edit] checkbox, then type in the 
new value in the value column.  Next, click the <Write> button to change the variable.  
When the [Edit] box is checked, the variable values are not automatically updated.  You 
can click the <Read> button to update all values.   
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7.6  The Operator Window 
The Operator Window can be used as a simple interface for operators.  You can configure 
EPSON RC+ 5.0 to open only the Operator Window when started.  In addition, when 
Remote Control is being used, the Operator Window can be displayed for monitoring 
purposes. 

 Title 

Status bar 

Operator buttons 

 

 
Item Description 

Program to Run Select the program to run. 

Start Starts the first function in the main program. 

Stop Stops all tasks. 

Pause Pauses all tasks that are enabled for pause. 

Continue Continues paused tasks. 

Robot Manager Opens the Robot Manager dialog in operator mode. 
It cannot be shown while the program is running. 

I/O Monitor Opens the I/O Monitor in operator mode.  This window can 
remain open while programs are running. 

System History Opens the System History window.  This window can remain 
open while programs are running. 

Simulator Opens the Simulator Window. 

Status Bar The status bar is located at the top of the window and shows 
emergency stop and safeguard status.  In addition, if a warning 
is detected from the controller (such as low encoder battery), a 
warning label will be displayed on the right side of the status 
bar.  If the mouse is over this label, you can see the warning 
error message.  When there is no warning, the warning label is 
hidden. 
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7.6.1  Operator Window Configuration 
You can configure the Operator Window from the Operator Window pages in [Project]-
[Properties]. 

 
There are several settings for operator Robot Manager and I/O Monitor. 

For details, refer to 5.9.15 [Properties] Command (Project Menu). 
 

7.7  Using Remote Control 
You can design your application to be run from external equipment using hardware I/O 
control.  This includes push button boxes, PLCs, and other PC systems. 

Refer to 11. Remote Control for details. 
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8.  Simulator  
 

8.1  Simulator Functions 
Simulator functions enable easy robot motion checking on your PC, which gives you 
flexibility to consider the system layout, measure the operation time, and create robot 
programs.  
They are useful from the introduction stage to the launch of robot system. 
The Simulator is supported in EPSON RC+ 5.0 Ver.5.4 or later.  

 
8.1.1  Overview 

The following are the major simulator functions:  

Robot motion 3D display 
- Shows robot orientation and motion in a 3D display from various viewpoints. 
- Offers accurate display data based on design data. 

 
Interference check  

- Checks whether the robot (including the hand) interferes with itself or its peripherals. 
 
Robot operation time prediction  

- Predicts the robot operation time for a program.  
- Considers the speed setting (Speed, etc.) and acceleration / deceleration setting 

(Accel, etc.) when predicting the robot motion time. 
 
SPEL+ program execution 

- Allows you to create, execute, and debug SPEL+ programs. 
 
The restrictions on the simulator functions are described in 8.4 Specification and 
Restriction of Simulator. 
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8.1.2  System Requirements 

Recommended specification 
When using CAD data, we recommend using a PC running Windows 7 Professional 32 bit 
version.  
 
OS Windows 7 Professional 32 bit version 
CPU Core i3 or more  
Memory 1 GB or more  
Hard disk spare capacity 4 GB or more 
Graphic DirectX9 or later must be available.  

OpenGL2.1 or later must be supported. 
 

Minimum specification 
To use one robot with several peripherals and operate them in a simple manner, the 
following environment is required. 
 
OS Windows 8.1 Pro 

Windows 7 Professional 32 bit version 
Windows XP Professional 32 bit version, SP3 or later 
Windows Vista Business 32 bit version, SP2 or later 

CPU 1.6 GHz or more, 32 bit (x86) Multi Core Processor 
Memory 512 MB or more 
Hard disk spare capacity 4 GB or more 
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8.2  Using the Simulator 
You can try the simulation functions using the provided sample virtual controllers and 
projects.  Refer to 8.2.1 Working with the samples. 
You can also select the robot model and build your own system.  Refer to 8.2.2 Working 
with a user created  system. 

 
8.2.1  Working with the samples 

You can operate a robot easily using the samples provided.  Follow the steps below: 
1.  Connect with a sample virtual controller (robot) 
2.  Open the corresponding sample project 
3.  Display the simulator window  
4.  Operate the robot by executing a program 
5.  Next step 

1.  Connect with a sample virtual controller   
 

Select “G6 Sample” from the EPSON RC+ 5.0 Tool bar-<Connection> list box. 
When the connection is complete, the <Connection> list box shows “G6 Sample”.  
 

2.  Open a corresponding sample project 
(1) Click the EPSON RC+ 5.0 menu-[Project]-[Open…]. 
(2) Select [Projects]-[SimulatorDemos]-[G6 Sample]. 

 
  



8.  Simulator 
 

EPSON RC+ 5.0 (Ver.5.4) User's Guide Rev.7 215 

(3) Click the <Open> button.  Then, the following program window appears. 

 

3.  Display the simulator window  
Click the Tool bar-<Simulator > button.  The [Robot Simulator] window appears.  
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4.  Operate the robot by executing program 
(1) Click the Tool bar-<Run Window  > button.  The project will be built and the 

[Run] window will appear. 

 
(2) Click the <Start> button.  

The message “Are you ready to start?” appears.   Click the <Yes> button. 
The program starts and the robot moves in the 3D display.  

 

5.  Next step 
If you want to change the sample, follow the steps in 8.2.2 Working with a user created 
system - Steps 5 to 7.  If you want to create your own system, start from Step 1.  

If you want to change the sample virtual controller, follow the steps in 8.3.4 Virtual 
controller - Copy the sample or configured virtual controller and change the copied 
sample.  

 

8.2.2  Working with a user created system  
You can create your own system and simulate the robot operation on your PC.   
Follow the steps below: 

1.  Create a new virtual controller (Connection setting) 
2.  Connect with the virtual controller 
3.  Configure a robot  
4.  Display the simulator window 
5.  Create and place objects 
6.  Create a project and program 
7.  Operate the robot by executing the program 
8.  Measure the robot operation time 
9.  Test for collisions  
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1.  Create a new virtual controller (Connection setting)  

(1) Click the EPSON RC+ 5.0 Tool bar-<Setup PC to robot controller communications. 
 > button.  The [PC to Controller Communications] dialog appears.  

 
(2) Click the <Add> button.  The [New Controller Connection] dialog appears. 
(3) Select [Connection to new virtual controller] and click the <OK> button. 

 
(4) A new virtual controller named “Virtual 1” is created.  Click the <Apply> button. 

 
(5) Close the dialog to return to the EPSON RC+ 5.0 main window.  
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2.  Connect with the virtual controller  
 

(1) Select the created “Virtual 1” connection from the EPSON RC+ 5.0 Tool bar-
<Connection> list box.  When the connection is complete, the <Connection> list box 
shows “Virtual 1”. 

(2) “Virtual 1” has no configured robot, so the following warning appears.   
Click the <OK> button.  

: 

3.  Configure a robot 
In this tutorial, a G6-551S robot model is used.  
(1) Select the EPSON RC+ 5.0 menu-[Setup]-[Controller].  
(2) Select the [Robot]-[Model] from the tree on the left side of the window.   The [Robot 

Model] page appears.  

 
(3) Select “G6-551S” from the [Model] list box.  
(4) Click the <Apply> button.  The message “Restarting Controller” appears.   
(5) When the message disappears, close the window and go back to the EPSON RC+ 5.0 

main window.  
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4.  Display the [Robot Simulator] window 

(1) Click the Tool bar-<Simulator > button.  The following window appears. 
 

 
(2) Configure the robot name.  

Select the robot in the [Layout Objects] and set its name in the [Property]-[Name] on 
the lower left of the window.  For this tutorial, enter “MyRobot”. 

 
5.  Place the objects 
For this tutorial, we will add a box to the layout.  
(1) Drag & drop the <Box  > button on the Tool bar to the [2D Layout] panel.  

 

 
(2) Select “SBox_1” from the [Layout Objects] and change the [Property]-[Position].  

For this tutorial, enter X = 600, Y = 300.  
 
To change the position, you can also drag the objects in the [2D Layout] panel. 
To save the layout change, execute the EPSON RC+ 5.0 menu-[File]-[Save].  

 
  

 

TIP 
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6.  Create a project and program 
(1) Create a new project  

(1)-1 Click the EPSON RC+ 5.0 menu-[Project]-[New Project]. 
(1)-2 Enter a new project name.  For this tutorial, enter “Test”.  
(1)-3 Click the <OK> button.  Then, the project “Test” is created. 

(2) Operate the robot and teach points.  
(2)-1 Click the Tool bar-<Robot Manager  > button.  The [Robot Manager] 

window appears.  
(2)-2 Select the [Control Panel] tab and click the <MOTOR ON> button.  

The message appears to confirm the operation.  Click the <Yes> button.  
(2)-3 Select the [Jog & Teach] tab.  The following window appears. 

 
(2)-4 In the [Robot Simulator] window, move the robot joint to a point where it 

does not interfere with the box. 
To move the robot joint, drag the robot joint while simultaneously pressing 
the <Ctrl> key.  
 

 
(2)-5 Go back to the [Robot Manager] window and click the <Teach> button on the 

lower right.  The message appears to confirm the operation.  Click the <Yes> 
button.  

(2)-6 The [New Point Information] dialog appears.  Click the <OK> button. 
(2)-7 Select “P1 - (undefined)” from the [Point] list box on the lower right.  
(2)-8 In the [Robot Simulator] window, drag the robot joint while simultaneously 

pressing the <Ctrl> key to another point without interfering with the box.    
(2)-9 Go back to the [Robot Manager] window and click the <Teach> button.  The 

message appears to confirm the operation.  Click the <Yes> button.  
(2)-10 The [New Point Information] window appears.  Click the <OK> button.  
(2)-11 Click the Tool bar-<Save all files> button to save the P0 and P1 data.  

 
You can also use the [Jog & Teach] window to move the robot.  

 
  

 

TIP 
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(3) Create and execute a program with robot motion.  
(3)-1 Create the following program in the program “Main.prg”.  

Function main  

 Go P0 

 Go P1 

Fend 

(3)-2 Click the Tool bar-<Build> button to build the program.  
When the program building is completed, the message “Build complete, no 
errors” appears in the [Status] window.  

 
7.  Operate the robot by executing program 
(1) Click the Tool bar-<Run Window> button.  The following dialog appears. 

 
(2) Click the <Start> button. 

The message “Are you ready to start?” appears.  Click <Yes> button.  
The program starts and the robot moves in the 3D display.  

 

8.  Measure the robot operation time 
The elapsed program run time (cycle time) is displayed in the Tool bar of the [Robot 
Simulator] window. 
It is the execution time of the program from start to finish. 

 

  
The following describes how to measure the operation time between two points (P0  P1).  
(1) Change the program in the “Main.prg” file to the following program. 

Function main  

   Motor On 

   Power High 

   Speed 100 

   Accel 100,100 

   Go P0 

Fend  

 

Function main2 

   Go P1 

Fend 
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(2) Click the Tool bar-<Build> button to build the project.  
When the project build is complete, the message “Build complete, no errors” appears 
in the [Status] window.  

(3) Click the Tool bar-<Run Window> button.  
(4) Confirm that “main” is selected in the [Function] dropdown list and click the <Start> 

button.  
The message “Are you ready to start?” appears.  Click <Yes> button.  
The program starts and the robot goes to P0, the point to start the time measurement, 
in the 3D display. 

(5) Select “main2” in the [Function] dropdown list. 
(6) Click the <Start> button. 

The message “Are you ready to start?” appears.  Click the <Yes> button. 
The program starts and the robot moves in the 3D display.  
Now, the cycle time displayed in the Tool bar is the execution time to move the robot 
from P0 to P1. 

When you operate the real robot, the actual cycle time will be longer than the simulated 
cycle time according to the model, Fine, load settings.  For details, refer to 8.4 
Specification and Restriction of Simulator. 
Also, when Speed, Accel values in the program are changed, the cycle time will reflect it. 

 
Motion command includes Move and Jump as well as Go.   
For the information on how to use these commands, refer to Online Help or SPEL+ 
Language Reference manual. 

9.  Test the collision detection 
(1) Go back to the [Robot Simulator] window. 
(2) Drag the robot joint while simultaneously pressing the <Ctrl> key to a point where it 

interferes with the box.  When the robot joint hits the box, the display turns to red.  
(3) In the [Robot Manager] window, select “P2 - (undefined)” from the [Point] list box 

on the lower right of the window.  
(4) Click the <Teach> button.  

The message to confirm the operation appears.  Click the <Yes> button.  
(5) The [New Point Information] dialog appears.  Click the <OK> button.  
(6) Click the Tool bar-<Save all files> button and save the P2 information.  
(7) Go back to the [Robot Simulator] window and drag the robot joint while 

simultaneously pressing the <Ctrl> key to the point where it does not interfere with 
the box.  

(8) Click the Tool bar-<Reset Collision  > button.  Then, the red display returns to 
normal.  

(9) Add the following function to the “Main.prg” program file.  
Function main3 

   Go P2 

Fend 

(10) Click the Tool bar-<Build> button to build the project.  
When the project build is complete, the message “Build complete, no errors” appears 
in the [Status] window.  

(11) Click the Tool bar-<Run Window> button.  
(12) Select “main2” in the [Function].  
(13) Click the <Start> button.   The message “Are you ready to start?” appears.  Click the 

<Yes> button.   The program starts and the robot moves in the 3D display.  When the 
robot joint hits the box, the display turns to red. 

 
When a collision happens, the users can stop the controller program execution with an 
error.  For details, refer to 8.3.3 Collision detection.  

 

NOTE 

 

TIP 

 

TIP 
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8.3  Description of Functions  
This section describes how to use the simulator window and its functions. 

 

8.3.1  Simulator window layout 

 

(5) 3D Display 
shows the robot orientation 
and motion from various 
points of view. 

(2) Layout Objects 
shows the list of robots 
and layout objects. 

(3) Property Grid 
shows the settings of the 
robots and layout objects. (6) Record / Playback 

Records and reproduce 
the simulation product. 

(4) 2D Layout 
Places and shows the robot 
and layout object positions. 

(1) Tool bar 

 
 

(1) Tool bar 

 
 

Button Description 

 
Simulator operating mode. 
It switches between <Simulation Mode> and <Playback Mode>. 

 Layout Box Adds a box object in the 2D layout.  

 Layout Sphere Adds a sphere object in the 2D layout. 

 Layout Cylinder Adds a cylinder object in the 2D layout. 

 Layout Plane Adds a floor / wall object in the 2D layout. 

 CAD Adds a CAD object.   
When you drag & drop this button in 2D layout, a dialog appears 
to load the CAD data from a file. 

 Hand Adds a hand object.   
When you click this button, the dialog appears to load CAD data 
from a file.   

 Reset Collision Resets the collision detection status.  
When you click this button while the robot is not interfering with 
any layout objects, the red display turns to normal.  

 
Simulator Settings 

Shows the [Simulator Settings] dialog. 
In this dialog, the 3D [Render Options] can be configured.  

 Screenshot Saves the current 3D display as an image file. 
A dialog appears to specify a file name and format before saving.  
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Button Description 

 
Create Movie 

Plays a simulation result (log file) in the Playback mode and saves 
into a movie file.  A dialog appears to specify the file and format 
to save.  

  
Elapsed Time 

Shows the program execution time as if you ran the same program 
with a real controller.  

When a program starts, the elapsed time counter counts from 0 and 
stops when the program finished.  It pauses counting when the 
program is paused and resumes when the program continues 
execution.  

 Clear Elapsed Time Resets the elapsed time.  

  Clear end  
effector path 

Clear the end effector path which the robot displays. 

 

(2) Layout Objects Pane 

 
 

The Layout Objects pane shows the robot objects and layout objects in a tree format. 
When you right-click on a layout object, the deletion menu appears.  
 
What is an Object? 
The objects in the simulator are either a “Robot Object” or a “Layout Object”:  
A “Robot Object” includes the robot itself, its hand, local coordinates, point information, 
etc.   
A “Layout Object” includes objects to be placed around the robot to simulate the robot 
peripheral environment in the 3D display.  

 
◆ Robot Object 

Robot : The robot itself.  The display data is handled by the simulator. 

Hand  : The hand is created by loading CAD data (VRML2.0, STEP, or 
IGES) from a file. 

Object to reflect a robot parameter : Local, Tool, Box, Plane 

Object to reflect robot point data : Point, Pallet 

 
◆ Layout Objects 

Simple object : Box, Sphere, Cylinder, Floor / Wall 
The display data for these objects is handled by the simulator. 
The object size can be changed as desired by editing properties. 

CAD object : These objects are created by loading CAD data (VRML2.0, STEP, 
or IGES) from a file. 
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(3) Property Grid Pane 
In the Property Grid pane, you can view and change the settings of the robot objects and 
layout objects in the Layout Object pane.   
 
◆ Robot Object Properties 
Robot 

 
 

Property Value 
Name Robot name  

You can specify any name for a robot. 

Type Robot type. 

The robot type (Scara, 6-Axis, and RS) is shown.   
This property is read-only. 

Series Robot series 

The robot series is shown.  This property is read-only. 

Model Robot model name 

The robot model is shown.  This property is read-only. 

Change Robot If you want to change the robot model, click on  button.  When you 
click on this button, a dialog appears to change the robot.  

For details, see Changing the robot model described later in this 
chapter. 

Position Robot position  

Specifies the robot's base center in the simulator World coordinates. 

Rotation Robot angle 

Check Collision Enables / disables the collision detection for layout objects.  

Enable : True (default) 
Disable : False 

Even if this is enabled, it does not detect collision between the robot 
base and layout objects.  

Check Self Collision Enables / disables the collision detection for a robot itself.  

Enable : True (default) 
Disable : False 
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Changing the robot model 
When you want to change the displayed robot model, click on the    button in the 
Change Robot property and the dialog shown below will be displayed.  If you cannot see 
the  button, increase the property grid width and click once on the [Value] column of the 
grid. 

 
Select a new robot type, series, mode and click on the <OK> button.  After the message 
“Restarting Controller”, the new robot will be displayed.  

 
When you change the displayed robot model, all the settings for the robot (Local 
coordinates, Tool coordinates, etc.) will be initialized to the default values.  

 
Type and Series  

Type Series 
Scara G series, LS series 
6-Axis C3 series, S5 series 
RS RS series 

 

Local, Tool, Box, Plane, Pallet 
If the local coordinate system of the corresponding number is not defined yet, the check 
box is grayed.  

 
Property Description 

 
Visible Displays a base / local coordinate system 

Visible : Check  
Not visible : Uncheck  (default) 

For Local 0 (Base), Visible is the default.   
   

TIP 

 

NOTE 
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Points 
Display the point display setting status in the point file.  Switch to show/non-show all 
points. 

 
Property Description 
File Name Show a point file name. 

Visible Shows / Not show all points 
Visible : Check  
Not visible : Uncheck 

If it is set to show some points, the check box shows indeterminate 
state. 

 
Point 
If the point of the corresponding number is not defined yet, the check box is grayed. 

 
Property Description 

 
Name Shows a point label 

In the Property Grid, point labels cannot be configured or edited.  

Visible Shows / Not show a point 
Visible : Check  
Not visible : Uncheck  (default) 

If you cannot see the [Visible] column, increase the property grid display width. 
  

TIP 
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Hand 
When a hand is registered with a robot, “Hand” is added in the Layout Objects tree.  

 
Property Value 

 
Name Hand name  

You can specify any name for a hand. (Default: Hand) 

Position Mounting offset from the robot end effector position. 

Rotation Hand mounting direction 

File name CAD data file name of the hand  
It cannot be changed.  

Visible Visible : True (default) 
Not visible : False 

Check Collision Detect collision : True (default) 
Not detect collision : False 
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◆ Layout Object 
Layout Box, Layout Sphere, Layout Cylinder, Layout Plane, CAD 
There are common attributes for all objects and others are for particular objects.  

 

 
 

 

 

 

Property Object Description 
Name All You can specify any name. 
Type Plane Floor : Horizontal (default ) 

Wall : Vertical 

Position All Specifies a center point in simulator World coordinates. 

Layout Cylinder: Bottom surface center  

Half size Box Specifies a length from the center.  
The box length is double this length. 

Radius Sphere 

Cylinder  

Sphere radius 

Cylinder radius 

Height Cylinder  

Plane 

Cylinder height  

Floor length / Wall height  

Width Plane Floor width / Wall width 
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Property Object Description 
Rotation All Object angle (Z-axis centering) 

File name CAD CAD data file name.   It cannot be changed.  

Color Box 

Sphere 

Cylinder 

Display color 

Click the drop-down  to change display color. 

The display color setting dialog will be displayed. 

Refer to Change layout object color for the details. 

Visible All Visible : True  (default)  
Not visible : False  

Check 
Collision 

All Detect collision : True (default) 
Not detect collision : False 
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Change layout object color 

When you want to change layout object color, click on the drop-down  in the Color 
property and the dialog shown below will be displayed.  If you cannot see the drop-down 

, increase the property grid width. 

 
Click color you want to display.  Layout object color will be changed. 
If you do not want to change color, click anywhere other than the display color setting 
window.  The window will be closed. 
If you create a custom color, right-click any color in the bottom two rows (16 colors) in 
the [Custom] tab, and the color setting dialog will be displayed. 

 
Create a custom color and click the <OK> button. 
Created color will be displayed in the display color setting window. 
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(4) 3D Display  

In the 3D display, you can check the robot 
orientation and motion from various points of 
view. 

 
 

Adding a layout object  

Drag and drop a tool button (Box, Sphere, Cylinder, 
etc.) onto the [2D layout] panel. 
When you add a layout object while a robot object is 
selected in the [Layout Objects], the added object is a 
separate object. 

 

When you add a layout object while a layout object is 
selected in the [Layout Objects], the added object will 
be in a group with the selected objects. 

 
Grouped objects move together when the parent object moves.  
RightTable/CenterTable/LeftTable of the sample virtual controller “G6 Sample” is an 
example of grouping. 

 

Editing a layout object 
[Cut], [Copy], and [Paste] commands in the [Edit] menu are available for the layout 
objects except CAD objects. 

 

Changing a hierarchy of layout objects 
To change a hierarchy of layout objects, drug and drop a layout object in the object tree. 

 

Change the robot / layout object position 

To display a guide which indicates the directions to 
move, press the <Shift> key and click on the object 
(box, etc.). 
To move the object, drag the grid corresponding to 
the axis. 
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Rotate the robot / layout object 
To rotate a layout object around the z-axis, press the <Ctrl> key and move the object (box, 
etc.). 

 

Move the robot joint  

To move a robot joint, press the <Ctrl> key and 
drag the robot joint.  The selected joint is displayed 
in blue.  
If a robot moves to a point out of the motion 
range, the joint comes back to the previous point. 

 
Change the view point  
To rotate the view point, press the mouse left button and drag the 3D display. 
To move the view point up and down, press the mouse right and left button and drag the 
3D display.  
Also, you can use the <L>, <R>, <D>, and <U> key to move the view point.  
You can reset the view point from the menu opened by right click. 

 
Zoom the layout 
To zoom the 3D layout, use the mouse wheel to scroll.  
You can change the zoom level from the menu opened by right clicking with the mouse. 

 
Check for collisions 

When a collision between a robot and layout 
object is detected, the collided robot joint and 
layout object are displayed in red. 
 
For details, refer to 8.3.3 Collision detection. 
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(5) 2D Layout 

In the [2D Layout] panel, you can add layout objects, or 
modify and check the robot objects and layout objects 
positions. 
 

 
 

Change robot and layout object position 

Drag an object (robot, box, etc.) to change its position. 
To move an object in Z direction, use the <D> and <U> 
keys. 
Drag  to change the size of an object, and drag  to 
rotate an object. 
If you are moving a box, it is shown as in the figure on 
the right: 

 
Zoom the layout 
To zoom the 3D display, use the mouse wheel to scroll.  
You can change the zoom level from the menu opened by right clicking with the mouse. 
 
Move the display area 
To move the 2D layout display area, drag the 2D layout while simultaneously pressing the 
<Shift> key. 

 

Rotate the display 
To rotate the 2D layout display area, right-click on the 2D layout and use the options - 
[Rotate Clockwise] [Rotate CounterClockwise].  
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(6) Record / Playback 
In Playback mode, you can record and produce simulation results.  
Also, you can store the simulation results in movie files.  

  
Function Description 

 RECORD When the button is red , it saves the simulation result into the 
specified log file.  Every time you execute the program, the log file is 
overwritten   with the new information.   

When the button is gray , it doesn’t save the simulation result.  
As the default, it doesn’t save the simulation result.  

 PLAY Plays a simulation result of a specified log file. 

 STOP Stops the simulation playback. 

 REWIND Puts the playback step to the starting point. 

 BACK Goes back one step.  
The number of steps back is specified in [Play Speed].  

 NEXT Goes to next step.  
The number of steps to go is specified in [Play Speed]. 

 REPEAT When this button is pressed, repeats the simulation playback. 

 Log list 
Specifies a recording file to record and play.  

 New button Create a new log file.  

 
Sampling 

Displays the log file sampling interval.  

 
Play Speed 

Specifies the playback interval with a number of steps.  

 
Play position 

Display the current playing position. 
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8.3.2  Simulator Settings  
When you click the Tool bar-<Simulator Settings  > button, the [Simulator Settings] 
dialog appears.  

 

Render options 
In the [Render options] dialog above, you can specify the 3D display method.  
The specified display method is valid while EPSON RC+ 5.0 is running.  However, when 
EPSON RC+ 5.0 is restarted, it returns to the default display settings.  

 
Function Description 
Render Wireframe Changes to the wire frame display (a three dimensional graphic 

using lines and points). 

Render Joints Displays fulcrum points of robot joints. 

Render Labels Displays names of robots and layout objects. 

Render Bounding Box Displays robots and layout objects in bounding box.  

Render End-Effector Path Displays robot end effectors path of a certain period of time. 

Render Duct Collision Area Available with G1 series and LS series manipulators.   
Shows the collision detection range of the robot ducts with the 
bounding view. 

Render End-Effector View Displays the view from robot end effectors. 

Render World Monitor Displays the simulator World coordinates. 
Render Grid Displays the simulator grid. 
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Produce the robot motion by outputting to a recording file 
(1) Confirm that the mode is “Simulation” mode on the Simulator Tool bar. 

 
(2) Click on the <New> button in the [Record / Playback] window.   

The [New Recording] dialog appears.  
(3) Here, enter “TestPlayBack” and click the <OK> button.  

Now, you can see “TestPlayBack” in the Recording list.  
(4) Click on the <RECORD> button in the [Record / Playback] window, which enables 

recording.  Now, the <RECORD> button is in red .  
(5) Start a program from the [Run] window to move the robot.  The simulation result is 

saved in the recording file while executing the program.  
(6) Change the simulator operating mode to “Playback Mode” again.  
(7) Click on the <PLAY> button and the simulation result starts to play. 

 
Produce the robot motion with saving in a movie file at once 
(1) Confirm that the mode is set to “Playback” on the Simulator Tool bar.  
(2) Click the <Create Movie> button in the Simulator Tool bar.  
(3) When the [Create Movie] dialog appears, select “TestPlayBack” from the Log list.  

 
(4) Specify the [Output File] and [AVI Compression] if necessary.  
(5) Click on the <OK> button.  

The [Create Movie] status window appears and the specified movie file is created 
with playing the log file.  

(6) The created movie file is “TestPlayBack.avi” in EPSON RC+ 5.0 project folder 
(\EpsonRC50\projects\“a project name”). 
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8.3.3  Collision detection  
In the simulation, collisions can be detected between the robots including its hand and the 
layout objects.  Here we describe the settings and details of collision detection.  

 

Basic settings for collision detection 
In the [Property Grid] of the robot, the following can be configured.  

 
Property Value 
Check Collision Enables / disables the collision detection for layout objects.  

Enable:  True (default) 

Disable:  False 

Even if this is enabled, it does not detect collision between the robot 
base and layout objects. 

Check Self Collision Enables / disables the collision detection for a robot itself.  

Enable: True (default) 

Disable: False 

 

Target of collision detection 
In the Property Grid of the layout objects, the following can be configured.  

 
Property Value 
Check Collision Enables / disables the collision detection for a robot.) 

Enable: True (default) 

Disable: False 

Even if this is enabled, it does not detect collision when the robot 
collision detection is disabled. 

 

Generate error when collision is detected 
When you open the [Setup]-[Controller]-[Simulator] and check the [Generate error when 
collision detected] checkbox, if a collision is detected during SPEL＋ program execution, 
an error occurs in the controller and the program stops.  
After checking the check box, click the <Apply> button and then click the <Close> button.  

 
 
The purpose of this function is to find where the program has a problem and not to prevent 
the collision of robots.   
It cannot guarantee that it has enough time for robots to stop when the simulator detects 
the collision.  

 

NOTE 
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Caution about the collision detection of Floor / Wall 
A collision is detected when a floor or wall is in contact with the robot.  If the robot or 
plane positions are changed so that the robot passes completely through the plane, then no 
collision is detected. 

Accuracy of collision detection 
The collision detection in the simulator cannot guarantee accuracy.  Make sure to have a 
margin when you apply the simulation result for a real robot system.  
The restrictions of the simulator are described in 8.4 Specification and Restriction of 
Simulator. 

 

8.3.4  Virtual controller 
To execute programs in the simulator, you need to create a virtual controller with defined 
robot and layout.  
Robot settings and layout settings for the 3D display are saved for each virtual controller.  
If you want to transfer the robot or layout data, you can copy and transfer the data.  

 

Create a new virtual controller 
Refer to 8.2.2 Working with a user created system. 

 

Copy the sample or configured virtual controller 
(1) Click the EPSON RC+ 5.0 Tool bar-<Connection  > button. 

The [PC to Controller Communications] dialog appears.  

 
(2) Click the <Add> button.  The [New Controller Connection] dialog appears. 
(3) Select the <Connection to new virtual controller> option button and specify a virtual 

controller from the list box.  Click the <OK> button. 
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(4) New “Virtual 2” is created.  Click the <Apply> button.  

 
(5) Close the dialog and go back to the EPSON RC+ 5.0 main window.  
(6) Connect to “Virtual 2” and display the simulator window. 

The robot setting and layout setting of 3D display has been taken over from “Virtual 
1”. 

(7) When you want to change the robot type, use the [Change Robot] in the robot object 
property. 
For details, refer to 8.3.1 Simulator window structure – (3) Property Grid.  

 

Virtual controller configuration 
Normally you don’t need to configure a virtual controller.   
The configuration is available from the [Setup]-[Controller]-[Simulator] page.  

 
[Performance] : You normally don’t need to change the setting from 8 ms (default).  
[Position Precision] : You normally don’t need to change the setting from 16 ms (default). 
The situations when you need to change these settings are described in 8.4 Specification 
and Restriction of Simulator. 

 

8.3.5  Connection with controller  
When the firmware of the RC180 controller is Ver.1.10.*.* or later, you can enable the 
simulator function with the controller connected. 

For the RC90 controllers, regardless of the firmware version, you can enable the simulator 
function with the controller connected. 
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Enable the Simulator in controller  
From the [Setup]-[Controller]-[Simulator], check the [Enable Simulator] checkbox to 
enable the simulator function.  
After checking the checkbox, click the <Apply> button and then click the <Close> button.  

 
If collision with the simulator object is detected during a Jog motion or a robot motion 
command execution when the Simulator is enabled, the Manipulator stops operation and a 
Warning occurs. 
To avoid collision with peripherals by using the Simulator, set 15 mm or greater margins 
to the simulator object. 

Function restrictions when connected with controller 
- Pallets cannot be displayed.  
- You cannot change the robot from the Simulator window.  
- You cannot select and move the robot arms in the Simulator window, except 

during the controller Dry run. 
- When the robot configured in the controller is not supported in the Simulator, a 

warning message is displayed when the Simulator window is opened, and the 
object list and the robot in 3D window are not displayed.  

- The [Record/Playback] functions are not available. 

Operator Window 
When you enable the Simulator, the <Simulator> button is added to the Operator Window.  
When you click on the <Simulator> button, the 3D display window appears.  
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8.4  Simulator Specifications and Restrictions  
This section describes the simulator specification, its restrictions, and precautionary 
statements.  

 
8.4.1  EPSON RC+ 5.0 package 

EPSON RC+ 5.0 has two packages:  
- EPSON RC+ 5.0 : Standard package for developing the robot system  
- EPSON RC+ 5.0 Trial  : Trial package for limited use (program execution on PC)  

  * It cannot connect with an RC180 robot controller.  
 Program execution 

on PC 
Connection with 

controller 
Connection with controller 

+ 3D display 
EPSON RC+ 5.0 OK OK OK  *1 
EPSON RC+ 5.0 Trial OK *2 × × 

*1 Requires the configuration to enable the simulator functions in EPSON RC+ 5.0. 
Refer to 8.3.5 Connection with RC170/180 controller for the detail information. 

*2 Continuous execution time of program is limited. 
 

8.4.2  Specifications and precautions for the 3D display 

Available robots for 3D display 
In the future, we will add more robots for 3D display.  Call your EPSON Regional Sales 
Manager for the latest information. 

 
The flexible duct is displayed roughly.  
・ Check the dimensions in the manipulator manual.  
・ The duct actually vibrates while the manipulator is moving, the simulator doesn’t 

display the vibration.  Check how the duct vibrates with your real manipulator.  
The bellow for Cleanroom or Protection model is displayed roughly 
・ Check the dimensions in the manipulator manual. 

 

Available CAD data for 3D display 
The following format is available for 3D display to show the robot hand and CAD object. 

- VRML 2.0  
Limits of reading: VRML2.0 prototype is not supported. 

- STEP (AP203/AP214) 
Limits of reading:  
If Color is configured in Face, the specified Color is displayed.  

- IGES 
 

The data file must be saved in the specified folder on the PC and not saved in EPSON 
RC+. 

   

NOTE 

 

NOTE 
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CAD data setup orientation 

Some CAD data coordinates may be different from those of the simulator. 
Adjust the coordinates to the correct position by changing [Property]-[ Rotation] after 
loading the CAD data.  
When loading CAD data as a hand, set the origin of the CAD data in the Tool0 position of 
the manipulator.  Set the coordinates to the correct position by changing [Property]-
[Position] after loading the CAD data. 

 
Number of available layout objects 
You can create as many layout objects as you want.  
However, when there are many objects to display, the display update interval becomes 
longer and the judgment of collision detection becomes rough.  Especially for CAD data, 
displaying data that is too complicated is not recommended. 

 

8.4.3  Specifications and precautions for Simulation (program 
 execution on PC) 

Overview 

The Simulator produces the robot motions virtually on your PC. 

It is designed to make the performance gap between the real system and the virtual system 
as small as possible.  However, a few differences in the virtual system are inevitable.   The 
operation time prediction and collision detection do not guarantee the precision. 

Fully understand the contents in this chapter and check if the real system operates without 
any problems before you go to full-scale operation.   

Operation time prediction  

Operation time displayed in the Simulator window is approximate time required for 
executing the program. 

Time for the motion commands such as Go, Jump reflects the Speed and Accel values in 
the program.  The operation time may vary when you operate the real robots from the 
displayed operation time according to conditions such as the Fine setting and servo delay. 

In particular, when small ranges are used with the Fine instruction, the real robots need a 
longer operation time for accurate positioning.  

The simulation cannot guarantee the precision but the margin of error in the operation time 
is within 10% when you execute motions with the standard cycle time (with the default 
Fine settings). 

 
Considered in the operation time prediction Not considered in the operation time prediction 

Robot model 
Speed settings (Speed, Speeds, etc.) 
Acceleration settings (Accel, Accels, etc.) 
Load (Weight, Inertia) 
Others (ARCH, CP) 

Fine setting 
Error within 10% from the default 
(Motions of standard cycle time)  
With larger setting than the default,  
the operation time will be shorter. 
With smaller setting than the default,  
the operation time will be shorter.  

Servo delay 
With the real robots, the operation will be longer. 
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Time for the other commands than the motion commands is a virtually executed time on 
PC; therefore the actual time varies widely depending on the PC performance. 
When measuring the motion time between two points, as simple program as possible is 
recommended.  Refer to 8.2.2 Working with a user created system - 8. Measure the robot 
operation time. 

 
Collision Detection Precision 

The Simulator Collision Detection provides an indication whether robots collide with the 
peripheral equipment or not when the program is executed.  It does not consider the error 
in trajectory due to servo delay.  Be aware that a margin is necessary for the real robot 
system. 

The Simulator judges collisions more accurately when the robot motion speed is slow.  

The judgment of collision detection during program execution is accomplished with the 
3D display update.  When your PC has high graphics performance, the collision judgment 
becomes more accurate.  

In Playback mode, the Simulator judges collisions in all steps and is useful when you need 
accurate detection.  

The Simulator cannot guarantee the precision but the margin of error in the collision 
detection is within 10 mm when you execute motions with Speed 100% on a PC of the 
recommended specifications. 

 

Motion duty and Overload error 

In the Simulator, you cannot detect the overload error.  Even when the motion duty is too 
high and the robot should have the overload error and stop, it keeps moving.   

Duty 50 % - As a measure of possible duty, the robot can really keep moving at duty 50% 
with the maximum acceleration/deceleration speed and without the overload error.  
However, it depends on the robot model type, load, points to go to, and 
acceleration/deceleration speed setting, etc.  

 

Time progress difference by PC condition 

On a PC that meets the system condition, progress of the time in the Simulator and the real 
time (as you see on the watch) are almost the same (few percentages difference). 

If you are running other applications such as Windows Media Player simultaneously, the 
time progress in the Simulator can widely vary from the real time.  In this case, use the 
Simulator function while other applications are not running. 

Also, on some PC models, the time progress in the Simulator may widely vary from the 
real time.  In this case, set the [Performance] at 16 ms and the [Position Precision] at 20 
ms, which may close the gap of the time progress.  

 

Time confirmation program 
 (If the two printed times are within 27 to 33 seconds, there is no problem.) 

Function main 

    Print Time$ 

    Wait 30 

    Print Time$ 

Fend 
 
  

 

TIP 
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Execution on PC below the minimum of specification 

You can install the EPSON RC+ and use the Simulator functions on a PC that doesn’t 
meet the minimum of the specification.   

However, it doesn’t guarantee the correct motions because the following may happen:  

- Operation time prediction is not accurate 
- Collision Detection has a large margin of error  
- 3D display skips updates  

 
8.4.4  Specification and precaution of EPSON RC+  

Restriction on the controller settings 

When you connect with a virtual controller, the following items are grayed and become 
unavailable to change.  

 Setup: Controller: Configuration Page: IP Address, etc.  -
 Setup: Controller: Preference Page: Dry run, etc. -

 

Backup and restore of the controller setting 

The setting data that you backup in the virtual controller cannot be restored in a controller.  
Also, the setting data that you backup in a controller cannot be restored in a virtual 
controller. 

 
8.4.5  Restriction on SPEL+ command execution 

(1) I/O operation and commands (On, Off, SW, Ctr, etc.) 
All I/O including the option boards are available in a virtual controller.  Operating I/O 
data is stored in the PC memory (virtual I/O mode).  The I/O input status can be 
changed from the EPSON RC+ I/O Monitor window.  Also, the I/O input status can 
be changed using the SetSw or SetIn statements in a SPEL+ program.  
Even if you specify an asynchronous On/Off command, the I/O status cannot be 
changed after the specified time and the Ctr function always returns 0. 

 
(2) Pallet definition (Pallet statement) 

In the Simulator, you can use the Pallet statement as in the controller.  
However, once you define a pallet in a project, you cannot clear the pallet definition 
unless you use the same project.  
Even if you switch to another project, the pallet definition will be redefined when you 
come back to the original project.  

 

 Controller Simulator 
(Virtual controller) 

Timing of a pallet definition When executing a Pallet  
statement in a program, etc. 

When executing a Pallet 
statement in a program, etc. 

Timing of a pallet reset 
- When building a project  
- When turning OFF the controller 
- When switching to other project 

None 

   

 

NOTE 
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(3) Ethernet / RS-232C communication command  
(Print #, Input #, OpenCom, OpenNet, etc.) 

All ports including the option RS-232C board are available in a virtual controller.  
However, an Ethernet port requires configuration of the IP address and TCP/IP port.  
Ethernet / RS-232C communication commands do not perform actual communication. 

Output data from Print #, etc. is saved in the communication output file.  In the input 
by Input#, etc, the return value is 0 (numeric data) or blank (string).   However, if you 
create a communication response file, the return value depends on the file content. 

 
Communication output file  

When calling OpenCom or OpenNet command, a communication output file is 
created in the \EpsonRC\Virtual\Mounted Volume\Project folder on the PC.  

DummySend***.dat : Communication output file (*** is the port number)  

When a communication output file already exists, the previous output data is deleted.  
The file is deleted when you switch the project; save the file in a proper folder if you 
need.  

 
When executing the following program, 

OpenCom #1 

Print #1, 123 

Print #1, "TEST DATA" 

CloseCom #1 

the DummySend001.dat file will contain...  
123 
TEST DATA 

 

Communication response file  

Copy the communication response file to the \EpsonRC\Virtual\Mounted 
Volume\Project folder in before running a program.  The file is deleted when you 
change the project; save the file in another folder if you need to keep it.  

When calling OpenCom or OpenNet command, the communication response file is 
loaded. 

DummyRead***.dat : Communication response file (*** is a port number)  
 

When the following DummyRead001.dat file is used,  
321 
Test Data 

and the following program is executed,  
Integer i 

String s$ 

OpenCom #1 

Input #1, i 

Input #1, s$ 

CloseCom #1 

Print i 

Print s$ 

the return values are i = 321 (numeric data), and s$ = "Test Data" (string). 
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(4) Vision command (VRun, VGet, etc.) 
For Vision-related commands, the communication with Smart Camera (SC300 / 
SC1200) is not performed and the command quickly executes.  
If you execute VGet, the return value is 0 (numeric data) or blank (string). 

 
(5) Other restrictions 

For the Wait command, the following syntax is not supported:  
Wait InsideBox() 
Wait InsidePlane() 

For the  Time and Date commands, the time can be displayed, but the time setting is 
not available. 
For the Box command, it always executes the default operation (I/O output On when 
the Box approaches) even if you specify the remote output logic.  

 

8.4.6  Specification and precaution of EPSON RC+ 5.0 Trial 

Version upgrade from EPSON RC+ 5.0 Trial to EPSON RC+ 5.0 

Follow the procedures in Appendix A: Software Installation to upgrade to EPSON RC+ 5.0.  
The EPSON RC+ 5.0 Trial version doesn’t need to be uninstalled. 

 
You can continue to use the projects and virtual controllers (layout) that you used in the 
EPSON RC+ 5.0 Trial in the EPSON RC+ 5.0 Standard version. 

 

Program execution time in EPSON RC+ Trial version 

In the Trial version, programs will execute continuously for up to one hour.  

If continuous execution is over one hour, the following warning appears.  

 
You can execute the program again after this warning is displayed, and the continuous 
execution timer will be reset.  

 

 

NOTE 
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9.  Robot Configuration 
This chapter contains information for configuring robots installed on the controller. 

Robots are configured from the Robots folder on the [Setup]-[Controller] dialog tree.  
 

9.1  Setting the Robot Model 
1. From the [Setup] menu, select [Controller]. 

2. Select [Robot]-[Model] in the tree on the left side to open the [Robot Model] page. 

 
3. Select the model for your robot from the [Model] dropdown list.  Only robot models 

that can be used with the amplifiers currently in the controller are listed.  When using 
Dry Run, all robot models are shown in the list. 

4. Click the <Apply> button to save settings. 

5. Select [Root]-[Configuration] in the tree to open the [Robot Configuration] page. 

 
6. Type in a name for the new robot and enter the serial number from the robot's 

nameplate.  Any serial number can be used, but it is recommended that you use the 
number that is stamped on the robot. 

7. Click <Apply> to save settings. 
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9.2  Calibrating the Robot 
EPSON RC+ 5.0 provides a calibration wizard for calculating the robot calibration 
parameters Hofs and Calpls. 

To calibrate the robot: 

1. From the [Setup] menu, select [Controller]. 

2. Select [Robot]-[Calibration] in the tree on the left side to open the [Robot Calibration] 
page. 

 
3. Select the joint to calibrate. 

4. Click the <Calibrate> button to start the calibration wizard.  The instructions for each 
step are shown on the right side of the dialog. 

 
5. Click the <Jog> button to jog the robot to the approximate zero pulse position, as 

shown in the picture. 

6. Click the <Next> button to view the next step. 
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7. For SCARA robots, reset the encoder for the selected joint as described on the dialog.  
For 6-axis robots, the encoder for the selected joint is automatically reset. 

8. Click the <Next> button to view the next step.  The controller is restarted before step 3 
is displayed. 

 
9. Select a point in the current project.  By default, a Jump command will be inserted into 

the [Motion command to move to reference point] text box.  You can change this 
command as necessary to move to the known reference position. 

10. Click the <Execute> button to execute the motion command to move to the reference 
point.  Note that the robot will only be close to the reference point, which will be 
corrected in the next step. 

11. Click the <Next> button to view the next step. 

 
12. Click the <Jog> button to carefully jog the robot to the exact reference point position. 

13. Click the <Next> button to view the next step. 

 
14. Click the <Finish> button to save the calibration settings for the selected joint. 
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9.3  Changing Robot System Parameters 
The following system parameters for the robot can be changed from EPSON RC+ 5.0: 

 Enable/Disable Joints -
You can disable one or more joints from [Setup]-[Controller]-[Robot]-[Configuration].  
On robots with ball screw Z axis, you must disable both joints 3 and 4 together. 

 Hofs -
Hofs are the joint home offsets.  You can view and edit the values from [Setup]-
[Controller]-[Robot]-[Hofs].  However, it is recommended that you use the Robot 
Calibration wizard to set these values.  These values are unique for each robot and are 
supplied from the factory.  Hofs are especially important for SCARA robots because the 
values determine that both lefty and righty hand orientation will position the robot at the 
same point. 

 CalPls -
CalPls values are joint calibration offsets.  You can view and edit the values from 
[Setup]-[Controller]-[Robot]-[Calpls].  However, it is recommended that you use the 
Robot Calibration wizard to set these values.  These values are unique for each robot and 
are supplied from the factory.  CalPls values are used to calibrate joint position after 
replacing a motor or encoder. 

These are one-time settings for each robot.  Additional robot parameters can be set from 
the Robot Manager. 

To change robot parameters, follow these steps 

1. Select [Controller] from the [Setup] menu. 

2. Under the [Robot] folder in the tree on the left, select [Calibration]-[Hofs] or [CalPls]. 

3. Perform a calibration or change values for Hofs or CalPls. 

4. Click <Apply> to make the changes permanent. 
 

9.3.1  Saving robot calibration data 
You can save and load individual robot calibration files.  This is useful for moving a robot 
from one controller to another.  When you save calibration data, a file is created with an 
MPD file extension.  This file contains Hofs and CalPls values. 

To save robot calibration data 

1. Select [Controller] from the [Setup] menu. 

2. Under the [Robot] folder in the tree on the left, select [Calibration]. 

3. Ensure that the robot serial number is correct.  The serial number will be used to create 
the default file name.  It is recommended that the serial number be used. 

4. Click the <Save Cal> button.  Browse to a destination directory and click Save.   
 

9.3.2  Loading robot calibration data 
To load robot calibration data 

1. Select [Controller] from the [Setup] menu. 

2. Under the [Robot] folder in the tree on the left, select [Calibration]. 

3. Click the <Load Cal> button.   

4. Browse to the desired MPD file and click <Open>.  
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10.  Inputs and Outputs 
 

10.1  Overview 
The RC90/RC180 controller I/O has the following types of I/O: 

Standard I/O This digital I/O comes standard with the controller. 

Expansion I/O This is optional digital I/O that can be added to the controller to 
expand standard I/O.   
For the RC180 controllers, up to four boards can be added, each with 
32 inputs and 32 outputs. 
For the RC90 controllers, up to two boards can be added, each with 24 
inputs and 16 outputs. 

Fieldbus I/O An optional board can be added that supports fieldbus slave mode for 
DeviceNet, EtherNetI/P, PROFIBUS-DP, PROFINET, or CC-Link. 
EtherNet/IP and PROFINET are not supported by the RC90 controller. 

Memory I/O This is built-in memory bits that can be used for inter-task 
communications. 

For Standard, Expansion, and Fieldbus I/O, there are input bits numbered starting with 0, 
and output bits numbered starting with 0.  For example, there is an input bit 3 and a 
separate output bit 3. 

For memory I/O, each memory bit is both an input and an output. 

For specifications and instructions on wiring I/O, refer to the Robot Controller manual. 
 

10.2  I/O Commands 
The SPEL+ language has several commands for inputs and outputs listed below.  For 
details on each command, see the SPEL+ Language Reference. 
Input Commands 

In Reads one byte of input bits. 

InBCD Reads one byte of input bits in Binary Coded Decimal format. 

InW Reads one word of input bits. 

Oport Reads one output bit. 

Sw Reads one input bit. 
 
Output Commands 

Off Turns off one output bit with optional time. 

On Turns on one output bit with optional time. 

OpBCD Sets one byte of output bits in Binary Coded Decimal format. 

Out Sets / reads one byte of output bits. 

OutW Sets / reads one word of output bits. 
 
Memory I/O Commands 

MemOff Turns off one memory bit. 

MemOn Turns on one memory bit. 

MemOut Sets / reads one byte of memory bits. 

MemSw Reads one bit of memory. 
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10.3  I/O Configuration 
To view the current I/O configuration, select [Setup]-[Controller]-[Inputs / Outputs].  This 
will show you what I/O is installed on the controller. 

 
Standard and expansion I/O is automatically configured by the controller.  To add 
expansion I/O boards, refer to the Robot Controller manual. 

The optional fieldbus I/O board is automatically detected.  You must configure the device 
ID using a DIP switch on the controller.  For details, refer to the Robot Controller manual. 

 
10.4  Monitoring I/O 

To monitor I/O, use the I/O Monitor tool by selecting [Tools]-[I/O Monitor].  From the I/O 
monitor, you can view inputs and outputs or memory I/O in bit, byte, and word formats.  
You can also configure up to three custom I/O views. 

For details on how to use the I/O Monitor tool, refer to 5.11.4 [I/O Monitor] Command 
(Tools Menu). 

 
10.5  Virtual I/O 

The Controller supports virtual I/O.  When enabled, virtual I/O allows you to simulate 
your hardwired I/O.  You can turn on / off any input bit or output bit.  Normally this is 
used when the controller is in Dry Run mode with no robot or I/O connected. 
Virtual I/O Commands 

SetIn Set the value of an 8 bit input port. 

SetInW Set the value of a 16 bit input port. 

SetSw Set the value of one input bit. 
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11.  Remote Control 
 

11.1  Overview 
By using Input/Output, Ethernet (TCP/IP), and RS-232C, the controller can control 
manipulators from an external device.  The external device can execute several commands, 
including Motor On/Off, Start, Pause, Continue, and Stop. 

For details on extended function of the remote I/O, refer to EPSON RC+ 5.0 Remote 
Control Reference manual. 

For use of Ethernet, refer to the section 11.10 Remote Ethernet.  

For use of RS-232C, refer to the section 11.11 Remote RS232. 

This section to 11.9 Remote Input Handshake timing describes the Remote control using 
Input/Output. 

 

There are two steps required for remote control: 

1. Configure Remote Control inputs and outputs using the [Remote Control] tab on the 
[Setup]-[Controller]-[Remote Control] page. 
Inputs and outputs from 0 to 7 are initially assigned to remote functions.  Change the 
setting if needed. 

2. Set the control device to remote on the [Setup]-[Controller]-[Configuration] page. 
To enable external remote inputs, assign the remote functions and also set the control 
device to remote.  When control device setting is remote, the controller is only 
controllable from the remote device. 

Remote control function can be used in the following systems. 

Example: Control the robot from a PLC 
Use remote control to control the robot (controller) from a PLC.  
When using a PLC, you will need to be familiar with the handshake required to use 
remote inputs.  See details below. 

Example: Control the robot using a push button box with buttons and lights 
The lights are connected to remote control outputs on the controller to indicate status, 
such as AutoMode, MotorOn, Error, etc.  The buttons are connected to remote inputs to 
control motor power and start programs. 

For details of each I/O connection, refer to the following: 

Robot Controller - Setup & Operation: I/O Connector 
I/O Remote Set Up 
Expansion I/O Board 
Fieldbus I/O Board 
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11.2  Remote Control Input Output Configuration 
This is the procedure to assign the remote functions to the I/O. 

1. Select [Controller] from the [Setup] menu and select the [Remote Control Inputs] or 
[Remote Control Outputs] page. 

2. For each input or output you want to use for remote control, click on the Input # or 
Output # cell for the desired signal, then click the dropdown arrow and select a bit 
number in the list. 

3. Click <OK> to save the new settings. 

 
For details of dialog setting, refer to 5.12.2 [Controller] Command (Setup Menu). 
 

11.3  Control Device Configuration 
This is the procedure to set the control device to “Remote I/O”. 

1. Set the controller control device to Remote.  Select [Controller] from the [Run] menu, 
click on [Configuration] in the tree on the left, then select “Remote I/O” from the 
[Control Device] dropdown list.  

2. Click <Apply> to save the new setting and the click <Close>. 

 
For details of setting, refer to 5.12.2 [Controller] Command (Setup Menu). 
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11.4  Auto Mode with Remote Control 
To run in auto cycle with remote control 

1. The host device (e.g. PLC) should wait for the AutoMode or Ready remote output to 
turn on before issuing remote commands. 

2. Now the remote input commands will be accepted. 

To monitor remote operation from the EPSON RC+ 5.0 Operator Window 

1.  Set the EPSON RC+ 5.0 Start Up Mode to “Auto”.  For details, refer to 4.3.3 Start 
Mode. 

2. The PC should also be configured to auto log into Windows and start EPSON RC+ 5.0 
during Windows start.  Refer to 4.3.7 Auto Start. 

 
11.5  Teach Mode with Remote Control 

When using Teach Mode with remote control, when Teach mode is ON, no remote input 
commands can be used.  Remote status outputs will still operate. 

 
WARNING 

■ Remote status outputs (such as MotorOn, Home, etc.) will operate when Teach 
Mode is ON, even when the enable switch (dead man) is disengaged.  
Therefore, DO NOT use remote status outputs to drive any devices that cause 
motion or any other safety hazard. 

You can monitor teach mode status using the TeachMode remote output. 
 

11.6  Debugging Remote Control 
You can debug programs using Remote Control from the EPSON RC+ 5.0 development 
environment. 

To run programs by remote control for debugging: 

1. Create a program (in the same procedure as usual). 

2. Open the [Run] window and click <Enable Remote I/O>. 

3. Now the remote commands will be accepted. 

You can set breakpoints and print messages to the [Run] window. 

If you cannot wire the I/O, use virtual I/O mode for debugging.  Remote function is also 
available when virtual I/O is enabled. 

   
 

NOTE 
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11.7  Remote Inputs 
Remote inputs are used to control the Manipulators and start programs.  Certain conditions 
must be met before inputs are enabled, as shown in the table below. 

To accept external remote inputs, assign the remote function and set remote to the control 
device.  When external remote input is available, “AutoMode output” turns ON. 

Except “SelProg”, the signals execute each function when the signal starts in input 
acceptance condition.  The function executes automatically.  Therefore, no special 
programming is needed. 

When an error occurs, you must execute a “Reset” to clear the error condition before any 
other remote input commands can be executed.  Use the “Error output” and “Reset input” 
to monitor the error status and clear error conditions from the remote device. 

Name Initial Description Input Acceptance 
Condition (*1) 

Start 0 

Executes function selected at SelProg. (*2) Ready output ON 
Error output OFF 
EStopOn output OFF 
SafeguardOn output OFF 
Pause input OFF 
Stop input OFF 

SelProg1 
SelProg2 
SelProg4 

1 
2 
3 

Specifies the executing Main function 
number. (*2) 

 

Stop 4 Stops all tasks and commands.  

Pause 5 Pauses all tasks. (*3) Running output ON 

Continue 6 
Continues the paused task. Paused output ON 

Pause input OFF 
Stop input OFF 

Reset 7 Resets emergency stop and error. (*4) Ready output ON 

SetMotorsOn Not Set 

Turns ON robot motors. (*5) Ready output ON 
EStopOn output OFF 
SafeguardOn output OFF 
SetMotorsOff input OFF 

SetMotorsOff Not Set Turns OFF robot motors. Ready output ON 

Home Not Set 

Moves the Robot Arm to the home position 
defined by the user. 

Ready output ON 
Error output OFF 
EStopOn output OFF 
SafeguardOn output OFF 
MotorsOn output ON 
Pause input OFF 
Stop input OFF 

ForcePowerLow 
(*6) 

Not Set 

Operates as the forced low power function. 
The robot is operated in the low power mode. 
Power High control from the command is not 
accepted. 
Executes the following according to the 
controller preferences. 
Stops or temporarily stops all the tasks and 
commands. (*7) 

Any time  
This input is acceptable 
even AutoMode output is 
OFF.  

  

 

NOTE 
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Name Initial Description Input Acceptance Condition (*1) 

ALIVE Not Set 

Input signal for alive monitoring of the 
controller.  Same signal as the input 
will be output to ALIVE output.  The 
master equipment can perform alive 
monitoring of the controller by 
switching the input periodically and 
checking the output signal. 

 

(*1) “AutoMode output” ON is omitted from the table.  This is an input acceptance condition for all functions.  

(*2) “Start input” executes Function specified by the “SelPlog1, 2, 4, and 3” bits. 

Function SelProg1 SelProg2 SelProg4 
Main 0 0 0 
Main1 1 0 0 
Main2 0 1 0 
Main3 1 1 0 
Main4 0 0 1 
Main5 1 0 1 
Main6 0 1 1 
Main7 1 1 1 

0=OFF, 1=ON 

(*3) “NoPause task” and “NoEmgAbort task” do not pause. 
For details, refer to EPSON RC+ 5.0 Online Help or Pause in SPEL+ Language Reference.  

(*4) Turns OFF the I/O output and initializes the robot parameter. 
For details, refer to EPSON RC+ 5.0 Online Help or Reset in SPEL+ Language Reference.  

(*5) Initializes the robot parameter. 
For details, refer to EPSON RC+ 5.0 Online Help or Motor in SPEL+ Language Reference.  

(*6) This is for the experienced.  Make sure that you fully understand the input specification before using.  
When the input changes from ON to OFF, all tasks and commands will stop. 
It is supported by EPSON RC+ 5.0 Ver.5.4 and Firmware Ver. 1.10.*.*. 

(*7) Operation of all tasks and commands, power mode of the robot, and PowerHigh command by the setting 
of the controller preferences. 

Preferences (1): “Motor power low when ForcePowerLow signal OFF” 
Preferences (2): “ForcePowerLow signal change pauses all tasks” 

For details of the controller preferences, refer to [Setup]-[Controller]-[Preferences] in  
5.12.2 [Controller] Command (Setup Menu). 

Preferences (1) Preferences (2) ForcePowerLow  All tasks and 
commands Power mode PowerHigh 

0 0 1→0 Stop Low only Accept 
0 0 0→1 Stop Low only Not accept 
0 1 1→0 Continue High/Low Accept 
0 1 0→1 Temp. stop Low only Not accept 
1 0 1→0 Stop Low only Not accept 
1 0 0→1 Stop Low only Accept 
1 1 1→0 Temp. stop Low only Not accept 
1 1 0→1 Continue High/Low Accept 
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11.8  Remote Outputs 

Remote outputs provide status for the Manipulator and Controller. 

Remote outputs provide the assigned function using with any control device.  The outputs 
execute automatically.  Therefore, no special programming is needed.  

Name Initial Description 

Ready 0 Turns ON when the controller startup completes and no 
task is running. 

Running 1 Turns ON when task is running. 
However, turns OFF when “Paused output” is OFF. 

Paused 2 Turns ON when pause task exists. 

Error 3 Turns ON when an error occurs. 
Use “Reset input” to recover from the error. 

EStopOn 4 Turns ON at Emergency Stop. 

SafeguardOn 5 Turns ON when the safeguard is open. 

SError 6 
Turns ON when critical error occurs. 
When a critical error occurs, “Reset input” does not 
function.  Reboot the controller to recover. 

Warnig 7 

Turns ON when warning occurs. 
The task runs as normal with the warning.  However, be 
sure to eliminate the cause of the warning as soon as 
possible. 

MotorsOn Not set Turns ON when the motor is ON. 

AtHome Not set Turns ON when the robot is in the home position. 

CurrProg1 
CurrProg2 
CurrProg4 

Not set 
Indicates the running or the last main function number 
 (*1) 

AutoMode Not set Turns ON in remote input acceptable status. (*2) 

TeachMode Not set Turns ON in TEACH mode. 

ErrorCode1 
. 
. 
. 

ErrorCode8192 

Not set 

Indicates the error number. 

InsideBox1  (*3) 
. 
. 
. 

InsideBox15 

Not set 

Turns ON when the robot is in the approach check area. 
For details, refer to EPSON RC+ 5.0 Online Help or Box 
in SPEL+ Language Reference. 

InsidePlane1(*3) 
. 
. 
. 

InsidePlane15 

Not set 

Turns ON when the robot is in the approach check plane. 
For details, refer to EPSON RC+ 5.0 Online Help or 
Plane in SPEL+ Language Reference. 

Power High (*4) Not set Turns ON when the power status is High. 

ALIVE Not set 

Output signal for alive monitoring of the controller.  The 
signal input by ALIVE input will be output.  The master 
equipment can perform alive monitoring of the controller 
by switching the input periodically and checking the 
output signal. 

Alarm Not set Turns ON when the alarms is occurring.  (*5) 
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(*1) Outputs the current or the last function number of CurrProg1, CurrProg2, or CurrProg4. 

Function CurrProg1 CurrProg2 CurrProg4 
Main 0 0 0 
Main1 1 0 0 
Main2 0 1 0 
Main3 1 1 0 
Main4 0 0 1 
Main5 1 0 1 
Main6 0 1 1 
Main7 1 1 1 

0=OFF, 1=ON 

(*2) Remote function is available in the followings conditions. 

- The setting is Auto mode and the control device is remote. 

- The setting is Program mode and Remote I/O is enabled. 

(*3) When the Controller firmware version is Ver.1.4.*.* or before, the remote outputs do not provide 
InsideBox1 to 15 and InsidePlane1 to 15. 

(*4) It is supported by EPSON RC+ 5.0 Ver.5.4 and Firmware Ver. 1.10.*.*. 

(*5) The signal turns on when any of the parts consumption alarms occurs. 
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11.9  Remote Input Handshake Timing 
The following charts indicate the timing sequences for the primary operations of the 
Controller. 

The indicated time lapses (time durations) should be referred to only as reference values 
since the actual timing values vary depending on the number of tasks running, as well as 
CPU speed of the Controller.  Check carefully and refer to the following charts for the 
timing interrelation when you enter an input signal. 

During system design, make sure that you actuate only one remote input operation at a 
time, otherwise an error will occur. 

The pulse width of an input signal must be 25 or more milliseconds to be detected. 

[Unit: msec] 

Timing Diagram for Operation Execution Sequence 
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Timing Diagram for Program Execution Sequence 
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* The duration varies depending on the Quick Pause (QP) setting and the program’s 

operating status at the time of Pause input 
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Timing Diagram for Safety Door Input Sequence 
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Timing Diagram for Emergency Stop Sequence 
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If an error occurs, the Error output will turn on.  To clear the error, you must turn on the 
Reset input.  No other inputs will be accepted when there is an error condition.   
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11.10  Remote Ethernet 
Remote Ethernet makes it possible to control the robot and controller from external 
equipment by sending the remote commands through Ethernet (TCP/IP).  

To set the remote Ethernet functions valid, follow the procedures below to configure the 
parameter.  

(1) Select [Controller] from the [Setup] menu and select the [Remote Ethernet] page. 

(2) Configure the necessary items for the remote Ethernet control. 

(3) Click <Apply> to save the new setting and click <Close>.  

 
For the details of the dialog setting, refer to the section 5.12.2 [Controller] (Setup menu) – 
[Setup]-[Controller]-[Remote]. 
 
Following setting for the control device is not necessary when you select “Use only for 
monitoring”, and only acquire the value using the Remote Ethernet control.  
 

Set the control device to “Remote Ethernet” by the following procedure.  

(1) Select [Controller] from the [Setup] menu and select [Controller Configuration] page. 
Select “Remote Ethernet” in the [Controller device] box. 

(2) Click <Apply> button to save the new settings, click <Close>.  

 
For the details of the dialog setting, refer to the section 5.12.2 [Controller] (Setup menu) – 
[Setup]-[Controller]-[Setup].   
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Set the remote control available by the following procedure.  

(1) Connect from client equipment to the specified port in the Remote Ethernet of the 
Controller. 

(2) Specify the password set in the Remote Ethernet to the parameter and send the Login 
command.  

(3) Client equipment has to wait until Auto (GetStatus command response) is ON, before 
execution of remote command.  

(4) Now remote command will be accepted.  
Each command executes the function the input acceptance condition. 

 

Program debug from EPSON RC+ 5.0 development environment is capable as follows.  

(1) Build a program as usual.  

(2) Open the Run window and click the <Ethernet Enable> button.  

 When you only acquire the value using the Remote Ethernet control, the <Ethernet 
Enable> button is not displayed.  Click the <Start> button of the device specified as 
the control device. 

(3) Now remote command will be accepted.  

Brakepoint setting and output to the Run window is available.  

 
If not Login within 5 minutes from external equipment, the connection will be cut down 
automatically.  After Login, if no command is send within the timeout duration of the 
remote Ethernet, connection will be cut down.  In this case, establish the connection again.  

If error occurs execute the Reset command to clear the error condition before executing 
the operation command.  To clear the error condition from external equipment by 
monitoring, use the “GetStatus” and “Reset” command. 

 

 
WARNING 

■ If you set “0” in the [Timeout] box, time out duration is infinite.  In this case, the 
task continues to execute even without the communication from client.  This 
means the robot may keep moving and cause unexpected damage.  Ensure the 
ways other than the communication to stop the task. 

 

 

NOTE 
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Remote command  

Format: $ remote command {, parameter....} terminator 

Remote 
command Parameter Contents Input acceptance 

condition (*1) 

Login password 

Start the Controller Remote Ethernet function 
Authentication by password 
Execute Login correctly, commands execution is enabled 
until Logout 

Available any 
time (*10) 

Logout  

Exit Controller Remote Ethernet function 
After Logout, execute the Login command to start remote 

Ethernet function.  
Logout during task execution causes an error.  

Available any 
time (*10) 

Start Function 
No.  

Execute the function of specified number (*2) Auto ON 
Ready ON 
Error OFF 
EStop OFF 
Safeguard ON 

Stop  Stop all tasks and commands  Auto ON 

Pause  Pause all tasks (*3) Auto ON 
Running ON 

Continue  Continue paused tasks  Auto ON 
Paused ON 

Reset  Clear emergency stop and error (*4) Auto ON 
Ready ON 

SetMotorsOn  

Turn ON the robot motor (*5) Auto ON 
Ready ON 
EStop OFF 
Safeguard OFF 

SetMotorsOff  Turn OFF the robot motor Auto ON 
Ready ON 

Home  

Move the arm to home position defined by user Auto ON 
Ready ON 
Error OFF 
EStop OFF 
Safeguard OFF 

GetIO I/O bit No.  Acquire the specified I/O bit Available any 
time (*10) 

SetIO I/O bit No. 
& value 

Set the I/O specified bit  
1: Turn ON the bit 
0: Turn OFF the bit 

Ready ON 

GetIOByte 
I/O port 
 No. 

Acquire the specified I/O port (8 bit)  (*8) Available any 
time (*10) 

SetIOByte 
I/O port 
No. & value 

Set the I/O specified port (8 bit)  (*8) Ready ON 

GetIOWord 
I/O word 
port No. 

Acquire the specified I/O word port (16 bit)  (*8) Available any 
time (*10) 

SetIOWord 
I/O word 
port No. & 
value  

Set the I/O specified word port (8 bit)  (*8) Auto ON 
Ready ON 
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Remote 
command Parameter Contents Input acceptance 

condition (*1) 

GetMemIO 
Memory 
I/O bit No. 

Acquire the specified memory I/O bit  (*8) Available any 
time (*10) 

SetMemIO 
Memory 
I/O bit No. 
& value 

Set the specified memory I/O bit  (*8) 
1: Turn ON the bit 
0: Turn OFF the bit 

Auto ON 
Ready ON 

GetMemIOByte 
Memory 
I/O port No. 

Acquire the specified memory I/O port  (*8) Available any 
time (*10) 

SetMemIOByte 
Memory 
I/O port No. 
& value 

Set the specified memory I/O port (8 bit)  (*8) 
 

Auto ON 
Ready ON 

GetMemIOWord 
Memory 
I/O word 
port No. 

Acquire the specified memory I/O word port (16 bit)  (*8) Available any 
time (*10) 

SetMemIOWord 

Memory 
I/O word 
port No. & 
value 

Set the specified memory I/O word port (16 bit)  (*8) Auto ON 
Ready ON 

GetVariable 

Parameter 
name 
{, type} 

Acquire the value of backup (Global Preserve) parameter 
 (*6) 

Available any 
time (*10) 

[Parameter 
name] 
(Array 
element), 
[Parameter 
name type], 
[Number to 
acquire] 

Acquire the value of backup (Global Preserve)  
array parameter (*7) 

 

SetVariable 

Parameter 
name & 
Value 
{, type} 

Set the value in the backup (Global Preserve) parameter
 (*6) 

Auto ON 
Ready ON 

GetStatus  Acquire the Controller state Available any 
time (*10) 

Execute 
Command 
string 

Execute the command (*8) (*9) Auto ON 
Ready ON 
Error OFF 
EStop OFF 
Safeguard OFF  

Abort  Abort the command execution  (*8) Auto ON 
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(*1) The Controller state bit from GetStatus. 

(*2) Execute the function specified in the Main[Function No.].  

Function Name Function No. 
Main 0 
Main1 1 
Main2 2 
Main3 3 
Main4 4 
Main5 5 
Main6 6 
Main7 7 

(*3) Pause command is not available for “NoPause task” and “NoEmgAbort task”.  
For the details, refer to the help or the section “Pause” in the EPSON RC+5.0 Language reference 
manual.  

(*4) I/O output will be turned OFF and the robot parameter will be initialized. 
For the details, refer to the help or the section “Reset” in the EPSON RC+5.0 Language reference manual.  

(*5) The robot parameter will be initialized.  
For the details, refer to the help or the section “Motor” in the EPSON RC+5.0 Language reference manual.  

(*6) Parameter type means {Boolean | Byte | Double | Integer | Long | Real | String}.  
Type specified: for the backup parameters when the parameter name and type are same.  
Type not specified: for the backup parameters when the parameter names are same.  

(*7) Acquiring the value of array parameter is supported in the firmware Ver.1.10.*.* or later.  
For the array element, specify an element you acquire as the following: 
You need to specify an element if when acquiring from the head of the array.  

1D array Parameter name (0) Acquire from the head. 
Parameter name  
(Element number) 

Acquire from the specified element number. 

2D array Parameter name (0,0) Acquire from the head. 
Parameter name  
(Element number 1, 2) 

Acquire from the specified element number. 

3D array Parameter name (0,0,0) Acquire from the head. 
Parameter name  
(Element number 1, 2, 3) 

Acquire from the specified element number. 

 You cannot omit the parameter type and number to acquire.  
You cannot specify a string for the parameter type. 
Available number to acquire is up to 100.  If you specify a number over the number of array elements, 
you have an error.  
e.g.) "$GetVariable,gby2(3,0),Byte,3" 
It acquires values of gby2(3,0), gby2(3,1), gby2(3,2) of Byte type 2D array parameter gby2. 

(*8) Following functions are supported in the firmware 1.13.*.* or later. 
- Acquiring and setting I/O port, 
- Acquiring and setting I/O word port 
- Acquiring and setting memory I/O 
- Acquiring and setting memory I/O port, 
- Acquiring and setting memory I/O word port 
- Execution and abortion of command 
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(*9)  Specify the command and parameters in the double quotation marks. 

Following commands are available while Execute is running. 

Commands available while Execute is running  

Remote Command 
Abort 
GetStatus 
SetIO 
SetIOByte 
SetIOWord 
SetMemIO 
SetMemIOByte 
SetMemIOWord 

When the commands specified in (SetIO, SetIOByte, SetIOWord, SetMemIO, SetMemIOByte, 
SetMemIOWrod) are the same and executed at the same time, the command executed later will result in 
error.  Make sure to check the execution result by using GetStatus after the execution of Execute 
command and output command which the Execute command is being executed. 

(*10) “Available anytime” applies only when the following conditions are met. 

When “Remote Ethernet” is set as the control device, 

or 

“Remote Ethernet” is not set as the control device, but set to be used for monitoring. 

Commands available for monitoring  

When the Remote Ethernet control is not set as the control device but set to be used for 
monitoring, following commands are only available to be executed. 

Remote command 
Login 
Logout 
GetIO 
GetIOByte 
GetIOWord 
GetMemIO 
GetMemIOByte 
GetMemIOWord 
GetVariable 
GetStatus 
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Response 

When the Controller receives the command correctly, the response in the following format 
is shown in the executing command.  

Command Format 

Remote command that acquire 
the value  
Except GetIO, GetVariable, and 
GetStatus 

#[Remote command],[0] terminator 

GetIO #GetIO,[0 | 1] terminator *1 

GetMemIO #GetMemIO,[0 | 1] terminator *1 

GetIOByte #GetIOByte,[ Hex string (00 to FF) of Byte (8Bit)] 
terminator 

GetMemIOByte #GetMemIOByte,[ Hex string (00 to FF) of Byte 
(8Bit)] terminator 

GetIOWord #GetIOWord,[ Hex string (0000 to FFFF) of Word 
(16Bit)] terminator 

GetIOMemWord #GetMemIOWord,[ Hex string (0000 to FFFF) of 
Word (16Bit)] terminator 

GetVariable # GetVariable,[Parameter value] terminator 

GetVariable (in case of array)  # GetVariable,[ Parameter value 1],[ Parameter 
value 2],...,terminator *4 

GetStatus 

#GetStatus,[Status],[Error, Warning code] 
terminator 
e.g.)    #GetStatus,aaaaaaaaaa,bbbb 
 *2 *3 

Execute 
If the value is returned as a result of command 
execution 

#Execute,”[Execution result]” terminator 

*1 [0 | 1] I/O bit   ON: 1/ OFF: 0 

*2 Status  
In the example above, 10 digits “aaaaaaaaaa” is for the following 10 flags. 
Teach, Auto, Warning, SError, Safeguard, Estop, Error, Paused, Running, Ready 
1 is ON /0 is OFF 
If Ready and Auto are ON, it is “0100000001”. 

*3 Error, warning code 
It is indicated in 4 digits.  If there is no error and warning, it is “0000”. 

e.g.)1 : #GetStatus,0100000001,0000 
The bits for Auto and Ready us ON (1). 
This means that AutoMode is ON and be in Ready state.  Command execution is 
enabled.  

e.g.)2 : #GetStatus,0110000010,0517 
This means the warning occurs during the operation.  Take appropriate action for 
the warning code.  (In this case, warning code is 0517)  

Flag Contents 
Teach Turn ON in the TEACH mode 
Auto Turn ON in the remote input acceptance condition 
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Flag Contents 

Warning 
Turn ON in the warning condition 
Task can be executed as usual even a warning condition.  However, take 
action for the warning as soon as possible.  

SError 
Turn ON in the serious error condition  
When a serious error occurs, Reboot the Controller to recover from the 
error condition.  “Reset input” is not available.  

Safeguard Turn ON with safety door open 
EStop Turn ON in the emergency condition 

Error Turn ON in the error condition 
Use “Reset input” to recover from the error condition.  

Paused Turn ON with paused task 

Running Turn ON with task executing 
Turn OFF when “Paused output” is ON 

Ready Turn ON with the Controller completed the startup and no task executing  

*4 It returns values of specified number in the Number to acquire. 

 

Error response 

When the Controller cannot receive the remote command correctly, the error response is 
shown in the following format.  

Format: ![Remote command],[Error code] terminator 

Error code Contents 
10 Remote command does not begin with $ 
11 Remote command is wrong 

Login is not executed 
12 Remote command format is wrong 
13 Login command password is wrong  
14  Specified number to acquire is out of range  

(Less than 1 or more than 100) 
Number to acquire is omitted  
Specified a string parameter 

15  Parameter is not existed  
Dimension of parameter is wrong  
Element out of range is called  

19 Request time out 
20 Controller is not ready 
21 Cannot execute since the Execute is running 
99 System error 

Communication error 
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Communication sequence 

 
Controller 

IP xxx.xxx.xxx.xxx 

   

 

 

 

 

 

Ethernet Client 

 IP zzz.zzz.zzz.zzz 

  

 

 

 

(1) Login 

(2) Response 

(3) Command request 
 
(4) Response 

(5) Logout 

(6) Response 

Request from 
zzz.zzz.zzz.zzz:zz 
is only available ： 

： 

 

 
 

11.11  Remote RS232 
Remote RS232 makes it possible to control the robot and controller from external 
equipment by sending the remote commands through RS-232C.  

To set the remote RS232 functions valid, follow the procedures below to configure the 
parameter.  

(1) Select [Controller] from the [Setup] menu and select the [Remote RS232] page. 

(2) Configure the necessary items for the remote RS232 control. 

(3) Click <Apply> to save the new setting and click <Close>. 

 
For the details of the dialog setting, refer to the section 5.12.2 [Controller] Command 
(Setup menu) – [Setup]-[Controller]-[Remote]. 
 
Following setting for the control device is not necessary when you select “Use only for 
monitoring”, and only acquire the value using the remote RS232 control. 
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Set the control device to “Remote RS232” by the following procedure.  

(1) Select [Controller] from the [Setup] menu and select [Controller Configuration] page. 
Select “Remote RS232” in the [Controller device] box. 

(2) Click <Apply> button to save the new settings, click <Close>. 

 
For the details of the dialog setting, refer to the section 5.12.2 [Controller] Command 
(Setup menu) – [Setup]-[Controller]-[Setup]. 

 

Set the remote control available by the following procedure.  

(1) Open RS-232C port that is connected from client equipment to the specified port in 
the Remote RS232 of the Controller, using the communication parameter specified in 
the RS-232C port setting. 

(2) Send the remote start command (EOT). 

(3) Specify the password set in the Remote RS232 to the parameter and send the Login 
command. 

(4) Client equipment has to wait until Auto (GetStatus command response) is ON, before 
execution of remote command. 

(5) Now remote command will be accepted.  
Each command executes the function when the input acceptance condition is satisfied. 

 

Program debug from EPSON RC+ 5.0 development environment is capable as follows.  

(1) Build a program as usual.  

(2) Open the Run window and click the <RS232 Enable> button.  

 When you only acquire the value using the Remote RS232 control, the <RS232 
Enable> button is not displayed.  Click the Start button of the device specified as the 
control device. 

(3) Now remote command will be accepted.  

Brakepoint setting and output to the [Run] window is available.  
 

After Login, if no command is send within the timeout duration of the RS-232C, the 
timeout error will be returned.  In this case, re-execute from sending remote start 
command.  
If error occurs, execute the Reset command to clear the error condition before executing 
the operation command.  To clear the error condition from external equipment by 
monitoring, use the “GetStatus” and “Reset” command. 
 

 

NOTE 
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WARNING 

■ If you set “0” in the [Timeout] box, time out duration is infinite.  In this case, the 
task continues to execute even without the communication from client.  This 
means the robot may keep moving and cause unexpected damage.  Ensure the 
ways other than the communication to stop the task. 

 

Remote Command 

Remote start 

Start the Remote RS232function of the Controller. 

EOT 

1byte 

EOT : &H04(&H is hexadecimal) 

Request format 

STX 

1byte 

Command 

1Byte 

Data 

Variable 

ETX 

1Byte 

BCC 

1Byte 

STX  : &H02 

ETX  : &H03 

BCC : Checksum of sent and received data 

XOR value from the command to ETX per 1Byte 

Remote 

Command 

Send 

command 
Data Description 

Input 

Acceptance 

Condition (*1) 

Login 
‘L’ 
&H4C password 

Authentication by password 
Execute Login correctly, commands execution is 
enabled until Logout 

Available any 
time 
(*10) 

Logout 
‘l’ 
&H6C  

After Logout, execute the Login command to 
start remote RS232 function.  
Logout during task execution causes an error. 

Available any 
time 
(*10) 

Start 

‘G’ 
&H47 Function No. 

(1Byte) 

Execute the function of specified number (*2) 
Example) Execute ‘main’ 
&H02&H47&H00&H03&H44 

Auto ON 
Ready ON 
Error OFF 
EStop OFF 
Safeguard ON 

Stop 
‘Q’ 
&H51 

 
Stop all tasks and commands  Auto ON 

Pause 
‘P’ 
&H50 

 Pause all tasks (*3) Auto ON 
Running ON 

Continue 
‘C’ 
&H43 

 
Continue paused tasks  Auto ON 

Paused ON 

Reset 
‘R’ 
&H52 

 
Clear emergency stop and error (*4) Auto ON 

Ready ON 
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Remote 

Command 

Send 

command 
Data Description 

Input 

Acceptance 

Condition (*1) 

SetMotorsOn 

‘M’ 
&H4D 

 

Turn ON the robot motor (*5) Auto ON 
Ready ON 
EStop OFF 
Safeguard 
OFF 

SetMotorsOf
f 

‘N’ 
&H4E 

 Turn OFF the robot motor Auto ON 
Ready ON 

Home 

‘H’ 
&H48 

 

Move the arm to home position defined by user Auto ON 
Ready ON 
Error OFF 
EStop OFF 
Safeguard 
OFF 

GetIO 
‘i’ 
&H69 

I/O bit No. 
(2Byte) 

Acquire the specified I/O bit  
Example) Acquire the I/O bit 1 
&H02&H69&H0001&H03&H6B 

Available any 
time 
(*10) 

SetIO 

‘I’ 
&H49 

[I/O bit 
No.](2Byte) 
[value] 
(1Byte) 

Set the I/O specified bit  
&H01: Turn ON the bit 
&H00: Turn OFF the bit  
Example) Turn ON the I/O bit 1 
&H02&H49&H0001&H01&H03&H4A 

Auto ON 
Ready ON 

GetIOByte 
‘b’ 
&H62 

I/O port 
No.(1Byte) 

Acquire the specified I/O port (8 bit)  (*8) 
Example) Acquire the I/O port 1 
&H02&H62&H01&H03&H60 

Available any 
time (*10) 

SetIOByte 

‘B’ 
&H42 

[I/O port  
No.](1Byte) 
[value] 
(1Byte) 

Set the I/O specified port (8 bit)  (*8) 
Example) Set &H0F to the I/O port 1 

&H02&H42&H01&H0F&H03&H4F 

Auto ON 
Ready ON 

GetIOWord 
‘w’ 
&H77 

I/O word 
Port No. 
(1Byte) 

Acquire the specified I/O word port (16 bit)  (*8) 
Example) Acquire the I/O word port 1 
&H02&H77&H01&H03&H75 

Available any 
time (*10) 

SetIOWord 

‘W’ 
&H57 

[I/O word  
port No.] 
(1Byte) 
[value] 
(2Byte) 

Set the I/O specified word port (16 bit)  (*8) 
Example) Set &H010F to the I/O word port 1 
&H02&H57&H01&H010F&H03&H5B 

Auto ON 
Ready ON 

GetMemIO 
‘o’ 
&H6F 

Memory I/O 
bit No. 
(2Byte) 

Acquire the specified memory I/O bit  (*8) 
Example) Acquire memory I/O bit 1 
&H02&H6F&H0001&H03&H6D 

Available any 
time (*10) 

SetMemIO 

‘O’ 
&H4F 

[Memory I/O 
bit No.] 
(2Byte)[value]
(1Byte) 

Set the I/O specified bit  (*8) 
&H01: Turn ON the bit 
&H00: Turn OFF the bit  
Example) Turn ON the memory I/O bit 1 

&H02&H4F&H0001&H01&H03&H4C 

Auto ON 
Ready ON 
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Remote 

Command 

Send 

command 
Data Description 

Input 

Acceptance 

Condition (*1) 

GetMemIOB
yte 

‘t’ 
&H74 

Memory I/O 
port No. 
(1Byte) 

Acquire the specified memory I/O port (8 bit) (*8) 
Example) Acquire the memory I/O port 1 
&H02&H74&H01&H03&H76 

Available any 
time (*10) 

SetMemIOB
yte 

‘T’ 
&H54 

[Memory I/O 
port No.] 
(1Byte)[value]
(1Byte) 

Set the I/O specified port (8 bit)  (*8) 
Example) Set &H0F to the memory I/O port 1 
&H02&H54&H01&H0F&H03&H59 

Auto ON 
Ready ON 

GetMemIO
Word 

‘u’ 
&H75 

Memory I/O 
word port 
No.(1Byte) 

Acquire the specified memory I/O word port  
(16 bit)  (*8) 
Example) Acquire the memory I/O word port 1 
&H02&H75&H01&H03&H77 

Available any 
time (*10) 

SetMemIOW
ord 

‘U’ 
&H55 

[Memory I/O 
word port No.] 
(1Byte) 
[value](1Byte) 

Set the I/O specified word port (16 bit)  (*8) 
Example) Set &H010F to the memory I/O word 
port 1 
&H02&H55&H01&H010F&H03&H59 

Auto ON 
Ready ON 

GetVariable 

‘v’ 
&H76 [Parameter 

name],(&H2C)
[type](1Byte) 

Acquire the value of backup (Global Preserve) 
parameter (*6) 
Example) Acquire the Global Integer g_Status 
&H02&H76&H67&H5F&H53&H74&H61&H74
&H75&H73&H2C&H03&H03&H56 

Available any 
time (*10) 

 

[Parameter 
name] (&H2C) 
(Array 
element) 
(&H2C), 
[Parameter 
type](1Byte), 
(&H2C) 
[Number to 
acquire] 
(2Byte) 

Acquire the value of backup (Global Preserve)  
array parameter (*7) 
Example) Acquire all of Global Integer 
g_intArray(10) 
&H02&H76&H67&H5F&H69&H6E&H74&H41
&H72&H72&H61&H79&H2C 
&H0000&H2C&H03&H2C&H000A&H03&H42
E 
Example) Acquire 10 elements from elements 
(3,5,0) of Global Integer g_int3Array(10,10,10) 
&H02&H76&H67&H5F&H69&H6E&H74&H33
&H41&H72&H72&H61&H79&H2C 
&H0003&H2C&H0005&H2C&H0000&H2C&H
03&H2C&H000A&H03&H77 

SetVariable 

‘V’ 
&H56 

[Parameter 
name], (&H2C) 
[value] 
(type size) 
(&H2C),[type] 
(1Byte) 

Set the value in the backup (Global Preserve) 
parameter (*6) 
Example) Set &H0 to Global Integer g_Status 
&H02&H56&H67&H5F&H53&H74&H61&H74
&H75&H73&H2C&H0000&H2C&H03&H03&
H5A 

Auto ON 
Ready ON 

GetStatus 
‘S’ 
&H53 

 Acquire the Controller state Available any 
time (*10) 
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Remote 

Command 

Send 

command 
Data Description 

Input 

Acceptance 

Condition (*1) 

Execute 

‘X’ 
&H58 

Command string 

Execute the command (*8) (*9) 
Example) Execute ‘print here’ 
&H02&H58&H22&H70&H72&H69&H6E&H7
4&H20&H68&H65&H72&H65&H22&H03&H
10 

Auto ON 
Ready ON 
Error OFF 
EStop OFF 
Safeguard 
OFF 

Abort 
‘A’ 
&H41 

 Abort the command execution  (*8) Auto ON 

(*1) The Controller state bit from GetStatus. 

(*2) Execute the function specified in the Main[Function No.].  

Function Name Function No. 
Main 0 
Main1 1 
Main2 2 
Main3 3 
Main4 4 
Main5 5 
Main6 6 
Main7 7 

(*3) Pause command is not available for “NoPause task” and “NoEmgAbort task”.  
For the details, refer to the help or the section “Pause” in the EPSON RC+5.0 Language reference 
manual.  

(*4) I/O output will be turned OFF and the robot parameter will be initialized. 
For the details, refer to the help or the section “Reset” in the EPSON RC+5.0 Language reference manual.  

(*5) The robot parameter will be initialized.  
For the details, refer to the help or the section “Motor” in the EPSON RC+5.0 Language reference 
manual. 

(*6) Parameter type 

Parameter type Type value(1Byte) 
Boolean &H00 
Byte &H01 
Double &H02 
Integer &H03 
Long &H04 
Real &H05 
String &H06 

For the backup parameters when the parameter name and type are same. 
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(*7) For the array element, specify an element you acquire as the following: 
You need to specify an element when acquiring from the head of the array.  

 Specify the array element in 2Byte value. 

1D array Parameter name&H2C&H0000 Acquire from the head. 
Parameter name, element number. Acquire from the specified 

element number. 
2D array Parameter name 

&H2C&H0000&H2C&H0000 
Acquire from the head. 

Parameter name, element number 1, element 
number 2 

Acquire from the specified 
element number. 

3D array Parameter name 
&H2C&H0000&H2C&H0000&H2C&H0000 

Acquire from the head. 

Parameter name, element number 1, element 
number 2, element number 3 

Acquire from the specified 
element number. 

 You cannot specify a string for the parameter type. 
Available number to acquire is up to 100.  If you specify a number over the number of array elements, 
you have an error.  

(*8) Following functions are supported in the firmware 1.13.*.* or later. 
- Acquiring and setting I/O port 
- Acquiring and setting I/O word port 
- Acquiring and setting memory I/O 
- Acquiring and setting memory I/O port 
- Acquiring and setting memory I/O word port 
- Execution and abortion of command 

(*9) Specify the command and parameters in the double quotation marks. 

 Following commands are available while Execute is running. 

Commands available while Execute is running  

Remote Command 
Abort 
GetStatus 
SetIO 
SetIOByte 
SetIOWord 
SetMemIO 
SetMemIOByte 
SetMemIOWord 

When the commands specified in (SetIO, SetIOByte, SetIOWord, SetMemIO, SetMemIOByte, 
SetMemIOWrod) are the same and executed at the same time, the command executed later will result 
in error.  Make sure to check the execution result by using GetStatus after the execution of Execute 
command and output command which the Execute command is being executed. 
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(*10) “Available any time” applies only when the following conditions are met. 

When “Remote RS232” is set as the control device, 

or 

“Remote RS232” is not set as the control device, but set to be used for monitoring. 

Commands available for monitoring  

When the Remote RS232 control is not set as the control device but set to be used for 
monitoring, following commands are only available to execute. 

Remote command 

Login 

Logout 

GetIO 

GetIOByte 

GetIOWord 

GetMemIO 

GetMemIOByte 

GetMemIOWord 

GetVariable 

GetStatus 
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Response 

When the Controller receives the command correctly, the response in the following format 
is shown in the executing command. 

Response Format 

ACK 

1Byte 

Command 

1Byte 

Data 

Variable 

ETX 

1Byte 

BCC 

1Byte 

ACK : &H06 

ETX : &H03 

BCC : Checksum of sent and received data 

XOR value from the command to ETX per 1Byte 

 

Command Format 

Remote command that acquire 
the value 

Except GetIO, GetVariable, and 
GetStatus 

[ACK][Command](1Byte)[ETX][BCC]  

GetIO [ACK] ‘i’[&H00 | &H01] [ETX][BCC] *1 

GetMemIO [ACK] ‘o’[&H00 | &H01] [ETX][BCC] *1 

GetIOByte [ACK] ‘b’[ Byte value(8Bit) (&H00～&HFF)] 
[ETX][BCC] 

GetMemIOByte [ACK] ‘t’[ Byte value(8Bit) (&H00～&HFF)] 
[ETX][BCC] 

GetIOWord [ACK] ‘w’[ Word value(16Bit) (&H0000～
&HFFFF)] [ETX][BCC] 

GetIOMemWord [ACK] ‘u’[ Word value(16Bit) (&H0000～
&HFFFF)] [ETX][BCC] 

GetVariable [ACK] ‘u’[parameter] [ETX][BCC] 

GetVariable (in case of array) [ACK] ‘u’[parameter 1][parameter 2]... 
[ETX][BCC] *4 

GetStatus 

 [ACK] ‘S’ [Status],[Error, Warning code] 
[ETX][BCC] 
Example)  [ACK] 
‘S’[aaaaaaaaaa][bbbb][ETX][BCC] 

*2 *3 

Execute 
If the value is returned as a result of command 
execution 

[ACK] ‘X’”[Execution result]” [ETX][BCC] 

*1 [&H00 | &H01] I/O bit   ON: &H01/ OFF: &H00 

*2 Status  
In the example above, 10 digits [aaaaaaaaaa] is for the following 10 flags. 
Teach, Auto, Warning, SError, Safeguard, Estop, Error, Paused, Running, Ready 
&H01 is ON /&H00 is OFF 
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If Ready and Auto are ON, it is 
[&H00&H01&H00&H00&H00&H00&H00&H00&H00&H01]. 

*3 Error, warning code 
It is indicated in 4 digits.  If there is no error and warning, it is “0000”.  
(&H30&H30&H30&h30). 

e.g.)1 : [ACK] 
‘S[&H00&H01&H00&H00&H00&H00&H00&H00&H00&H01][ &H30&H30&
H30&h30] 

The bits for Auto and Ready are ON (&H01). 
This means that AutoMode is ON and be in Ready state.  Command execution is 
enabled.  

e.g.)2 : :[ACK] 
‘S[&H00&H01&H01&H00&H00&H00&H00&H00&H01&H00][ &H30&H35&
H31&h37] 
This means the warning occurs during the operation.  Take appropriate action for 
the warning code.  (In this case, warning code is 0517 )  

Flag Contents 
Teach Turn ON in the TEACH mode 
Auto Turn ON in the remote input acceptance condition 

Warnig 
Turn ON in the warning condition 
Task can be executed as usual even a warning condition.  However, take 
action for the warning as soon as possible.  

SError 
Turn ON in the serious error condition  
When a serious error occurs, Reboot the Controller to recover from the 
error condition.  “Reset input” is not available.  

Safeguard Turn ON with safety door open 
EStop Turn ON in the emergency condition 

Error Turn ON in the error condition 
Use “Reset input” to recover from the error condition.  

Paused Turn ON with paused task 

Running Turn ON with task executing 
Turn OFF when “Paused output” is ON 

Ready Turn ON with the Controller completed the startup and no task executing  

*4 It returns values of specified number in the Number to acquire. 
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Error response 

When the Controller cannot receive the remote command correctly, the error response is 
shown in the following format.  

NAK 

1Byte 

Command 

1Byte 

Error code 

2Byte 

ETX 

1Byte 

BCC 

1Byte 

NAK : &H15 

ETX  : &H03 

BCC : Checksum of sent and received data 

XOR value from the command to ETX per 1Byte 

 

Error code Contents 
10 Remote command does not begin with $ 
11 Remote command is wrong 

Login is not executed 
12 Remote command format is wrong 
13 Login command password is wrong  
14  Specified number to acquire is out of range  

(Less than 1 or more than 100) 
Number to acquire is omitted  
Specified a string parameter 

15  Parameter is not existed  
Dimension of parameter is wrong  
Element out of range is called  

16 BCC is wrong 
19 Request time out 
20 Controller is not ready 
21 Cannot execute since Execute is running 
99 System error 

Communication error 
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Communication sequence 

 

 

Request from the 
Remote Controller is 
only available 

180Controller 
Port xx 
 
 

RS-232C 
RemoteController 
Port zz 
 

②Login 

③Response 

④Command request 
 
⑤Response 

⑥Logout 

⑦Response 

： 

： 

 

①EOT 
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12.  RS-232C Communications 
The RC180 controllers can support up to 8 optional RS232 ports, 4 ports per board. 

The RC90 controllers can support one port as standard and up to 4 optional RS232 ports, 2 
ports per board.  

For instructions on how to install RS-232C boards, refer to the Robot Controller manual. 
 

12.1  RS-232C Software Configuration 
To configure an RS-232 port 

1. Select [Controller] from the [Setup] menu and open the [RS232] folder on the tree 
located on the left side of the dialog.   

If RS232 boards have not been installed on the controller, you will not see the 
corresponding ports in the tree. 

2. Select the port you want to configure. 

3. Change the settings as desired. 

4. Click <Apply> to save the new settings, and then click the <Close> button. 

 
If the several ports are used in the communication at one time with more than 19200 baud 
rate, error 2929 or 2922 may occur.  In this case, select the lower baud rate or avoid using 
several ports at one time.    

 

NOTE 

 

NOTE 
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12.2  RS-232C Commands 
Here is a list of all of the commands associated with RS-232 communications.  For details, 
please see the online help or SPEL+ Language Reference manual. 

OpenCom Opens a communications port. 

ChkCom Returns port status: the number of bytes waiting to be read or error 
condition. 

CloseCom Closes a communications port. 

SetCom Sets communications port parameters at runtime or from the 
Command window. 

Print # Sends characters out of the port. 

Input # Receives characters from the port into one or more variables. 

Line Input # Receives one line characters from the port into one string variable. 

Read # Receives one or more characters from the port into one string variable. 

ReadBin # Receives one or more bytes from the port. 

Write # Sends characters out of the port. 

WriteBin # Sends one or more bytes out of the port. 
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13.  TCP / IP Communications 
EPSON RC+ 5.0 supports eight TCP/IP ports that allow peer to peer communications. 

This chapter contains instructions on using TCP/IP, including IP addresses, Windows 
TCP/IP configuration, and SPEL+ examples. 
 

13.1  TCP/IP Setup 
Before you can use TCP/IP communications between PCs and controllers, you must 
configure your network.  The following sections describe basic network configuration.  
 

13.1.1  Ethernet Hardware 
The Controller includes a built in Ethernet interface with an RJ45 connector accessible 
from the controller front panel.  It supports 10BaseT (10 Mbps) and 10BaseTX (100 
Mbps). 

Your PC will need a 10BaseT 10/100 adapter to communicate with a controller via 
Ethernet. 
 

13.1.2  IP Addresses 
The Controller has a fixed IP address that you can configure from EPSON RC+ 5.0.  To 
configure the IP address, mask, and gateway for the Controller, refer to 5.12.2 
[Controller] Command (Setup Menu)-[Setup]-[Controller]-[Configuration]. 

The following table shows a typical IP address configuration. 

Host Name IP Address Subnet Subnet Mask 

PC1 192.168.0.1 192.168.0 255.255.255.0 

PC2 192.168.0.2 192.168.0 255.255.255.0 

Controller1 192.168.0.3 192.168.0 255.255.255.0 

Controller2 192.168.0.4 192.168.0 255.255.255.0 

In this example, the network address (subnet) is 192.168.0.  With a subnet mask of 
255.255.255.0, there can be 254 hosts on this subnet (0 and 255 cannot be used). 

Refer to the Microsoft Windows operating system manual for instructions on setting the 
PC IP address. 
 

13.1.3  IP Gateway 
If you are connecting PCs and controllers on different networks, you will need to route 
traffic between the networks using one or more routers.  Each device communicating via 
Ethernet will need to have their default gateway address set to the address of the router for 
its subnet. 

To configure the gateway address for the Controller, refer to 5.12.2 [Controller] 
Command (Setup Menu)-[Setup]-[Controller]-[Configuration]. 
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13.1.4  Testing Windows TCP/IP setup 
Use the ping command from a Command Window to test communications. 

First, do a loopback test to check if you can ping your own address by using the local IP 
address: 

C:\>ping 127.0.0.1 

Pinging 127.0.0.1 with 32 bytes of data: 

Reply from 127.0.0.1: bytes=32 time<10ms TTL=128 

Reply from 127.0.0.1: bytes=32 time<10ms TTL=128 

Reply from 127.0.0.1: bytes=32 time<10ms TTL=128 

Reply from 127.0.0.1: bytes=32 time<10ms TTL=128 

C:\> 

Ping your PC’s IP address: 
C:\>ping 192.168.0.1 

Pinging 192.168.0.1 with 32 bytes of data: 

Reply from 192.168.0.1: bytes=32 time<10ms TTL=128 

Reply from 192.168.0.1: bytes=32 time<10ms TTL=128 

Reply from 192.168.0.1: bytes=32 time<10ms TTL=128 

Reply from 192.168.0.1: bytes=32 time<10ms TTL=128 

C:\> 

Now ping controller on the network. : 
C:\>ping 192.168.0.3 

Pinging pc2 [192.168.0.3] with 32 bytes of data: 

Reply from 192.168.0.3: bytes=32 time<10ms TTL=128 

Reply from 192.168.0.3: bytes=32 time<10ms TTL=128 

Reply from 192.168.0.3: bytes=32 time<10ms TTL=128 

Reply from 192.168.0.3: bytes=32 time<10ms TTL=128 

C:\>   
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13.2  TCP/IP Software Configuration 
You can configure TCP/IP settings for the Controller in a SPEL+ program using the SetNet 
command.  You can also configure settings from the [TCP/IP] tab on the [Setup]-
[Controller] dialog. 

 
To configure a TCP/IP port 

1. Select [Controller] from the [Setup] menu and select the page for the TCP/IP port you 
want to configure. 

2.  Enter the IP address for the controller or PC that you want this controller to 
communicate with. 

 The controller does not support DNS, so you must specify an IP address for the host 
you are communicating with.  You cannot specify a name for the host. 

3. Enter the TCP/IP port number.  This must be the same port number that is used on the 
host device.  It must be different from any of the other TCP/IP port numbers used for 
the other TCP/IP ports. 

4.  Change the other settings as desired. 

5.  Click <Apply> to save the new settings  

6. Click <Close>. 
 

13.3  TCP/IP Commands 
Here is a list of all of the commands associated with TCP/IP communications.  For details, 
please see the online help or SPEL+ Language Reference Manual. 

OpenNet Opens a TCP/IP port. 

ChkNet Returns port status: the number of bytes waiting to be read or error 
condition. 

CloseNet Closes a TCP/IP port. 

SetNet Sets communications port parameters at runtime or from the 
Command window. 

Print # Sends characters out of the port. 

Input # Receives characters from the port into one or more variables. 

Line Input # Receives one line characters from the port into one string variable. 

Read # Receives one or more characters from the port into one string variable. 

ReadBin # Receives one or more bytes from the port. 

Write # Sends characters out of the port. 

WriteBin # Sends one or more bytes out of the port.   

 

NOTE 
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13.4  TCP/IP Example 
This example shows how to configure 2 PCs running EPSON RC+ 5.0 to communicate 
using TCP/IP.  Note that for the OpenNet command, one PC is the server, and the other is 
a client. 

Controller #1: 

Port: #201 

IP Address: 192.168.0.1 

TCP/IP Port: 1000 
 

Function tcpip1 

String reply$ 

OpenNet #201 As Server 

WaitNet #201 

Do 

Print "Sending data to host 2" 

Print #201, "Data from host 1" 

Input #201, reply$ 

Print "Received reply: ", reply$ 

Loop 

Fend 

Controller #2: 

Port: #201 

IP Address: 192.168.0.2 

TCP/IP Port: 1000 
 

Function tcpip2 

String data$ 

OpenNet #201 As Client 

WaitNet #201 

Do 

Input #201, data$ 

Print "Received '", data$, "' from host 1" 

Print #201, "Received data" 

Loop 

Fend 
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14.  ECP Motion 
 

14.1  Overview 
An ECP (external control point) motion is when the robot arm holding a part follows a 
specified trajectory (part’s edges, etc.) using an outside fixed tool. 

 

External Control Point 
(ECP) 

Outside Fixed Tool 

Part 

 
The ECP option supports the following:  

 ECP definition by ECPSet statement and selection by ECP statement -

 ECP motion commands (additional functions of Move, Arc3, Curve and CVMove -
commands) 

 Teaching with ECP jogging -

This option is available for SCARA, Cartesian and 6-Axis robots.  Also, it can be used 
with multi-robot systems. 

Up to 15 ECP coordinate systems can be defined.   
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14.1.1  How to move the arm with ECP motion  
In the following paragraphs, the process for moving the 6-axis robot arm with ECP motion 
is explained as an example.  
 
1. Setting the ECP 

The ECP (external control point) is coordinate system data used for defining the robot 
position and orientation at a processing point on the tip of the outside fixed tool. 

The ECP should be defined based on the robot coordinate system or desired local 
coordinate system. 

For example, when a drawing shows that the ECP is located at X=300, Y=300, Z=300 
based on the robot coordinate system, specify it as shown below.  

ECPSet 1,XY(300,300,300,0,0,0)   ' Defines ECP No.1 

When you have no ECP location data, you can specify it by teaching. 

As an example, attach the tool of which you know the data precisely and bring the tip of 
the tool close to the ECP and then teach its position anywhere as P0.  Then, specify the 
ECP using P0 coordinate data as shown below.  

ECPSet 1,P0 :U(0) :V(0) :W(0)    ' Defines ECP No.1 

The orientation data (U, V, W) were set to 0 in the above examples.  In these cases, the 
orientation in the ECP coordinate system is equal to that in the reference robot coordinate 
system. 

You can specify U, V, and W coordinates in the ECP coordinate system.  However, this 
data is valid only during the tangential correction mode ON in the Curve statement and 
ECP jog motion.  
 
2. Teaching 

Teach the point data while moving the robot arm holding the actual part.  In this section, 
the part is assumed a rectangular solid and the arm is moved straight so that it touches one 
side of the part to the ECP specified in the former section 1. Setting the ECP.   

For details on teaching, refer to 5.11.1  [Root Manager] Command (Tools Menu) - 
[Tools]-[Robot Manager]-[Jog & Teach] Page.  

2-1 Teaching the motion start point 

Move the arm to the motion start point and teach it as P1.  
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2-2 Teaching the motion end point 

Move the arm to the motion end point and teach it as P2.  

 
ECP Jog Motion: 

The ECP jog motion is added to available jog motions for teaching besides Joint, World, 
and Tool jog motions. 

The ECP jog motion is based on the selected ECP coordinate systems. 
 
3. Executing Motion 

To move the arm with ECP motion, add an “ECP” parameter to a motion command. 
Go P1 ' Moves the arm to the motion start point 
Move P2 ECP ' Executes ECP motion  

Use the Arc3 command to move the arm in an arc trajectory with the fixed tool.  Use the 
Curve and CVMove commands to move the arm in cubic spline curves. 

 

NOTE 
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15.  Installing Controller Options 
When you purchase options with your system, the options are already installed on your 
system before shipment.  You can also purchase options separately. 

The Controller has option software keys that are enabled from EPSON RC+ 5.0. 

To see what options are enabled on your system, select [Setup]-[Controller]-[Options].  
The following dialog will be displayed. 

 
Item Description 

Option Name of the option. 

Enabled Indicates that the option is enabled in the controller. 

To enable an option on site 

1. Write down the controller options key code.  You can view this from the [Setup]-
[Controller]-[Options] page. 

2. Call your distributor to purchase the enable key code for the desired option. 

3. You will receive a code to enable the option from your distributor. 

4. Select the option to enable on the grid, and then click the <Enable> button. 

5. Enter in the code you received from your distributor. 

Key code is case sensitive. 

 
 

 

 

NOTE 
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16.  Software License Agreement 
THIS IS A CONTRACT.  CAREFULLY READ ALL THE TERMS AND 
CONDITIONS CONTAINED IN THIS AGREEMENT.  INSTALLING THE 
SOFTWARE (EPSON RC+ 5.0) INDICATES YOUR ACCEPTANCE OF THESE 
TERMS AND CONDITIONS.  IF YOU DO NOT AGREE TO THESE TERMS AND 
CONDITIONS, SIMPLY DO NOT INSTALL OR USE THE EPSON RC+ 5.0 
SOFTWARE. 
 

LICENSE 

SEIKO EPSON CORPORATION (the "Licenser") hereby grants to you (the 
"Licensee") a non-exclusive and transferable right to use the EPSON RC+ 5.0 
Software program and documentation (the "Licensed Materials").  You may only use 
this software on one (1) CPU.  You may not use, copy, or modify the Licensed 
Materials, in whole or in part, except as expressly provided for by this agreement. 
 

OWNERSHIP 

As the Licensee you own the magnetic or other physical media on which the Licensed 
Materials are recorded or fixed, but the Licenser retains sole and exclusive title to and 
ownership of the Licensed Materials recorded on the original disk and all subsequent 
copies regardless of the form or media in or on which the original and other copies 
may exist.  By paying the fee required for this license, you do not become the owner 
of the Licensed Materials, but are entitled to use the Licensed Materials according to 
the terms of this agreement.  You acknowledge that the Licensed Materials are not 
your property and understand that giving away or selling copies of the Licensed 
Materials is theft. 
 

TERM 

This license is effective until terminated.  You may terminate this license by 
destroying the Licensed Materials together with any backup copies that may have been 
made.  This license will also terminate if you fail to comply with any term or 
conditions of this Agreement.  You agree upon such termination to destroy the 
Licensed Materials together with any copies which may have been made. 
 

BACKUP AND TRANSFER 

The Licensed Materials are copyrighted and contain proprietary information and trade 
secrets of the Licenser.  Unauthorized copying, modifying or reproducing of the 
Licensed Materials, even if modified, merged or included with other software, is 
expressly forbidden.  You may make one (1) archival copy of the Licensed Materials 
for the sole purpose of backing up the Licensed Materials.  In no event does the 
limited copying or reproduction permitted hereunder include the right to decompile, 
disassemble or electronically transfer the Licensed Materials, or translate the Licensed 
Materials into another language.  You may sell your license rights in the software to 
another party.  If you sell your license rights in the Licensed Materials you must at the 
same time transfer the documentation and the backup copy or destroy the backup copy.   
You cannot sell your license rights in the Licensed Materials to another party unless 
that party also agrees to the terms and conditions of this agreement. 
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PROTECTION AND SECURITY 

You agree not to deliver or otherwise make available the Licensed Materials or any 
part thereof, including, without limitation, the object code, to any person other than 
the Licenser or its employees, except for purposes specifically related to your use of 
the Licensed Materials on one (1) CPU, without the prior written consent of the 
Licenser.  You agree to use your best efforts and take all reasonable steps to safeguard 
the Licensed Materials to ensure that no unauthorized person shall have access thereto 
and that no unauthorized copy, publication, disclosure or distribution thereof, in whole 
or in part, in any form, shall be made.  You recognize that the Licensed Materials 
contain valuable confidential information and trade secrets. 
 

LIMITED WARRANTY 

The only warranty the Licenser makes to you in connection with this license to use the 
Licensed Materials is that the media on which the Licensed Materials are recorded will 
be replaced without charge, as long as the original diskette(s) are returned to the 
licenser, with satisfactory proof of date of purchase, within ninety (90) days of 
purchase.  This warranty is limited to the Licensee and is not transferable.  The 
foregoing warranty does not extend to any Licensed Materials that have been damaged 
as a result of accident, misuse or abuse. 
 

EXCEPT FOR THE LIMITED WARRANTY DESCRIBED ABOVE, THESE 
LICENSED MATERIALS ARE PROVIDED "AS IS".  THE ENTIRE RISK AS TO 
THE RESULTS AND PERFORMANCE OF THE LICENSED MATERIALS IS 
ASSUMED BY YOU.  THE LICENSER DOES NOT WARRANT, GUARANTEE 
OR MAKE ANY REPRESENTATIONS REGARDING THE USE OF, OR THE 
RESULTS OBTAINED WITH THE LICENSED MATERIALS IN TERMS OF 
CORRECTNESS AND RELIABILITY OR LEGALITY.  THE ABOVE IS THE 
ONLY WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED.  
INCLUDING, WITHOUT LIMITATION, LOSS OF PROFITS OR INABILITY TO 
USE THE LICENSED MATERIALS, EVEN IF THE LICENSER OR SUCH 
OTHER PARTY HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH 
DAMAGES.  YOU AGREE THAT YOUR EXCLUSIVE REMEDIES, AND THE 
LICENSER'S OR SUCH OTHER PARTY'S ENTIRE LIABILITY WITH RESPECT 
TO THE LICENSED MATERIALS SHALL BE AS SET FORTH HEREIN, AND IN 
NO EVENT SHALL THE LICENSER'S OR SUCH OTHER PARTY'S LIABILITY 
FOR ANY DAMAGES OR LOSS TO YOU OR ANY OTHER PARTY EXCEED 
THE LICENSED FEE PAID FOR THE LICENSED MATERIALS. 
 

ENTIRE AGREEMENT 

This Agreement represents the entire agreement between Licenser and Licensee with 
respect to the License and use of the Licensed Materials.  
 

SEVERABILITY 

If any provision or a portion of this agreement is determined to be invalid under any 
applicable law, it shall be deemed omitted and the remaining provisions and partial 
provisions of this agreement shall continue in full force and effect. 
 

NOTICE 

Any notice or other communication relating to this license agreement to be sent to the 
Licenser must be mailed by certified mail to your distributor. 
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Appendix A: Software Installation 
EPSON RC+ 5.0 supports the following OS.  

Windows XP Professional Service Pack 3  
          (EPSON RC+ 5.0 Ver.5.2.0 SP3 or greater is required.) 
Windows Vista Business Service Pack 2 
          (EPSON RC+ 5.0 Ver.5.3.1 or greater is required.) 
Windows 7 Professional  
          (EPSON RC+ 5.0 Ver.5.3.4 or greater is required.) 
Windows 8.1 Pro  
          (EPSON RC+ 5.0 Ver.5.4.6 or greater is required.) 

 
Before Installing EPSON RC+ 5.0 Software 

If you are using the Windows 8.1 Pro, follow the steps below and configure “.NET 
Framework 3.5” before installing the EPSON RC+ 5.0 software. 

EPSON RC+ 5.0 cannot be used with the Windows 8.1 Pro if “NET Framework 3.5” is 
not configured. 

 
When the computer can be connected to the Internet 

If the Internet environment is available, insert the EPSON RC+5.0 setup DVD to the DVD 
drive. 

The following dialog box will appear if “.NET Framework 3.5” is not configured. 

 

 

Select “Download and install this feature” and install “.NET Framework 3.5” by following 
the instruction. 
The EPSON RC+ 5.0 will be installed after “.NET Framework 3.5” is installed. 

  

 

NOTE 
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When the computer cannot be connected to the Internet 

If the computer cannot be connected to the Internet, install “.NET Framework 3.5” from 
the media that you have installed the Windows 8.1 Pro from. 

After installing “.NET Framework 3.5”, install the EPSON RC+ 5.0. 

If you do not have the installation media of Windows 8.1 Pro, install the feature in the 
environment where the Internet connection is available. 

 

“.NET Framework 3.5” can be enabled by specifying the installation media (ISO image or 
DVD) that you have installed the Windows 8.1 Pro from using Deployment Image 
Servicing and Management (DISM) command line tool. 

 

1. Open the WindowsPowerShell or the command prompt window using the 
administrative credential.  * WindowsPowerShell is recommended. 
(Select [Run as an administrator].) 

     

2. Execute the following command. 
DISM /Online /Enable-Feature /FeatureName:NetFx3 /All /LimitAccess 
/Source:d:\sources\sxs 

* “/Source:d:\sources\sxs” is the path to the installarion disc.  Select the drive 
according to the PC environment. 
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Installing EPSON RC+ 5.0 Software 

The EPSON RC+ 5.0 software needs to be installed on your development PC. 

If your application uses the EPSON RC+ 5.0 Operator Window you will also need to 
install it on the production PC.     

To install EPSON RC+ 5.0: 

1. Insert the EPSON RC+ 5.0 Setup CD in the CD drive. 

2. If EPSON RC+ 5.0 has previously been installed, you will be asked to uninstall the 
previous version, otherwise go to step 3. 

  

 After uninstalling, you will be prompted to restart the computer.  Start the setup 
program again by double-clicking the installer CD icon in My Computer, or by re-
inserting the CD. 

3. The welcome dialog will be displayed as shown below.   

  

4. Click the Next button to continue. 
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5. Enter your user name and company name, then click Next. 

  
 

6. Select the drive where you want to install EPSON RC+ 5.0 and click <Next>. 

 The installation directory is called EpsonRC50 and cannot be changed. 

 You will be prompted to confirm installation. 

 

 Click <Yes> to continue. 

7. If required, Windows Installer and Microsoft .NET Framework 3.5 are installed on 
your system.  This may take several minutes. 

8. Adobe Reader needs to be installed on your PC in order to view the EPSON RC+ 5.0 
manuals.  If the installer cannot find Adobe Reader on your system, it will be installed 
at this time.  Follow the instructions in the Adobe installer.  Do not restart the system 
after the Adobe Reader installation has completed. 

9. After the installation has completed, you may be prompted to restart your computer. 

10. The EPSON RC+ 5.0 software installation is now completed. 

 

NOTE 
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Appendix B: Project Import Automatic Processing 
 

Project for EPSON RC+ 3.* / 4.* 
When projects created in EPSON RC+ 3.* / 4.* are imported, the following processes are 
executed automatically: 

- User program conversion 
- Point file conversion 
- I/O label file conversion 
- User error label file conversion 

User Program Conversion 
The tables below show the syntax conversions from EPSON RC+ 3.* / 4.* to EPSON RC+ 
5.0. 

Project Type  EPSON RC+ 4.* EPSON RC+ 5.0 

Syntax 
While Do While 
Wend Loop 
Trap...Call Trap...Xqt 

 
Project Type EPSON RC+ 3.* EPSON RC+ 5.0  

Syntax 

While Do While 
Wend Loop 
Trap...Call Trap...Xqt 
On $, Off $ MemOn, MemOff 
Sw($ MemSw( 
Sw $( MemSw( 
In($ MemIn( 
In $( MemIn( 
Out $ MemOut 
Xqt ! Xqt 
Quit ! Quit 
Resume ! Resume 
Halt ! Halt 

Point File Conversion 
For EPSON RC+ 3.*, the EPSON RC+ 5.0 .PTS files are generated automatically from 
the .PNT files and corresponding .DEF files. 

Project Type  EPSON RC+ 3.* EPSON RC+ 5.0 
Point File *.PNT file (Point file) 

*.DEF file (Point label file) 
*.PTS 

For EPSON RC+ 4.*, the EPSON RC+ 5.0 .PTS files are generated automatically from 
the .PNT files. 

Project Type  EPSON RC+ 4.* EPSON RC+ 5.0 
Point File *.PNT file (Point file) *.PTS 

I/O Label File Conversion 
IOLabels.dat is generated automatically from the following three files. 

Project Type  EPSON RC+ 3.* / 4.* EPSON RC+ 5.0 
I/O Label File inplabel.txt 

outlabel.txt 
memlabel.txt 

IOLabels.dat 
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User Error Label File Conversion 
Files are changed automatically as the user error numbers are changed. 

Project Type  EPSON RC+ 3.* / 4.* EPSON RC+ 5.0 
User Error Label 30000 to 30999 8000 to 8999 
User Error Label File UserErrors.txt UserErrors.dat 
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Project Import for SPEL for Windows 2.*  
When projects created in SPEL for Windows 2.* are imported, the following processes are 
executed automatically.  

- User program conversion 
- Point file conversion 
- I/O label file conversion 

- Global Preserve variable table conversion 
- Global variable conversion 
- Local variable conversion 

User Program Conversion 
The table below shows the syntax conversions from SPEL for Windows 2.* to EPSON 
RC+ 5.0. 

Project Type SPEL for Windows 2.* EPSON RC+ 5.0 
Syntax While Do While 

Wend Loop 
Trap n...Call Trap n...Xqt 
On $, Off $ MemOn, MemOff 
Sw($ MemSw( 
Sw $( MemSw( 
In($ MemIn( 
In $( MemIn( 
Out $ MemOut 
Xqt ! Xqt 
Quit ! Quit 
Resume ! Resume 
Halt ! Halt 
Palet Pallet 
Print" Print " 
Date$(0) Date$ 
Time$(0) Time$ 
JS(0) JS 
TW(0) TW 
ZeroFlg(0) ZeroFlg 
Entry Global 
Config statement SetCom statement 
Cooked Line deleted 
SetRaw Line deleted 
SelRB Line deleted 
SelRB1 Line deleted 
Extern Line deleted 
End Quit All 
GetDate d$ d$ = Date$ 
GetTime t$ t$ = Time$ 
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Point File Conversion 
EPSON RC+ 5.0 .PTS files are generated automatically from the .PNT files and 
corresponding .DEF files. 

Project Type SPEL for Windows 2.* EPSON RC+ 5.0 
Point File *.PNT file (Point file) 

*.DEF file (Point label) 
*.PTS 

I/O Label File Conversion 
Converts the I/O labels automatically. 

Project Type SPEL for Windows 2.* EPSON RC+ 5.0 
I/O Label File ProjectName.IOL IOLabels.dat 

Global Preserve Variable Table Conversion 
Backup variable definitions created in the SPEL for Windows 2.* Project Menu are 
converted into Global Preserve declaration statements in the first program file. 

(Example)  
If the SPEL for Windows 2.* project defines an integer backup variable called 
“s_iValue”, the following statement is generated in the first program of the project. 

Global Preserve Integer s_iValue 

Global Variable Conversion 
Global variables (Entry / Extern) in SPEL for Windows 2.* projects are converted to 
Global variables in EPSON RC+ 5.0.  

Project Type SPEL for Windows 2.* EPSON RC+ 5.0 
Global Variable (Command) Entry / Extern command Global command 

Local Variable Conversion 
Local variables in SPEL for Windows 2.* functions can be used throughout the entire file 
in which they are declared.  These variables are converted to module variables or local 
variables in EPSON RC+ 5.0, depending on their scope. 
If the variable is used in only one function, it is converted to a local variable in that 
function. 
If the variable is used in more than one function, it is converted to a module variable. 
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